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Welcome

Welcome

Congratulations on your purchase of Proficy* Logic Developer - PLC*, the
PACSystems*, Series 90*, and VersaMax* Controller programming component
of Proficy* Machine Edition* automation software.

This software package provides all the tools necessary to create powerful
control applications. Logic Developer - PLC provides a way to configure your
Controller hardware or remote I/O, create and edit logic, upload and download
projects, and monitor and debug the execution of control programs. Projects can
be imported from Logicmaster, VersaPro, and Control folders.

Hosted in the Machine Edition environment, Logic Developer - PLC takes
advantage of a powerful set of common programming tools (see page 22). The
same tools can be applied to Logic Developer - PC* (PC Control) and View,
providing a single programming environment. The Machine Edition environment
unites and organizes components, providing data sharing and networked
operation.

The following features are included in this version of Logic Developer - PLC:
Hardware Configuration. See page 57.
LD Editor. See page 95.

FBD Editor. See page 110.

IL Editor. See page 122.

ST Editor. See page 129.

C Blocks. See page 137.

C Programs. See page 139.
DLBs. See page 141s.
PACMotion. See page 151.
Motion Editor. See page 155.
Local Logic Editor. See page 159.
CAM Editor. See page 163.
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System Requirements

SYSTEM REQUIREMENTS

To use Logic Developer - PLC* and its tools, you require the following:

Operating system
32-bit or 64-bit Windows 7 SP1 Ultimate, Windows 7 SP1 Enterprise, or
Windows 7 SP1 Professional.

Important: On 64-bit Windows 7 platforms, the property column display in
the Variables tab of the Navigator is not supported. For more cautions
and limitations when using Logic Developer on Windows 7, refer to the
Important Product Information (IPlk in the Product field, select
Engineering Workstation; and click the Release Notes tab.

You must be part of the Administrators group.
Windows regional settings must be set to English.

Processor speed and memory
Minimum (for small to medium-sized projects):
Intel Core i5 with 4 GB RAM
AMD FX or Phenom Il X6 with 4 GB RAM

Strongly recommended for large projects to see multi-threading performance
gains:
Intel quad-core Core i7 with 8 GB RAM and 64-bit Windows 7 SP1

AMD higher FX or Phenom Il X6 models with 8 GB RAM and 64-bit
Windows 7 SP1

Extra requirements when executing multiple instances of Engineering Workstation

Minimum requirement for very large projects and strongly recommended for
any project: 64-bit versions of Windows 7 SP1

Possible for small or average-sized projects, but not recommended: 32-bit
versions of Windows 7 SP1

Average-sized projects: each instance uses approximately 500 MB of RAM.
Very large projects:

8 GB of RAM in total

Limit the number of instances to 2 or 3

6 Proficy* Logic Developer - PLC* 8.50 GFK-1918S
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Other requirements
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The Development Environment is supported on VMware with the following
VMware requirements:

» Minimum requirement
Player 2.0 or greater
-or

VMware Workstation 6.0 or greater.

» For multiple processor cores' (required to leverage multi-threading
performance gains):

4 Player 4.0 or greater
-or
» VMware Workstation 8.0 or greater.

Notes

1. After powering down the guest operating system (O/S) of a VMware
virtual machine, configure the number of cores to use for that virtual machine:
match or come as close as possible to the number of cores in your
computer's processor. You cannot configure the number of cores for a virtual
machine if its guest O/S is running or paused.

2. The APM Motion Programmer does not function if Proficy Machine
Edition* is executed from within VMware.

» Internet Explorer 10.0, 9.0, or 8.0; with current updates.
You must install Internet Explorer before installing Machine Edition.

» TCP/IP network protocol (if you use an Ethernet connection).
.NET Framework 4.5 Full. If the Microsoft .NET Framework is not yet
installed, it is automatically included during the installation of Machine Edition,
and a reboot may be required to complete the installation.
2 GB hard disk space. Additional space is required for your projects and
temporary files.

Proficy* Logic Developer - PLC*8.50 7



1 Welcome

INSTALLATION

For last-minute information, release notes, and supported hardware lists for
Machine Edition* products, see the Important Product Information (IPI)
document on the install disk. There are several ways to view this document:

» When installing Machine Edition, select Important Product Information on
the initial Launcher screen.

> When running Machine Edition, from the Help menu, choose Important
Product Information.

If you have a previous version of Machine Edition installed on your computer,
you must uninstall it before installing the latest version. All of your existing
projects, settings, and authorizations are preserved following an uninstall
operation.

To install Logic Developer - PLC*
1. Insert the Machine Edition install disk into your CD-ROM drive.

By default, the setup program automatically starts. If the setup program does not
automatically start, run Setup.exe in the root directory of the install disk.

2. Click Install to start the install process.
3. Follow the instructions as they appear on the screen.

For information on troubleshooting installation problems, see the IPI Release
Notes.
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PRODUCT AUTHORIZATION

A new installation of Logic Developer - PLC* provides a 4-day trial license with
full access to Logic Developer - PLC features. This license overrides all other
licensing and cannot be removed. Any licensing added is apparent on the fifth
day.

To continue using Logic Developer - PLC beyond the 4-day trial period, you must
authorize the software.

Two types of authorization are available: software key authorization and
hardware key authorization. On a single computer, it is not recommended to use
both types of authorization.

Hardware Key Authorization

A M4 or MAX USB hardware key contains authorization files that are read by the
Proficy Common License Viewer, which enables Proficy products, including
Logic Developer - PLC, to execute.

To see what products and target types are authorized by a hardware key

* On the operating system Start menu, point to Programs, then to Proficy

Common, and then choose License Viewer.

To authorize Logic Developer - PLC with a hardware key

GFK-1918S

1.

Find out which version of the Proficy Licensing Software is installed on your
computer: On the operating system’s Start menu, point to Programs, then to
Proficy Common, and then choose License Viewer. In the top right corner of
the License Viewer window that appears, click About. Take note of the version
number that appears and click OK.

If this is the first time you install a Proficy product, access http://support.ge-
ip.com, and in the top right corner, click Register. In the Single Sign On page
that appears, enter your email address and click Submit. When you receive a
GE Intelligent Platforms Web Access Registration email, follow the instructions.
In the Single Sign On -- SSO Registration application window that appears, fill
out the information and click Submit.

3. Access http://support.ge-

ip.com/support/index?page=securitykey&id=ST15&Iclicked=Licensing Key
Updates (login req). Enter your SSO User ID and Password. In the middle of the

page that appears, follow the Updating the Max/M4 or Pro/M1 key procedure,
keeping in mind the following:

Proficy* Logic Developer - PLC*8.50 9



Welcome
Product Authorization

Logic Developer - PLC does not support the insertion of a hardware key into
a parallel port, the insertion of hardware keys in multiple USB ports, or the
combination of a hardware key with a software key on the same computer.

If the web site refers to a more recent version than the one on your computer,
uninstall your current version, download the more recent version, and install
it.

The USB port is usually located on the front or back of your tower case, or in
the side of a laptop. We do not recommend using a USB port on your monitor.

If this is a new hardware key, double-click the license file <serialnumber>.plic
(supplied by your local distributor). In the wizard that appears, accept all the
defaults. The license file will be flashed onto your key.

The first time you plug the key into a USB port, you see a progress dialog box
that indicates that Windows has detected new hardware and is updating its
system settings. After the dialog box disappears, the settings stored in the
hardware key are active and you can use the products that it authorizes.

You must leave the hardware key in the port while using the products. If you
remove the key from the port, authorization for those products is removed and
replaced with read-only access to your projects.

To move the hardware-key authorization to another computer

* Remove the hardware key from the source computer and follow the previous
procedure on the destination computer.

After the authorization file <serialnumber>.plic has been flashed to the M4 or
MAX hardware key, it can be used on any computer on which the current version
of the Proficy Common License Viewer is installed.

Software Key

When authorizing Logic Developer - PLC with a software key, you need to
contact us by telephone, fax, or e-mail. Authorization personnel are available on
the telephone between 6 a.m. and 6 p.m. MST.

Software key authorization is specific to a single computer. If you want to work
with Logic Developer - PLC on a different computer, you must move the
authorization to that second computer (see page 11).

To see what products and target types are authorized by a software key

» On the operating system Start menu, point to Programs, then to Proficy (or GE
Fanuc or CIMPLICITY Machine Edition, depending on when Machine Edition
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was first installed on the computer), then to Proficy Machine Edition, and then
choose Product Authorization.

To authorize a copy of Logic Developer - PLC with a software key

1.

Have your serial number ready.

The serial number can be found on the Certficate of Authentication that came
with Logic Developer - PLC.

. On the operating system’s Start menu, point to Programs, then to Proficy (or

GE Fanuc or CIMPLICITY Machine Edition, depending on when Machine
Edition was first installed on the computer), then to Proficy Machine Edition, and
then choose Product Authorization.

In the Product Authorization dialog box that appears, click Add.

Select how to authorize: by Internet, Phone/Fax/E-mail, or Floppy Disk
Transfer. Click Next.

If you choose the Internet option, follow the instructions on the web site.
If you choose the Phone/Fax/E-mail option, proceed to step 5.

If you choose the Floppy Disk Transfer option, ensure that you have an
authorization removable media before proceeding.

Fill in the fields in the dialog box.

Fields that are identified with an asterisk (*) must be filled in.

If authorizing by:

Phone, click Phone/Fax and call the number on the screen to receive one or
more new key codes.

Fax, click Phone/Fax. In the dialog box that appears, click Print FAX. Fax
the Product Authorization Request to us, using our fax number on the
printout. We will reply by fax with your new key code(s).

Internet. On the Authorization web page, click Submit Authorization. We
will then reply by e-mail with your new key code(s).

E-mail, click Send E-mail. In the dialog box that appears, click Authorize to
e-mail us. We will reply by e-mail with your new key code(s).

Product Authorization is complete after you enter the new key code and it has
been accepted. If you have purchased other Proficy products, you may need to
run the Product Authorization program for each product.

To move the software-key authorization to another computer

GFK-1918S

You can run the software only on the computer that has Product Authorization.
To develop your projects on a different computer, you need to complete the
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following steps to move the software key authorization from one computer to
another. (For a more detailed procedure with screen shots, access www.ge-
ip.com/support and look up Knowledge Base article KB5659.)

On the computer that the authorization will be moved to, do as follows:

1.
2,

4.

Install Logic Developer - PLC*

On the operating system’s Start menu, point to Programs, then to Proficy (or
GE Fanuc or CIMPLICITY Machine Edition, depending on when Machine
Edition was first installed on the computer), then to Proficy Machine Edition, and
then choose Product Authorization.

In the top right corner of the Product Authorization dialog box that appears, take
note of the Site Code.
This code is required to generate the license file on the source computer.

Leave the dialog box open.

On the source computer, do as follows:

10.
1.

12.
13.

On the operating system’s Start menu, point to Programs, then to Proficy (or
GE Fanuc or CIMPLICITY Machine Edition, depending on when Machine
Edition was first installed on the computer), then to Proficy Machine Edition, and
then choose Product Authorization.

In the Product Authorization dialog box that appears, select Logic Developer -
PLC and click Move.

In the Before Moving message box that appears, read the note and click OK.
Enter the Site Code that you wrote down when you were on the destination
computer.

Caution: If the Site Code is entered incorrectly, the authorization will be lost and
cannot be recovered; you will need to contact technical support (see page 13).
Click Next.

In the Confirm dialog box that appears, verify that the site code is correct. If it is,
click OK.

Insert a blank formatted removable medium in the appropriate location.

In the refreshed Product Authorization dialog box, select the drive letter mapped
to the medium you inserted.

Do not select the C:\ drive; otherwise, your source license files will be
overwritten.

Click Next.

In the window that appears, confirm the accuracy of the Target Site Code. Ifit is
correct, click Finish.

12 Proficy* Logic Developer - PLC* 8.50 GFK-1918S
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The authorization code is moved to a file named authoriz.dat on the removable
medium you selected.

In the Authorization disk successfully created message box, read the message
and click OK.

On the destination computer, do as follows:

1.
2.
3.

9.

Insert the removable medium.
In the Product Authorization window that you left open earlier, click Add.

In the refreshed Product Authorization dialog box, select Floppy Disk Transfer
and click Next.

In the refreshed dialog box, to the right of the Please insert your Authorization
Disk field, click the button.

In the dialog box that appears, select the drive letter that corresponds to the
medium you inserted and navigate to the location of the authoriz.dat file. Click
Open.

In the Product Authorization dialog box, click Next.

In the refreshed dialog box, verify the product and contact information. If all is
correct, click Finish.

In the message box that indicates that the move was successful, click OK.

The authorization has now been moved to the new computer, as you can see in
the refreshed Product Authorization window.

Click Exit.

To change a software key to a hardware key or vice-versa

GFK-1918S
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Proficy* Logic Developer - PLC*8.50 13



14 Proficy* Logic Developer - PLC* 8.50

Welcome
Contact information

CONTACT INFORMATION

If you purchased this product through an Authorized Channel Partner, please
contact them directly.

General Contact Information

Online Technical Support and GlobalCare: www.ge-ip.com/support
Comments about our manuals or online help: doc.ip@ge.com
Additional information: www.ge-ip.com

Solution Provider: solutionprovider.ip@ge.com

Authorization: authorization.ip@ge.com

Technical Support

If you have technical problems that you cannot resolve with this guide, look up
the Machine Edition* online help. If you still need help, please contact us by
telephone or email, or on the web at www.ge-ip.com/support.

Americas

Online Technical Support: www.ge-ip.com/support

Phone: 1-800-433-2682

International Americas direct dial: 1-434-978-5100 (if toll free 800 option is
unavailable)

Technical Support email: support.ip@ge.com

Customer Care email: customercare.ip@ge.com

Inside Sales: insidesales.ip@ge.com

Primary language of support: English

Europe, Middle East, and Africa (EMEA)

Online Technical Support: www.ge-ip.com/support

Phone: +800 1-433-2682

EMEA direct dial: +420 239015850 if the toll free 800 option is unavailable or if
you are dialing from a mobile telephone

Technical Support email: support.emea.ip@ge.com

Customer Care email: customercare.emea.ip@ge.com

Inside Sales: insidesales.emea.ip@ge.com

Primary languages of support: English, French, German, Italian, Czech,
Spanish

GFK-1918S
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Asia Pacific

Online Technical Support and GlobalCare: www.ge-ip.com/support
Phone:

+86-400-820-8208

+86-21-3877-7006 (India, Indonesia, and Pakistan)
Technical Support email:

support.cn.ip@ge.com (China)
support.jp.ip@ge.com (Japan)

support.in.ip@ge.com (other Asian locales)
Customer Care email:

customercare.apo.ip@ge.com

customercare.cn.ip@ge.com (China)
Primary languages of support: Chinese, Japanese, English

Proficy* Logic Developer - PLC*8.50 15
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Proficy* Machine Edition*

Proficy* Machine Edition*

Proficy Machine Edition offers you a complete solution for the development of
automation applications, in one package. Machine Edition features an integrated
development environment and tools that enable you to spend more time building
applications and less time learning the software. All Machine Edition products
are fully integrated into the environment and interact with each other.

» They share the same set of tools providing a consistent interface throughout
the development process.

» Full drag-and-drop capabilities between tools and editors.

» A true scalable solution: you choose the type of Controller your projects run
on.

The following illustrates a Machine Edition project:
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2 Proficy* Machine Edition*

QUICK START

Machine Edition* makes it easy to get started developing a project.

To start Machine Edition

1. Click #stat| point to Programs, point to Proficy, point to Proficy Machine
Edition, and then choose Proficy Machine Edition.

After Machine Edition initializes, the Environment Themes dialog box appears.

Environment Themes ﬂ
Select an environment theme. A theme defines the layout of windows, toolbars, and other settings
uzed by the development environment.
Logic Developer PC - Previe :
ic Developer PLC Theme for Logic Developer - PLC
Logic Developer State TN A
Mation Developer IE & H
Wiew Developer
[T e —
G Luyges Dwvalcpn = LG
- Loge Levarzpar -
vicw
i Motion
e
g EE0IR o T HAL
o . B‘ =
()3 I Cancel |

Note: The Environment Themes dialog box appears automatically the first time
you start Machine Edition. To change the theme later, choose Apply Theme
from the Windows menu.

2. Choose the Logic Developer - PLC theme.
3. Click OK.

When you open a project, the appearance of your Machine Edition screen
matches the preview displayed in the Environment Themes dialog box.
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The Machine Edition dialog box appears.

Machine Edition

Select this option if you want
to choose an existing project. 7

Select this option to display on
the projects that have been

used recently. _—

x|

i~ Create a new project uzing

Empty project
" Machine Edition template
]

—é? ' [Open an existing projsct

| Location

My Computer
My Computer

My Computer
y 3Application 3 My Computer
3Application 2 My Computer
PR /—
Showe % Recent Projects &l Projects
[ Daon't show this dialog box on startup
|

Proficy* Machine Edition*
Quick Start

Select this option if you
want to create a new project
from scratch.

Select this option to use
a template to create your project.

. Select this option to display

all projects stored on your comput

4. Select the appropriate option to open a project. The Open an existing project
option is selected by default.

N

2

otes

If you select either the Empty project option or the Machine Edition
template option, the New Project dialog box appears and you can continue
creating a new project (see page 20).

If you select the Open an existing project option, you can also select either
the Recent Projects option or the All Projects option. The Recent Projects
option is selected by default.

5. If you selected the Open an existing project option, select from the list the
project that you want to open.

6. If you want, select the Don’t show this dialog box on startup option.
7. Click OK.

Your project opens in the Machine Edition environment that you specified in the
Environment Themes dialog box.

GFK-1918S
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To create a new pr

Choose your
project
template
from the
Project

A sample
description of the
project appears on
the screen.

2 Proficy* Machine Edition*
Projects

PROJECTS

You can create and edit Machine Edition* projects by using Proficy View, Logic
Developer - PC, and Logic Developer - PLC*. These products share Machine
Edition tools to provide a high level of integration between the various parts of
your project.

You can import folders created with Logicmaster, Control, or VersaPro.

With Logic Developer - PLC*, you can build multiple projects to suit your specific
requirements.

oject using a template
Before creating a project, there are some things you should know:
» The primary components your project will contain.
» The GE IP Controller your project will run on.
1. From the File menu, choose New Project, or click ﬁ on the File toolbar.

The New Project dialog box appears.

Enter the name of
Projsct bame:  [MyPACSystemsProjsc — | yourprojectinthe
Project Template: | GE Inteligent Flatforms PACS pstems F3i [Defaul] =] Setas default Project Name
2 box.
GE Intelligent Platforms PACSystems RX3i You can set the
A project with one GE Intelligent Platforms PACSystems RX3i target selected pl'OjeCt
preconfigured with default settings. template as the
default template
| o St by clicking the
-8 Sample argetl: ystems RS
- Targett Data Watch Lists: Ermpty Set as default
R Data Wakeh Lists Hardware Default PACSystarns button.
i Hardware Configuration Configuration: R¥3i sl
I Logic Logic  Program ~ Contains empty
=g Program Blacks Blocks: _MAIN LD Black

T _man

i - Refarence View Contsins Default
[-_ = Reference Yiew Tables

H i I il Tables: RWTs
-1 Supplemental Flss Supplemental Contains empty
Files: folders J
-

2. Choose a Project Template that suits your needs.
3. Enter a descriptive Project Name.
4. Click OK.

Your project opens in the Machine Edition environment.
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To open an existing project for editing
1. Open the M@ Navigator and select the E Manager tab.

----- 2 Sample Animatio A list of projects appears.

----- 3 Sample Blobs Gai .

..... ] 2. Do one of the following:

----- z . -

..... |Se » Right-click a project and choose Open.
3 Create Template -or-

..... B AddToServer
..... B Duplicate Project
..... B BackUp.

* Double-click a project.

..... P Your project loads and is ready for editing.
_____ Diestray Froject..
..... = Bename
;I_ Froperties
_E—m % Want to know more? In the online help index, look up “Projects”.

Navigator: Manager tab

To import a folder

-

Open the Navigator and select the Project tab.
Select the target that you want to import the folder into.
Right-click the target, point to Import, and choose the folder type.

In the dialog box that appears, navigate to and double-click the folder you want
to import.

P @ Dd

% Want to know more? In the online help index, look up “importing Control folders”,
“importing Logicmaster folders”, or “importing VersaPro folders”.
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@ Navigator

E Feedback Zone

Inspector

%2 Data Watch

ﬂ Toolchest

Proficy* Machine Edition*
Tools

TOOLS

Project development is supported by the Machine Edition* tools. Each tool is
opened by means of a button on the Tools toolbar. When open, each tool is a
docking window.

A description of each tool’s function is provided below.

LY N=i-o B

Navigator InfoViewer
Feedback Zone Companion
Inspector Toolchest
Data Watch

The Navigator contains a set of tabs. Each tab displays information about your
development system in a hierarchical tree structure similar to Windows Explorer.
The available tabs depend on which Machine Edition products you have
installed and what kind of work you are developing or managing. The Project tab
shows the overall organization of your application.

The Feedback Zone window is used to display several types of output
information generated by Machine Edition components. This interactive window
uses category tabs to organize the output generated from the Machine Edition
products you have installed.

The Inspector window lists the properties and current settings for a selected
object or element. You can edit these properties directly in the Inspector. When
you select several objects, the Inspector window lists the properties common to
all of them. The Inspector provides a simple method of viewing and setting
properties for all Machine Edition objects.

The Data Watch tool is a run-time debugging tool that enables you to monitor
and edit the values of variables. This tool is useful while working online to a
target. With the Data Watch tool, you can monitor individual variables or user-
defined lists of variables. Data Watch lists can be imported, exported, or saved
with a project.

The Toolchest is a powerful storehouse of objects you can add to your project.
You can drag most items directly from the Toolchest into Machine Edition editors.
You can choose from predefined objects or create your own reusable fxClasses.
The Toolchest adds true object-oriented capability to Machine Edition.

22 Proficy* Logic Developer - PLC* 8.50 GFK-1918S



@ Companion

ﬂ InfoViewer
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Tools

The Companion provides useful tips and information while you work. While the
Companion is open, it tracks your moves and displays help on whatever item is
currently selected in the Machine Edition* environment. It is context-sensitive
and displays a description of whatever you click in Machine Edition.

The InfoViewer is an embedded Web browser used mainly to display the
following:

> Machine Edition help
» Machine Edition reports
The documentation associated with a project or target

If you are familiar with Internet Explorer or Netscape Navigator, then you are
already familiar with the basic InfoViewer interface. Like the Companion, the
InfoViewer is context-sensitive. Press F1 to get help on any item you select in
the Machine Edition environment.

A table of contents is found in the InfoView tab of the Navigator.

% Want to know more? In the online help index, look up “Tools: an Qverview”.

Using docking markers

If the Show Docking Markers option is enabled, you can use docking markers to
help dock a tool window to a desired location.

As you drag a dockable window, a series of docking markers appear, indicating
valid docking locations. Docking markers appear as a series of blue arrows.
Move the mouse over a docking marker to preview how the window would be
docked when using that marker. Release the mouse button while hovering over
a marker to use that location.

» b These markers dock tools to the edge of an existing tool or to
f\,s\/\) the Machine Edition Environment window.

This marker “stacks” the tool overtop an existing tool window,

</ forming a series of tab-docked windows. You can then switch
between tab-docked tools by clicking the tabs that appear at
the bottom of the tab-docked windows.
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4

| .
EREEREE

Navigator: Variables tab. This
tab displays all the variables
used in a project.
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¥ myDINT
9 atherDINT
P regUDINT
----- Y atherDINT
®

o

: ¥ otherDINT
L resultDINT

----- Y resultDINT

----- "_':.H W_RO0006

myDINT
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VARIABLES

A variable is a named storage space for data. That is, the variable name
represents a memory location in the target Controller. The way in which the
variable represents a memory location is determined by the value of the
variable’s Ref Address property. A variable's Ref Address property can be set to
any of the following:

2

A reference address, for example,%R00001. This is the GE IP Controller
memory location that contains the variable's value. This can be an 1/O
register or an internal memory register on the Controller.

A blank. On a PACSystems?, if you leave a variable's Ref Address property
blank, the variable is a symbolic variable. Machine Edition* handles the
mapping for you in a special portion of PACSystems user memory space. On
Series 90* and VersaMax* Controllers, you cannot leave the Ref Address
property blank.

An /O variable address, for example%IX0.6.0.1. (PACSystems only.) This
represents the PACSystems Hardware Configuration terminal that contains
an I/O variable's value. For example, this can be a physical discrete or analog
1/0 point on a module or Genius device, a discrete or analog status returned
by the module, or global data.

A name. This makes the current variable an alias variable of the name, that
is, a variable that points to the same memory location as the name. The
following names may be valid:

? The name of a parameterized LD block parameter (provided the alias
variable is local to the same block)

The name and index of an array element, for example,
MyComplexArray[255,3]

? The name of a structure element, for example, MyStructure.MyElement
The name of another variable that is not used as an alias variable.

7 Want to know more? In the online help index, look up “Reference Address (GE IP

Controllers)”, “Symbolic Variables”, “I/0 Variables”, and "Alias Variables”.

GFK-1918S



Proficy* Machine Edition*
Variables

Arrays and compound structure variables are supported by Machine Edition*.
Variable definitions can be imported from and exported to a variety of file types.
You can edit your variables in a spreadsheet and then import them.

Variables used on PACSystems* targets must be externally published in order to
be viewed in Proficy* View.

% Want to know more? In the online help index, look up “Arrays in GE IP Controller targets”,
“Structure Data Types”, “Importing variables from a file”, and "Publishing PACSystems*
variables”.

User-defined Data Types

(PACSystems only.) A User-defined Data Type (UDT) is a structured data type
consisting of various elements of various other data types. You can define a UDT
to reside entirely in discrete memory or non-discrete memory. After defining a
UDT, you can create structure variables of that data type and use them in logic.

% Want to know more? In the online help index, look up “UDT".

Variable properties in the Inspector

The Ref Address and other properties of a variable, such as Data Type, are
configured in the Inspector. The following is an illustration of the Inspector
displaying a typical set of variable properties.

Yariable [TRAC]
MName Alea_jacta_est
[rezcription
Fublish True
Array Dimenzion 1 0
[Ciata Source GE Contraller
Fef Address *%R00001
[Data Type DIMT
Current Valug 0
Initial * alue u]
Default Display Format Decimal
Retentive True

General I
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To create a variable

Tew Yariable BOOL...
Packe

INT...
Impcrt...

CIMT.
Expcrt... -
Sork By UIMT. ..
Repott...

S BYTE.

Filtet By WORE, .,

Filter Configurati DWORD. ..

Delete Unused V. REAL. .
Mofrosh Yariable LRCAL...

Function Bl

New variable menu

Proficy* Machine Edition*
Variables

. Inthe T2 Variables tab of the [ Navigator, right-click = Variable List, point

to New Variable and then choose the data type of the variable. If you have only
one target in your project, then Machine Edition*creates a new variable with a
default name.

If you have more than one target in your project, then the New Variable dialog
box appears with a unique default name for the new variable.

Mew Yariable [ %]
Wariable Mame: I

Target: I MewProject j

[T Aray  Size: I * I
()8 I Cancel |

. (Optional.) Enter a unique name for the variable.

Variable names can range from 1 through 32 characters, begin with a letter or
the $ character, contain upper or lower case letters, use numbers between zero
and nine, and use the underscore character (“_").

3. Select the target the variable will be used in.
. If the new variable is an array, select the Array check box and enter the size(s).
. Click OK.

The new variable appears in the list in the Variables tab.

To map a variable to Controller memory or alias a variable

There are two ways to map a variable to Controller memory or alias a variable.

First method:

. Inthe T‘% Variables tab of the @ Navigator, right-click a variable and choose

Properties.

. In the inspector that appears, in the Ref Address field, enter a reference

address to map the variable or enter the name of another existing variable, a
parameterized LD block parameter, an array element, or a structure element to
alias the variable.

»  Spell out the exact reference address, for example, %R00123 or 123R (in
either case this maps the variable to %R00123), or enter only the memory
area, for example %R. This maps the variable to the next available address in
that memory area. For example, if %R00122 is the last address used by a 16-
bit variable, entering %R maps the variable to %R00123.
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Variables

> Spell out the name of another variable, or of a parameterized LD block
parameter, for example, MyVarWithALongName, or Abc. Or provide the
array’s name and the element’s number, for example, MyArray[5]. Or provide
the structure element’s name, for example, MyStructure.MyElement.

Notes (PACSystems* only)

If you leave the Ref Address property of a variable blank, the variable is a
symbolic variable.

» You can enter an |/O variable address to make the variable an /O variable,
but it is easier to map an I/O variable in the Terminals tab of a module. See
“I/O variables”, on page 69.

Second method to map or alias a variable:

1. Inthe T‘% Variables tab of the @ Navigator, right-click a variable and choose
Properties.

2. In the Inspector that appears, click the Ref Address field and then click the +]
button.

The Reference Address Wizard appears.

Reference Address Wizard |

a region of memory. \ i
LEUTIEACES 11 - Discrete |nternal = | When mapping,

Nhen aliasing, select a
sariable, LD block
>arameter, or element.

When aliasing, select a
filter.

GFK-1918S

/ Alias variable to: j Bit Fieference: ID g:

select an index.

Wariable Aliasing Filter When mapping, a
¥ Display wariables ¥ Display elements \ BOOL variable in
[V Display parameters 16-bit memory,

select a bit
0K I Cancel | Help »> | reference.

3. Do one of the following:
To map a variable to Controller memory: From the Memory Area list, choose a
region of Controller memory. In the Index box, enter an index from the beginning
of the region. Select a bit reference. The Bit Reference box is available only if
you are mapping a BOOL variable to 16-bit memory area on a PACSystems*.
Click OK.
- or -
To alias a variable: In the Variable Aliasing Filters section, select the
appropriate check boxes for the filters you want to use. In the Alias variable to
box, select what you want to alias the variable to. Click OK.

% Want to know more? In the online help index, look up “Bit references in non-BOOL
variables”.
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OPTIONS

=3 Contraller The Options tab of the Navigator contains option and preference settings.
=] Gen;ral o Options are organized into folders and pages. Click = or = to expand or
+-33 it:f: e Confuraton collapse folders. Examples:
. 8 L“;'iifﬁféﬂifén [ Controller > General > Duplicate Addresses: Indicates whether to
E Ef:;erences prevent, warn about, or ignore mapping two variables of the same data size (1,
5] Toolbars 8, 16, 32, or 64 bits) and length (array size) to the same reference address.
=11 Tools
Praperty Tnspector O Controller > Hardware Configuration > New Reference Assignment:
£] Tookhest The way in which default reference addresses are assigned when modules are
added to the Hardware Configuration.

4 »
] B EE 7

Y AL A [ Editors > 3 Ladder > [5j View > Coil Justification: The default column in
which coils are placed; also the column where the right power rail resides. The
default is 10.

3 Machine Edition > Preferences > Visual Style: The visual style used
for the Machine Edition* environment, including the appearance of toolbars, tool
windows, and menus. You can choose from several visual styles based on
different versions of Microsoft products and the Windows operating system:
Classic (based on Windows 2000), XP, 2003, and 2005.

Navigator: Options tab

To set options and preferences

1. Inthe & Options tab of the | Navigator, expand an options &3 folder and
right-click a [£] page within the folder to display the options in the Inspector.

2. Inthe Inspector, edit the option’s settings as needed.

Tip: When you click an option, the Companion automatically displays help on
that option. If the Companion is not already open, press SHIFT + F11 to open it.

To reset an entire page of options to their default settings:
1. Inthe 2 Options tab of the & Navigator, expand an options [ folder.
2. Right-click one of the [=] options pages, and then choose Reset.

Tip: To reset only one option, look up its default value in the Companion and set
the option to that value.
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To use Companion help
. Ensure that the 3 Companion is open. To open it, press Shift+F11.
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MACHINE EDITION HELP

Machine Edition includes a comprehensive online help system that enables you
to access specific help topics while working with Machine Edition.

Use the InfoViewer or Companion to access help.

Companion Help

The Companion is a Machine Edition help system that provides useful tips and
information while you work. While the Companion is open, it displays help on
whatever item is currently selected in the Machine Edition environment.

2. Click any item in Machine Edition, outside the Companion.

A description of the item you clicked appears in the Companion.

oo
& ® ¥ % & ¥ % GEIP Controller Target @ °
all iterns under a GE IP Contraoller target node will be
Configure downloaded to and run on the controller specified by the
Interact with the target properties. A redundancy target represents two
target controllers, each having its own Hardware Configuration. A
Import Folder project can contain multiple GE IP Controller targets or
CommeR TorE GE IP Remote I/0 targets.
An active target can be offline, online in monitor mode, or
online in programmer mode, Mon-active targets can be
only offline. v

InfoViewer Help

The InfoViewer, another Machine Edition* help system, provides detailed
information. The InfoViewer has the following features:

» its own toolbar for navigating the help system

a Table of Contents (in the InfoView tab of the Navigator)
» an index
»  a full-text search engine

InfoViewer help is context-sensitive. Click an item on the screen and press F1 to
display the appropriate topic in the InfoViewer.
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To use the Help index

1.
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Machine Edition Help

From the Help menu, choose Index.

The Index dialog box appears.

Type in the keyword to find:
o
Select kepword to lst related tapic Display
ZP =l
%0
%R
5
Z5A
%58
%50 ﬂ
Select topic to display:
Title | Location | Rating
Cancel

Click List Topics.

. Enter a keyword in the top text box or select one in the middle text box.

A list of topics appears in the bottom text box. The topics are sorted by their

rating or likelihood of containing the correct information.
In the bottom text box, select a topic to display.

5. Click Display.

The selected Help topic is displayed in the InfoViewer.

Tip: To narrow a search, click the Location heading. The list of topics will be

sorted by location and then by rating.
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To use the full-text search

GFK-1918S

You can use the standard HTML Help Viewer to perform a full-text search of the
Help. Advanced boolean search expressions can be applied.

1. From the Help menu, choose Search.
The Machine Edition Help Search dialog box appears in a separate window.

& - B A

Back Fopward Refresh Home nt Optionz  Infoliewer

| G |- ToeNTA 1108 RX3i Hardware

Configuration: an Overview

Search | Favorites I

Type in the word(z] to search for:

Ipacsystems j AMD
; ; ; OR I Related Tapi |
List T Dizpl elates opIcE
List Topics | Display | o
Select topic: Found: 85 MNOT ou create a target with a fiis
Title | Location | Rai=| R%3i rack system, the default

Systern Varables: PA.. Logic Dev: Var.. 1 _I Hardware Configuration (HWC) consists of a
P&CSystems Paramet... Logic Dev.: Pé... single main rack (EITIT ICE95CHS012) with a
PACSystems Word-fo... Log!CDev.: LD... power supply in slots 0 and 1 (El-

Parameters for PACS... Logic Dev.: Par... IC695PSA040) and @ CPU in slots 2 and 3 (El
PACSpstems R?| Ca... HWC: PALC... =aodP SRt

Converting PACSyste... Logic Dewv: Ov... IC695CPU310Y. In this configuration, '] empty
PACSystemns Fx3l Ca... HWC: PAC.. slots 4 through 11 are available for I/0

Logic: Series 90-70 v... HWC: Serie... modules. Slot 12 of an ICE95CHS01Z is
PACSystems Rx3i Ha.. HWC: PAC.. reserved for a Serial Bus Transmitter module
E’:‘Eg?:;ziﬂ;g; E;\;EETQELD {IC6O5LRENOLY. The power supply can be

< % | deletgd, cut and pasted, or dragged ta another
location. So can the CPU. For information on

= =0 00~ LT e L RO
* oo
4

I” Search pn?vious results other possible configurations on the
I” Match similar wards (5 R¥3i main racks, click the following
v Search titles only links: LI

2. Enter a search word or phrase in the top text box. SURROUND A PHRASE

WITH QUOTATION MARKS.

3. Click 2l to perform a boolean search; that is, use AND, OR, NEAR, or NOT to
create a boolean search expression.

4. Click List Topics.

A list of topics appears in the Select topic box. The topics are sorted by their
rating or likelihood of containing the search term, terms, or phrase.

5. In the Select topic box, select a topic to display.
6. Click Display.

The selected Help topic is displayed in the Help Viewer.

7. (Optional.) Click the 3] InfoViewer button to display the current topic in the

InfoViewer.
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Tips:

»To narrow the search results, click the Location heading. The listed topics are
sorted by location and then by rating.

> When using the HTML Help Viewer window, you may get better results if you
select the “Search titles only” check box and/or clear the “Match similar
words” check box.

To bookmark favorite topics
1. After using the HTML Viewer to perform a full-text search, select a topic you
want to add to your list of favorite topics and then click the Favorites tab.

The Machine Edition Help Search dialog box displays the selected topic title in
the Current topic text box (bottom left corner).

e fa}
Back Fopward Refresh Home Frint Optionz  Infoliewer

Block usage and block types -l
In PACSystems and Series 90-70 CPUs, called blocks and interrupt blocks
{scheduled blocks) can be of various block types.

Search Favorites |

Topics

Function Blocks: an Overview

KU i3
Bemove | Dizplay
Current topic:

"what are Blocks on GE IP Controllers?

(PACSystems only)

n User-defined
function block

{UDFB}

= Specialty
function block)

Instance Data of UDFEs, Specialty Function Blocks, and Block Type Block Usage

Specialty Function Blocks: an Overview called block Interrupt block

Standard Function Blocks: an Owerview scheduled block

Uszer-Defined Function Blocks [UDFB =) an Overview (Schedule ock)

What are Blocks on GE IP Controllers? Block Supported Supported

mhalf' are_tirgg_mm; U”t_GE Blr iontmuem? Parameterized Supported Supported if no
orking with Built-In Function Blocks

Working with Function Block s [PACSystems] Block Ezgim;;]?r:zgaue

Function Block Supported Mot supported

Mote: Built-in function blocks and standard function hlocks are function blocks hut they

are not blocks. See Function blocks vs. functions, blocks, and function block diagrams

and The four kinds of function blocks.

In other CPUs, called blocks and interrupt blocks {scheduled blocks) are

fdd Il of the block type Block.
allo e block type Bloc ;I
2. Click Add to add the topic to the Topics list.
3. (Optional.) Click the [2] InfoViewer button to display the current topic in the
InfoViewer.
4. To display a favorite topic in the Help Viewer, select it and click Display.
To remove a topic from the Favorites list, select it and click Remove.
GFK-1918S
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To look up topics in the Help Table of Contents

o

+ m Yariables

+-filll Utilities

= m Errors and Warnings

+ 6 1 - 000

+ -6 1000 - 1999
—-0E8 4300 - 4400

= l:@ Ertars

o o o o o o o) ]

Errar 4365
Errar 4370
Errar 4371
Errar 4373
Errar 4374
Errar 4350
Errar 4355

=

Navigator: InfoView Tab

GFK-1918S

1.

Click the  InfoView tab of the Navigator.

A table of contents for the entire help system appears.

Expand fifl Libraries and ® Books to locate a & topic of interest.
Double-click a & topic.

The topic is displayed in the InfoViewer.

InfoYiewer h

variable on same target [object type, object name:
property name]

This indirect variable points to a variable that doesn't exist
or points to a variable on another target. Indirect variables
must point to an existing variable, on the same target.

X
Error 4390: Indirect variable must peint to existing }

Solution

Reconfigure this indirect variable so it points to an existing
variable located on the same target as the indirect variable.

Tip: To scroll through error messages in the Feedback Zone, press F4d.

This also locates the error within the project |
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E|-- MewProject

- Targetl
% D ata'watch Lists
-l Hardware Configuration
E|:D~ Logic
E%g Pragram Blocks
LAl _MAIN
_d Reference View T ables
@3 Supplemental Files

Navigator: New PACSystems*
RX7i or RX3i Project
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GE IP Targets

GE IP Targets

A & target represents a run-time destination of the program or programs you
develop with Logic Developer - PLC*. Each target contains all of the components
associated with that target. Logic Developer - PLC supports the following GE IP
families of Controllers:

»  PACSystems™ RXi
PACSystems* RX7i
PACSystems* RX3i

»  Series 90*-70

» Series 90*-30

VersaMax*

» VersaMax* Nano/Micro

> Series 90* Micro

and the following GE IP remote I/O interface targets:
» Series 90*-30 Ethernet Network Interface Unit
Series 90*-70 Genius Remote I/O Scanner
»  PACSystems* RX3i Ethernet
» VersaMax* Ethernet
VersaMax* Genius

» VersaMax* Profibus
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ADDING, CONFIGURING, AND
CONVERTING TARGETS

Adding Targets

Typically a target is present in a project when you use a template to create the
project (see page 20). A project can contain multiple targets. Before grouping
targets into a project or isolating each target in its own project, consider the
following:

» How large are the targets? For example, a target that contains 200,000
variables should probably be by itself in a project.

Are the targets related? For example, a PACSystems* RX3i with a relatively
small program is connected to twenty GE IP Remote I/Os (RIOs). Size is not
an issue because RIO targets use little memory in a project. Grouping all the
targets into one project is appealing because it makes navigation much
easier from one target to another than if the PACSystems RX3i target and
RIOs are isolated in 21 separate projects. For another example, if you have
various targets that do not communicate with one another or do not serve a
common purpose, there may be little value in grouping them in one project.

One target is required for each Controller or remote /O adapter your project
accesses, except when you are using CPU redundancy. In this case, one target
contains a Primary Hardware Configuration and a Secondary Hardware
Configuration, which correspond to the primary Controller and the redundancy
Controller, respectively. For more information, see page 72.

Existing targets can be converted from one Controller family to another. For
more information, see page 38.

To add a target to a project

Add Target  » GE Controllers 1
GE Remote [/0x
Save L

Save As...
Close
Close {without

Validate Al
Dovnload Al
Clean All Build

Show Dacume
Properties

Project right-click menu

2.

In the Project tab of the | Navigator, right-click the Project node and
point to Add Target.

Point to GE Intelligent Platforms Controller or GE Intelligent Platforms
Remote I/0 and then respectively choose the GE IP Controller family or the
Remote I/0.

A new target appears in the Project tab of the Navigator. When expanded, the
new target contains a default Hardware Configuration, logic blocks, and
miscellaneous components.
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Configuring Controller Targets

The properties of a target specify the Controller family, the communication
connections between your computer and the Controller, and various other
settings. All properties are edited in the Inspector. The following table describes
common Controller target properties:

Name Edit the name for your target in this field.
Type The type of target is set by default to GE IP Controller.
Description Enter a description of your project in this field. The maximum

number of characters is 255.

Documentation Address

Enter the URL where your project documentation is stored.

Family

By changing the Controller type in this field, you initiate a
target conversion. Caution: Changes are irreversible.

Controller Target Name

The name of the target as stored on the Controller.

Update Rate (ms)

Set the rate at which the screen is updated while online to the
target.

Sweep Time (ms)

The sweep time of the Controller when online. This value is
also displayed on the status bar. (Read-only.)

Controller Status

The online/offline, run/stop status of the Controller. (Read-
only.)

Online Project Synchronization

When Enabled, Machine Edition* performs project
synchronization checks with an online Controller.

Physical Port

Choose the type of connection to the Controller (Ethernet,
COM, or modem).

IP Address

(Ethernet protocol only.) Set the IP address of the Controller.

[+] Additional Configuration

Group of properties used for the detailed configuration of
your communication connection.

Modem Communication

Group of properties to configure the modem communications
link between your computer and a remote GE target.

Other properties are available depending on the value of the Family property

and the CPU model.

To configure a Controller target
1. Inthe Project tab of the T3] Navigator, right-click a ¢ target and choose

Properties.

The properties of the target appear in the Inspector.

2. Inthe Inspector, configure the properties as needed.
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Converting Targets

With Logic Developer - PLC*, you can convert targets from one GE IP Controller
family type to another. For example, you can take the Hardware Configuration
and logic written for a Series 90*-70 Controller and convert them for use on a
PACSystems* RX7i. However, target conversions are irreversible; when logic
blocks are deleted during a conversion, they cannot be restored. We
recommend that you make a backup of your project before converting a target.
There may also be logic execution differences when converting an application
from one GE IP Controller family type to another, especially if a Series 90-70 is
involved in the conversion. You must validate the application execution prior to
deployment into a production environment.

. Inthe Project tab of the [/ Navigator, right-click a # target and choose

Properties.

The Inspector displays the target’s properties.

. Inthe Inspector, click Family.
. From the list, choose the new GE IP Controller family you want to convert the

target to.

Target

Mame 59070
Type GE Controller

Description

Documentation Address

Family Series 90-70PLC * |
FACSystems Ard

Contraller T arget Mame

Update Rate [ms) F'Aym Ri3i

= Series 90-70 PLC
Sweep Time [ms] Series 30-30 PLC
Werzabax PLC
Controller Status Versablax Nano/Mict
Enable Shared Yariables | Series 30 Micro PLC |
Physical Port CORA

[Hadditional Configuration

Inspectar
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There are two types of target conversions.
A basic conversion does the following:

»  Strips all the configured modules from the original Hardware Configuration
(HWC) and sets up the destination family’s default HWC, with a single power
supply and a CPU.

»  Deletes or adds target components, logic programs, or blocks of logic.

Updates the system variables, including the fault locating references if
applicable.

An enhanced conversion does the following:
»  Replaces a power supply with the destination family’s default power supply.

Retains the settings of CPU parameters common to the original and
destination CPUs when the settings are supported in the destination family;
otherwise, replaces them with the default settings.

> Retains all the original modules that are supported by the destination family.
Retains all the module parameter settings that are supported by the
destination family; otherwise, the default settings are used.

»  Ethernet module settings of non-supported Ethernet modules are used to
configure the destination's Ethernet daughterboard or default Ethernet
modules.

Converts unsupported expansion racks to the nearest equivalents.
» Deletes or adds target components, logic programs, or blocks of logic.

»  Updates the system variables, including the fault locating references if
applicable.

Displays a conversion report in the InfoViewer.

Caution: The capabilities of a destination target may be different from those of
the original target. Carefully examine the conversion report when it is available.
Validate the project and test it thoroughly before deploying it in production.

Note: The hardware must be configured before it is operational. For detailed
information on hardware configuration, see page 57.

% Want to know more? In the online help index, look up “Target Conversions”.
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CONFIGURING COMMUNICATION

For Logic Developer - PLC* to communicate with a target Controller, a
connection must be properly configured. The properties of a target are
adjustable to accommodate your connection(s).

To configure an Ethernet, modem, or serial connection with any GE IP Controller
1. Inthe Project tab of the [i=] Navigator, right-click a # target and choose
Properties.
The Inspector displays the target’s properties.

2. Inthe Inspector, set the Physical Port property to Ethernet or a COM port
(or a modem if one is installed).

3. If the Physical Port is Ethernet, enter the IP Address of the target Controller.

4. Double-click Additional Configuration to access the detailed settings for your
connection.

Note: An IP address must be set in the Controller before an Ethernet connection
can be established.

7 Want to know more? In the online help index, look up “Configuring communications with
GE IP Controller targets”.
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To set a temporary IP address for a PACSystems* RX7i, PACSystems* RX3i, or VersaMax*

Ethernet NIU target

GFK-1918S

1. Inthe = Utilities tab of the B Navigator, double-click # Set Temporary IP

Address.
The Set Temporary IP Address dialog box appears.

Set Temporary IP Address [ %]

Thiz utility iz designed to zet the IP address of the target
for a temporary time period. The P address will reset after
power is cycled. Please remember to download the
hardware configuration immediately after using this tool.

— MAC Addre:

Enter 12-digit MALC address uzing
hexadecimal notation [six 2-digit pairz].

— P Address to Set————————
Enter [P address uzing
dotted decimal notation. Exit |

o .o .o .0 ﬂelpl

— Metwark Interface Selection

If your computer haz multiple netwark
interfaces, you may pick the one to use.

[T Enable interface selection

. In the MAC Address field, specify the MAC address for the target.
. Inthe IP Address to Set field, specify the temporary IP address you want to set

on the target.

. If required, select the Network Interface Selection check box and specify the

network interface the target is located on.

. Click the Set IP button.

The IP address of the specified Controller or device is temporarily set to the
indicated address.

Warning: The IP address set by the Set Temporary IP Address utility is not
retained through a power cycle. If you want to set a permanent IP address, you
must download the Hardware Configuration to the Controller.
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To set a permanent IP address for a PACSystems*

1. Inthe Project tab of the T3] Navigator, right-click the # target and choose
Properties.

The Inspector displays the target’s properties.
2. In the IP Address property, enter an IP address.
3. Expand the fis Hardware Configuration.
4. Do one of the following:

For a PACSystems* RXi, expand the PACSystems RXi node, and double-
click the Ethernet node.
- Or -
For a PACSystems* RX7i, expand the il main rack, expand the 8 CPU, and
double-click the Ethernet subnode.
- Or -
For a PACSystems* RX3i, expand the fiil main rack, double-click every H
IC695ETMO001 Ethernet module and repeat step 5 for each one of them.

5. In the Settings tab that appears in the Parameter editor, set the IP Address, the

Subnet Mask, and the Gateway IP Address.

6. Download the Hardware Configuration to the PACSystems.

7 Want to know more? In the online help index, look up “Configuring communications with
GE IP Controller targets” and “Set Temporary IP Address utility”.

To set an IP address for Series 90*-70 Controllers

1. Inthe Project tab of the I Navigator, expand the s Hardware
Configuration.

2. Expand the il main rack and double-click the 8 slot where you want to add a
communications module.
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The Module Catalog appears.

Dizcrete Inputl Dizcrete Dutputl Analog Inputl Analog Dutputl WME I
Communications | Bus Expansionl Bus Eontrollerl Intelligent Dptionl

Lancel
Catalog Mumber | D escription |

ICES7CM T Communications Coprocessor Help x>

dil;

ICEI7CMM 721 GEnet MAP Carrierband [Single Slot)
ICEI7CHMM 74 Ethernet Controller Type 1
ICEI7CMM 742 Ethemet Controller Type 2
ICES7BEMT7ES DLAM Interface Module

. Choose the Communications tab and select the communications module you

want to add.
Select either IC697CMM741 or IC697CMM742.

. Click OK.

The Parameter editor displays the configuration settings for the module.

. In the Settings tab, double-click the IP Address parameter.

The IP Address dialog box appears.

IP Address: E

Jn.o.0.0
0K |  Cancel | Hep |

. Enter the IP Address and click OK.
. Download the Hardware Configuration. For more information, see page 49.

To set an IP address for a Series 90*-30 CPU364, CPU372, CPU374, NIU004, or a VersaMax*

CPUEO05

GFK-1918S

Note: An Ethernet adapter is built into CPU364, CPU372, CPU374, NIU0O4, and
CPUEOQ5. For other Series 90*-30 CPUs, Ethernet connections are supported
through an optional expansion slot on the rack.

. Obtain an IP address, perhaps from your network administrator.
. Inthe Project tab of the [E| Navigator, expand the i Hardware

Configuration and expand the main rack.

. Right-click the slot containing the CPU364, CPU372, CPU374, NIU004, or

CPUEO05 and choose Configure.
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In the Parameter editor that appears, click the Ethernet tab.

The Parameter editor displays the contents of the Ethernet tab.

Settingsl Scan I Memoryl Power Consumption  Ethernet | Fi5-232 Port [Station Manager]l F5-232 Port [EMET S Load]l
Parameters VYalues |
Configuration Mode: TCRAP |
Adapter Mame:
IP Address: 0.0.0.0
Subnet Mask: 0.0.0.0
Gateway P Address: 0000
Wame Server IP Address: 0.0.0.0
Status Address: #0000
Statuz Length: a0
Metwark Time Sync: Mone
AdUI Tranzceiver Power [wattz]: 2
[

InfaViewer  (0.1)ICE33CPL.

Double- click the IP address parameter.
The IP Address dialog box appears
Enter the IP address in the box and click OK.

Download the Hardware Configuration. For more information, see page 49.

To set an IP address for other Series 90*-30 CPUs (not CPU364, CPU372, or CPU374)

1.

In the Project tab of the [E| Navigator, expand the fii Hardware
Configuration.

Right-click the slot containing an Ethernet Interface Module (IC693CMM321)
and choose Configure.

The Parameter editor displays the configuration settings for the module.

. In the Settings tab, double-click the IP Address field.

The IP Address dialog box appears.
Enter the IP address and click OK.

5. Download the hardware configuration. For more information, see page 49.

To download an IP address via a Controller serial port

1.

Configure a CPU or Ethernet communications module with an IP address using
gis Hardware Configuration.

Right-click the target and choose Properties.

The Inspector displays the target’s properties.

3. In the Physical Port property, select a serial connection.

Right-click the target and choose Go Online.
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5. Right-click the target and choose Download to Controller.
The Download to Controller dialog box appears.
6. Select Hardware Configuration and click OK.

The IP address is assigned to the Controller and the rest of the Hardware
Configuration is downloaded to the Controller.

7. Right-click the target and choose Go Offline.
8. Right-click the target and choose Properties.
9. In the Physical Port property, select Ethernet.

The next time you go online, Machine Edition* will use an Ethernet connection
with the specified IP address.
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INTERACTING WITH A CONTROLLER

Communicating with a PACSystems*, Series 90, or VersaMax* is necessary to
perform such operations as storing and loading programs or monitoring data
values and Controller Status information. You can connect to a Controller from
Logic Developer - PLC* over a serial, Ethernet, or modem connection,
depending on the Controller’s capabilities.

All interactions with a target are available from the target’s right-click menu.

Validating a Target

Validating your target detects syntax and configuration errors on the target. Error
messages are generated for each error and displayed in the Feedback Zone. A
target containing errors cannot be downloaded. A target is automatically
validated before a download operation.

In the Project tab of the I/ Navigator, right-click a @ target and choose
Validate.

Logic Developer - PLC* checks all items under the target for syntax errors. Any
errors detected are noted in the Build tab of the B Feedback Zone.

Tip: Double-click an error message to locate the noted error in your project. The
appropriate editor or tool opens automatically with the item in question selected.
Press the F4 key to locate the next error or warning in your project. Tips showing
you how to proceed are displayed in the Companion. To open the Companion,
press SHIFT + F11.

Offline, Online: monitor mode, programmer
mode

When offline from a PACSystems*, Series 90, or VersaMax*, there is no ongoing
communication between the Controller and your development computer. A
physical communication link is not required as long as you only edit logic; it is
required only when you want to communicate with the Controller.

The only Controller operations you can perform while offline are to go online or
to set up the temporary IP address (see page 41).

When online with a target Controller, a communication link exists and is active
and you have an ongoing real-time communication with the Controller.
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1.
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When online in monitor mode, you can monitor the Controller while it is
executing. You cannot edit logic on your computer. You cannot change any
values on the Controller. Depending on your level access on the Controller and
your Change Management permission levels, you can upload from the
Controller.

When online in programmer mode, you can make changes on your computer
and the Controller and can monitor the Controller while it is executing. You can
edit any type of Controller logic on your computer. Depending on your level
access on the Controller and your Change Management permission levels, you
can upload from the Controller, control the Controller while it is executing, and
change values on the Controller, including downloading to the Controller. When
editing LD logic while online, you can make word-for-word changes (see page
104); on PACSystems, you can also use the test edit feature (see page 102).

When online in either mode, if the project stored on the Controller is equal to the
current project in Logic Developer - PLC*, the LD editor displays a graphical
representation of LD logic as it executes.

7 Want to know more? In the online help index, look up “Offline (Logic Developer)’.

Controller

In the Project tab of the [E| Navigator, ensure that no ## target Controller is
already online.

You can be online to only one target at a time. When a target is offline, its icon is
grey.

. If the name of the target you want to go online to does not appear in bold

characters, right-click the target and choose Set as Active Target.
Bold characters indicate that this is the active target.

Do one of the following:
Right-click the active target and choose Go Online.
-or-

> Click the thunderbolt on the Online toolbar: | #

Logic Developer - PLC* connects your project to the GE IP Controller. The online
status is indicated by the target icon in the Project tab and on the status bar.

T ti Controller's run state Sweep time
argetican | ?utputs enabled/disabled |

# | Monitor, Stop Disabled, Config EQ, Logic EQ, Swesp= 0.0 ms

_Online mode; Logic equality
Monitor or Programmer

HwZ equality
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Note: When online to a GE IP Controller, the target icon in the Project tab of the
Navigator appears as g (equal), W (not equal), or @ (stop faulted).

To change the online mode

* Inthe Project tab of the @] Navigator, right-click the ## target Controller,
point to Online Commands, and choose Set Programmer Mode or Set
Monitor Mode.

To go offline from a GE IP Controller
» Do one of the following:

In the Project tab of the [/ Navigator, right-click a ﬁ target Controller
and choose Go Offline.

- Or -
Click the thunderbolt on the Online toolbar; | #

Logic Developer - PLC* goes offline.

7 Want to know more? In the online help index, look up “going online to GE IP Controllers”,
“setting online programmer mode”, “setting online monitor mode”, and “going offline from GE
IP Controllers”.
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Upload/Download

The download process builds and validates all run-time files necessary for a
target to perform its role in a completed project. The compiled project is then
transferred to the target hardware over the communication connection
previously configured. For more information, see page 40.

The upload process acquires a project from the active GE IP Controller target
and transfers it to Logic Developer - PLC for editing.

To download to a GE IP Controller
1. Ensure that you are online in programmer mode to the target Controller.

2. Inthe Project tab of the | Navigator, right-click the #p target to which you
want to download files and choose Download to Controller.

The Download to Controller dialog box appears,displaying these or other

options.

Download to Controller [ <]
Download to RAM ————————————
I \H ] Lancel |

v Logic

¥ Initial/Forced values

IV ‘wiiite ALL iterns to flash memaory ‘

Note: If the Controller is running, you can download only logic that is not equal to
the Controller’s current logic and the Download to Controller dialog box does not
appear. On a PACSystems*, some source files that do not affect equality are
also downloaded.

3. Choose the items you want to download and click OK.
Note: Only one project can be downloaded to a target at a time. If you download
to a target Controller that already has a project on it, the existing project is
overwritten.
For each target that you download, Machine Edition* performs a validation. Any
errors that occur are displayed in the Build tab of the B Feedback Zone. If there
are no errors, Machine Edition builds and sends all the necessary run-time files
to the Controller.

7 Want to know more? In the online help index, look up “downloading to GE IP Controllers”.
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To upload files from a GE IP Controller
1. Ensure that you are online to the target Controller.

2. Inthe & Project tab of the I Navigator, right-click the ## target Controller from
which you want to upload information and choose Upload from Controller.

The Upload from Controller dialog box appears, displaying these or other

options.
Upload from Controller E
Optio:

I

Lancel

v Logic

¥ Initial/Forced values

3. Choose the item(s) you want to upload and click OK.

The selected items are uploaded to Logic Developer - PLC*. If you already had a
version of the project open, the uploaded project merges with the existing
project. Because variable names are not stored on Series 90* or VersaMax*
Controllers, if you upload to an empty target, all variables are assigned default
names. For example, %R00001 is named R00001.

7 Want to know more? In the online help index, look up “uploading from GE IP Controllers”.
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Add Component 3 R un I s t o p

Add &l Components . .

Y SE— > When you are online in programmer mode, you can set a target GE IP Controller
Feu— = to Run or Stop mode. In Stop mode, you can choose to enable or disable the
Delete,.. el Outputs.

Set as Ackive Target

Validate F7
Download to Controller F&
Upload from Controller
Download and Start F3
Go Offline

Cnline Commands 3
Shiawy Runtime

Repork
Diagnostics
Show Docume
Find in "CPUZ

Clean Build Fr
Irnpork
Export Binarie

Properties |

To start a GE IP Controller
* Do one of the following:

7 Inthe Project tab of the T Navigator, right-click a ## target, point to
Online Commands, and then choose Start Controller.
-or-

© Click ™ on the Online toolbar: | # [@]% » &

The target Controller begins executing its program.

Note: If you are starting a PACSystems* or Series 90*-70 Controller, you can
choose to have outputs enabled or disabled.

To stop a GE IP Controller
1. Do one of the following:

» Inthe Project tab of the 1] Navigator, right-click a # target, point to
Online Commands, and choose Stop Controller.
- Or -

> Click ™ on the Online toolbar: l # [@] u
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The Stop Controller dialog box appears, prompting you to enable or disable the
Controller’s outputs.

Stop Control ﬂ

" Outputs Enabled

' Outputs Disabled

Cancel |

. Select an option.
. Click OK.

The target Controller stops executing its program.

% Want to know more? In the online help index, look up “starting GE IP Controllers” and
“stopping GE IP Controllers”.

Fault Tables

The Controller and 1/O Fault Tables display fault information logged by the CPU
or modules in the Controller. This information is used to determine if there are
problems with the Controller hardware or software running in the Controller’s
CPU.

To view the fault table reports

* Do one of the following:

» Inthe B8 Project tab of the I| Navigator, double-click the L] target you want
a fault table report on, or right-click it and choose Diagnostics.

- Or -
» In the status bar, at the bottom of the Machine Edition* window, double-click
the target.

Note: To view the Controller and I/O fault tables, your computer must be online
to the Controller. To clear faults, you must be in online programmer mode.
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The fault table appears in the InfoViewer window.

GE IP Targets
Interacting with a Controller

Choose the type of
faultinformation you
require.

Print fault table by
clicking here.

Choose Fault Table
@ controllar
 yo

~
Print Fault Tables

| Save Fault Tables

Save fault table to .
xml file by clicking

Fault Extra Data

Format
@ Byte T Word
Select the format € ascn
of fault data. Sort Order
" Location

" Dascription
" Date/Time

Sort fault
information.

& Hone

" asc | # pesc

Clear Controller Fault
Tahble

(When in online
programmer
mode only.) Clear
fault information
by clicking here.

el Saa Status ;
o/ Time: ao00o-azee Fault Table Viewer online Indicates
Last Cleared: 2000 01:00:00 online status
Controller Fault Table (Displaying 16 of 81 faults, 65 Overflowed) of Controller.
(ra;:]_;ﬂt) Fault Description Date/Time
0.1 Can't locate remote node; discarded request 09-23-2000 05:58:47
0.1 Can't locate remote node; discarded request 09-21-2000 02:40:09 View the date
0.1 Bad remote application request; discarded request 09-21-2000 00:36:35 and time of
0.1 Connection to remote node failed; resuming w/o it 09-17-2000 02:39:28 the faults.
0.1 Can't locate remote node; discarded request 09-16-2000 23:51:46
H Error Code Group Action Task Num
31 22 2:Diagnastic 0 Double-click a
Fault Extra Data: | 16 00 06 00 03 00 05 00 00 00 gg gg 0000000000000000 00881 { | row to view
0.1 LAN severe network problem; attempting recovery 09-16-2000 23:20:44 details of
0.1 Local request to send was rejected; discarded request 09-16-2000 23:18:21 faults.
0.1 LAN severe network problem; attempting recovery 09-16-2000 22:42:34
0.1 Reset of communications interface 01-01-2000 03:02:11
0.1 Mo user program present 01-01-2000 03:02:08 [

% Want to know more? In the online help index, look up “fault” (in lower case), then select
“Working with the Fault Tables”.
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Reference View Tables

In Reference View Tables (RVTs), you can monitor reference data when you are
online to a GE IP Controller. If you are in online programmer mode, you can also
use RVTs to change the values of reference data. In the & Project tab of the &
Navigator, the ‘@ Reference View Tables folder contains a ‘& Default Tables
folder. You can add O user-defined tables to the Reference View Tables folder.
A target can have zero or more user-defined RVTs.

You can configure the default appearance of your RVTs in the Options tab of the
Navigator. For more information, see “Options”, on page 28.

Data values at sequential addresses are displayed from right to left, by default,
starting at the reference address specified in the Address column. Both default
and user-defined RVTs display rows of 8 cells for discrete memory (each cell
corresponding to 8 bits) and rows of 10 cells for register memory (each cell
corresponding to one 16-bit register). The amount of data displayed in the
columns depends on the data display format.

Format of selected address Selected address Starting Address

AN /

Signed Decimal| Cut Cil+¢ | MO0 Address /

00 0ooooooo

Paste Cirl+ : :
N0 00000000, 00000000 00000000 00000071 %600001

+0, 4, | Cony Cul+C g +0, W0 8170 +100 127200 %RO0001 /

00 0ooooooo Delete Del [0 00000000 00000000, 00000000 00000001: 2100001

) g leEe (e 0, W0 32 16, -6 +1488  %Al0000

+0, +0 | fite +0, +0, +0, +0, +0,  +1E10;  ZAQ0om

00 00000000, pisplayMode  » PQ 00000000 00000000 00000000 0000000T  %M0001 /

w Format =T 00000 @0010710, 010110106 2500001

" Fomat View Table.. Octal / /

Hex
Unsigned Decimal |x]

v Signed Decimal 7 I

N

Infoiewer

_MAIN  Ref  Real / \
Scientific NotaEE h /

This i4 the data Dlsplay\format can

Subsequent at the starting be selected for

addresses are indivi

e e oot Address. |nd|V|dL.1aI cells or
isplayed right to le the entire table.

To create a user-defined Reference View Table
* Inthe Project tab of the I/ Navigator, right-click the ‘m Reference View
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To work with a user-defined Reference View Table

iew Tables

fiewT ablel

Navigator: Project Tab

Reference View Table node

To generate reports

GFK-1918S

1.

In the Project tab of the | Navigator, expand the ‘g Reference View Tables
folder and double-click the 3 table you want to view.

The Reference View Table appears in the main Machine Edition* window.

. Add reference addresses to the table as required.

Note: You cannot add reference addresses to a default RVT.

. Format the table entries as desired.

% Want to know more? In the online help index, look up “RVT", then select “Working with
user-defined Reference View Tables” or “Working with default Reference View Tables”.

Reports

Reports provide summaries and tables of information about your project. Most
reports are displayed in the InfoViewer (see page 29). The Reports tab of the
E Feedback Zone contains a list of all reports generated since the last Machine
Edition* project was opened. The following are types of reports and logic
printouts available in Logic Developer - PLC*:

Address Use report Hardware Configuration report IL block report L
Application Structure reports Initial Force States in Project LD block report L

report
CAM profile report Modbus Address report Local Logic block report L
EGD reports Variable Difference report Motion block report L
Forces in Controller report Variables reports Structured Text Blocks -

An L indicates a logic printout.

In the Project tab of the 1] Navigator, right-click a node and choose Report
to generate a report on that node.

A report is automatically generated and displayed in the InfoViewer.

Note: To generate a Forces in Controller report for a target, you must be online
to the target. Right-click the target and choose Report. In the Select a Report
dialog box, select Forces in Controller Report and click OK.
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To redisplay a previously generated report

1.

2,

In the E Feedback Zone, double-click the Reports tab.

A list of previously generated reports appears in the B Feedback Zone.
In the list, click the report you want to view.

The report appears in the InfoViewer.

Many items in a report contain hyperlinks. Click a hyperlinked item to jump to
that item in the project. For example, if a variable's name appears hyperlinked in
a report, clicking it selects that variable in the Variables tab of the Navigator.

Large reports are often separated into several pages. To view a different page of
the report, scroll to the bottom of the report in the InfoViewer and click the
number of the page you want to view.

To print a report displayed in the InfoViewer

1.
2.

To print LD Blocks

To print ST blocks

Generate the report you want to print, or redisplay a previously generated report.

When the report is displayed, right-click the ##| InfoViewer window and choose
Print.

In the Project tab of the [/ Navigator, expand the T Logic node.
Right-click the T:g Program Blocks node and choose Print LD Blocks.
The Print dialog box appears.
Select the blocks to print.
To print all of the target's LD blocks in alphabetical order, select the All option.

To print only some of the target's LD blocks, select the Selection option, then
select the check box in front of each block you want to print. To determine in
which order to print the blocks, select them one at a time and click Up or
Down until the selected blocks appear in the desired order.

Select options as required and click OK.

. Inthe Project tab of the T Navigator, expand the I+ Logic node.

Right-click the T8 Program Blocks node and choose Report of ST Blocks.

The Structured Text Blocks logic printout is automatically generated and
displayed in the InfoViewer.

7 Want to know more? In the online help index, look up “Reports” and “printing ST logic”.
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Hardware Configuration

Logic Developer - PLC* supports several GE IP Controller families and various
GE remote I/O interfaces (see page 82) with a variety of CPUs, racks, and
modules for each. In order to operate, GE IP Controller hardware must be
configured with Logic Developer - PLC or some other GE tool. The HWC
component of Logic Developer - PLC provides a way to configure your target
equipment. This chapter details specifics on configuring Controller hardware for
your operational needs.

The first step in configuring Controller hardware is to select the Controller you
want to configure (see page 36). When creating a new project, you can use a
project template containing a default Hardware Configuration, or you can create
an empty project and configure it manually.

PACSYSTEMS* RXI

The PACSystems™ RXi, pictured below, is an advanced, high performance, small
footprint, PROFINET-dedicated Controller designed for distributed applications
(process or discrete) in rugged environments.
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The PACSystems* RXi has the following characteristics:
2-port (shared MAC) Gigabit Ethernet I/O PROFINET network connection
Additional 1xGB Ethernet port

Built-in cable redundancy (MRP) delivering PROFINET 10 cabling redundancy
with no external switches

Dual core COMExpress ICRXICTL000 CPU with 2 GB RAM and up to 64 GB
internal flash data storage

Support for most LD, FBD, and ST instructions supported on other
PACSystems platforms

High speed Interconnect Bus enabling combinations of control and Proficy (or
other Microsoft® Windows® or Linux applications)

Internal industrial grade SSD drive providing local long-term data retention
Energy Pak supplying power to write data to NV RAM during power failures

USB and SD interfaces enabling program loading, serial communications,
and data storage via standard devices

(Optional.) Intelligent Display Module, a configuration and maintenance
touchscreen right on the Controller

% Want to know more? From the Help menu, choose Important Product Information. In the
window that appears, select the Logic Developer - PLC product, select Version 7.50, select the
New Features tab, and click PACSystems RXi.
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PACSYSTEMS* RX7I

The PACSystems RX7i is pictured below.

1/0 Modules

The PACSystems RX7i consists of a main rack and up to seven expansion
racks. The PACSystems RX7i supports a few types of main racks. It supports
five types of Series 90*-70 expansion racks. All main racks and expansion racks
support a few non-intelligent Series 90-70 fan kits.

The PACSystems RX7i main racks have 10 or 18 single-width VME slots. Slot 0
supports one of the power supply modules. Slots 1 and 2 are used to house a
double-width CPU. PACSystems RX7i supports a few CPU models. Each
PACSystems RX7i CPU has an embedded Ethernet adapter. In addition to the
Ethernet adapter, up to seven IC698ETMO001 Ethernet modules can be installed
in a PACSystems RX7i main rack. An Ethernet module occupies only one slot.
All of the IC698... modules are supported only on the main rack.

PACSystems RX7i supports most Series 90*-70 modules. Most Series 90-70
modules are double-width, that is, they occupy two slots on the main rack, but
they occupy only one slot on a Series 90-70 expansion rack. You can plug
double-width modules into any two adjacent slots of the main rack except slots
0, 1, or 2. Because slot 17 is a double-width slot, any module in slot 17 occupies
only slot 17. Slot 17 can also accept a single-width module.

PACSystems RX7i supports the following Series 90-70 bus expansion modules:
IC697BEM711
IC687BEM713
IC697BEM713

Proficy* Logic Developer - PLC* 8.50 59



=@
= m TPAC

----- % D ata'watch Lists

EI EL'_’ Ethernet Global Data
------ EEE Consumed Exchanges
------ EE Produced Exchanges
E1- ﬂ" Hardware Configuration
B- ﬁ Rack 0 (ICEI8CHS017)

Slot 2 [Uzed \With Slat 1
@ slet3q
...... u Slat 4 )

------ ﬂ Slat 16 ()

------ @ Slat17 ()
=1+ Logic

%g Program Blocks
#- g Reference View T ables
=My Supplemental Files

T
EAERER =N ENE

Navigator: Project Tab
displaying the HWC node of
a PACSystems* RX7i

60 Proficy* Logic Developer - PLC* 8.50

Hardware Configuration
PACSystems™* RX7i

PACSystems RX7i also supports Series 90-70 Genius Bus Controllers, which
support numerous Genius devices.

Configuring PACSystems* RX7i Hardware

When you create a target with a PACSystems RX7i rack system, the default
Hardware Configuration consists of the main rack, with a power supply in slot 0
and a single CPU in slots 1 and 2. You can replace the default power supply and
CPU, and add single-width or double-width modules. You can add up to seven
expansion racks, and on each of these, you can add Series 90-70 modules.

Note: On PACSystems RX7i targets, only one rack is added by default. On
Series 90-70 and Series 90*-30 Controllers, seven expansion racks are added
by default to the HWC. You do not need to add them.
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PACSYSTEMS* RX3I

The PACSystems RX3i, pictured below, is an upward compatible upgrade for
Series 90*-30 Controllers, offering more memory, faster clock speed, and an
enhanced backplane bus.

Rack

CPU /0 Modules

The PACSystems RX3i consists of a main rack and up to seven expansion
racks. Six types of Series 90-30 expansion racks are supported; they have
IC693CHSNNN catalog numbers and are colored black, in keeping with the
Series 90-30 color scheme. Two expansion racks have IC694CHSnnn catalog
numbers. These are identical to the IC693CHSnnn expansion racks of the same
numbers except that they are colored blue, in keeping with the PACSystems
RX3i color scheme.

The main rack and all expansion racks support most Series 90-30 modules;
these have IC693NNNnNnn catalog numbers and are colored black, in keeping
with the Series 90-30 color scheme. Almost all of the IC693NNNnnn modules
supported by PACSystems RX3i also come as IC694NNNnnn modules that
have identical functionality. The only difference is that the IC694NNNnnn
modules are colored blue, in keeping with the PACSystems RX3i color scheme.
For example, the IC693DSM314 and IC694DSM314 are functionally identical
and both can be used interchangeably in a Series 90-30 rack system or a
PACSystems RX3i rack system. The only hardware difference is their color.

When you configure a PACSystems RX3i rack system, you can select
IC693NNNnNnn or IC694NNNnnn racks or modules. When you configure a
Series 90-30 rack system, however, you can select only IC693NNNnnn racks or
modules. Even if you are physically using IC694NNNnnn racks or modules,
selecting IC693NNNnNnn racks or modules in Logic Developer - PLC* is
adequate.
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The PACSystems* RX3i default main rack, IC695CHS012, has 13 slots: Slots 0
through 12. The alternate main rack, IC695CHS016, contains 17 slots: Slots 0
through 16.

On either main rack, slot O is reserved for a power supply or the CPU, but the
power supply or CPU does not have to be in slot 0. The last slot is reserved for
the Serial Bus Transmitter module (IC695LREOQ01). The slot just before the last
slot can contain any single-width module native to PACSystems RX3i (IC695...)
except the Serial Bus Transmitter. Any other slot can contain any single-width
module native to PACSystems RX3i (IC695...) except the Serial Bus Transmitter,
and if the next slot is empty, they can contain any supported double-width
module.

The IC695PSA040 and IC695PSA140 power supplies and the CPU are two-slot
modules. The IC695PSD040 and IC695PSD140 power supplies are one-slot
modules. PACSystems RX3i supports many Series 90*-30 modules: each one
occupies a single slot.

Configuring PACSystems* RX3i Hardware

When you create a target with a PACSystems RX3i rack system, the default
HWC consists of the main rack, with a power supply in slots 0 and 1, and a CPU
in slots 2 and 3. You can replace the default power supply. You can replace the
CPU with itself to update it to the latest catalog version, that is, the latest set of
parameters supported for the CPU in Logic Developer - PLC*. You can move the
power supply and the CPU to any empty slot in the target with an adjacent empty
slot; however, the second adjacent slot cannot be the last slot. You can add up to
seven expansion racks, and on each of these, you can add IC693NNNnnn
modules and the IC694NNNnnn that are supported by Series 90*-30.

Note: On PACSystems RX3i targets, only the main rack is added by default. On
Series 90*-70 and Series 90*-30 Controllers, seven expansion racks are added
by default to the HWC. You do not need to add them.
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CONFIGURING CONTROLLER
HARDWARE

The following configuration procedures focus on the PACSystems* RX3i.
Procedures for the other Controller families supported by Logic Developer -
PLC* are nearly identical, when applicable.

The default power supply for the PACSystems RX3i is the IC695PSA040.

To replace a power supply (not applicable for PACSystems RXi)

1.

In the Project tab of the B Navigator, right-click the s power supply slot
and choose Replace Module.

A list of available power supplies appears.

Catalog Mumber
ICE9EPSA040
ICE95P54140
ICE35PS D040
ICE95PSD140

0/ C. 125vDC 400 Pawer Supply
Multlfunctlonal 120/240A0, 128V DC 40w Power Supply
28DC 400 Power Supply
Multifunctional 24%DC 400w Power Supply

Note: For non-PACSystems GE IP Controller families, there is no Slot 0. Right-
click the PWR slot instead.

Select the power supply you have installed in your rack and click OK.

The default CPU specified in the project template for a PACSystems RX3i is the
IC695CPU320.

To replace a CPU (not applicable for PACSystems RXi)

Configure Enter
Copy Chil+C
Paste Cirl+

IFis

Bz

Froperties Alt+E nter

HWOC right-click menu

GFK-1918S

1.

In the B8 Project tab of the T Navigator, expand the fii Hardware
Configuration.

All racks are revealed.

Expand the fili main rack.
Right-click the ] CPU slot and choose Replace Module.

Note: A GE IP Controller supports only one CPU; it can be replaced with itself to
update it to the latest catalog version, that is, the latest set of parameters
supported for the CPU in Logic Developer - PLC*.
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The Catalog dialog box appears.

Central Processing Unit |

. 5 e : R
ICE95CRUZ20 PACSystems Rx3i 1000kHz Celeron-M CPU 64 MB
ICESSMILIO0T PACSystems Rx3i 300MHZ Celeron NI
ICEIECHMUIT0 PACSpstems Rx3i 300MHz Celeron MaxOn CPU

Ok |
Cancel |

From the list, select a CPU.
Click OK.

A dialog box appears asking if you want to retain the settings from the existing

CPU.
Click Yes or No.

The target is configured with the selected CPU.

In the @ Project tab of the | Navigator, right-click a slot containing a CPU and

choose Configure.

The Parameter editor displays all configurable settings for the CPU.

Settings | Scan I Memoryl Faults I Part 1 I Port 2 I Scan Setsl Power Eonsumptionl

Parameters VYalues

Pazswords Enabled

Stop-Mode /0 Scanning Dizabled

‘watchdog Timer [ms] 200

Logic/Configuration Power-up Source Always Rak

D ata Power-up Source Always RAM

Memory Pratection Switch Dizabled

Power-up Mode Last

Infoigwer [0.1] ICESBCPE...
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2. Modify the settings as required. For information on any parameter of a
PACSystems* CPU, select the parameter.

Help topics for PACSystems CPU parameters appear in the Companion. To
open the Companion, press SHIFT+F11.

To add an expansion rack (PACSystems* RX7i and PACSystems* RX3i only)

Note: On Series 90*-70 and Series 90*-30 Controllers, seven expansion racks
are added by default to the HWC. You do not need to add them.

1

EREEIRE

Navigator: Project tab

PACSystems* HWC

1. Inthe Project tab of the | Navigator, right-click the &i§ Hardware
Configuration and choose Add Rack.

The Catalog dialog box appears listing available rack types.

Expanzion Racks |

Catalog Mumber

IEBSSEHSSSS
ICEI3CHS 338
ICEI3CHS333
ICE34CHS 332
ICRI4CHS 358

Description
90-30 Expansion B acl

90-30 Expansion Rack: 10- slot Femote [700ft.]
90-30 Expansion Rack: 5-glot

90-30 Expanzion Rack: 5-slot Remate (700 ft.)
90-30 Style Expanzion Rack: 10-slot

90-30 Stule Exnansion Rack: B-zlat

2. Select a rack and click OK.

The Series 90*-30 expansion rack is added to the PACSystems* RX3i rack
system. It is assigned an available number in the range of 1 through 7, excluding
numbers already assigned to other expansion racks.

To replace a rack (not applicable for PACSystems RXi)

l?‘"ﬁi'ﬁ

EBEEEE]

Navigator: Project tab

HWC configuration

GFK-1918S

A4 3

1. Inthe Project tab of the T Navigator, right-click a il rack and choose
Replace Rack.

The Catalog dialog box appears listing available rack types.

ICE93CHS 393
ICEI3CHS 398
ICES3CHS 399
ICE34CHE 392
ICRI4CHS 3597

SD 30 Expansmn Hack 1D slot Remate [FO0f.)
90-30 Expanszion Fack: 5-slat

90-30 Expanszion Rack: 5-zlat Remate (700 ft.]
90-30 Style Expansion Rack: 10-slot

A0-30 Stule Fxnansion Rack: B-alat

Cancel

2. Select a rack and click OK.
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To add a fan kit to a rack (PACSystems* RX7i only)

1.

In the Project tab of the [i=] Navigator, expand the i Hardware
Configuration.

. Right-click a fiil rack and choose Properties.

The Inspector displays the rack’s properties.

o =

Fack ﬂ
Catalog Mumber ICEI8CHS01 7

[rescription Standard 18-5

Fan Catalog Mumber Maone

Fan Description LI

Inzpector I

In the Inspector, click the Fan Catalog Number property.
The =4 button appears to its right.

Fan Catalog Mumber |N0ne :I

Click the = button.
The Catalog dialog box appears.

Fan Kits |

Catalog Mumber Drescription Carcel |
ICBS7ACCT21 Mon-Inteligent fan kit 1200

ICEI7ACCT24 MorInteligent fan kit 240AC

ICEI7ACCT44 Morvinteligent fan kit 244DC

Select the fan kit you want to add and click OK.
The fan kit is added to the rack.

To add an Ethernet module (PACSystems* RX7i and PACSystems* RX3i only)

1.

In the Project tab of the | Navigator, expand the i Hardware
Configuration and then fiii Rack 0 (the main rack).

. Double-click the slot you want to add an Ethernet module to, or right-click it and

choose Add Module.
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The Catalog appears.

x|
Central Processing Unit I
Dizcrete Inputl Dizcrete Dutputl Dizcrete Mixedl Analog Inputl Analog Dutputl oK
Analog Mived  Communications I Bus Eontrollerl Motionl 3rd F'artyl Power Suppliesl —I
Catalog Mumber Description |
|ICES5E Th4007 Ethernet Peripheral Module

Cancel

3. In the Communications tab of the Catalog, select the Ethernet Module and click
OK.

The Ethernet module is added to the slot.
4. Double-click the Ethernet module.
The Parameter editor appears.
5. Configure the Ethernet module’s parameters as needed.

g Want to know more? In the online help index, look up “configuring PACSystems RX3i rack
system”and “Parameter editor features”.
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To configure the Ethernet daughterboard (PACSystems* RX7i and RX3i only)

=
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1.

In the Project tab of the [i=] Navigator, expand the @i Hardware
Configuration, then fi# Rack 0 (the main rack), and then 8 the CPU.

. Double-click =5 Ethernet.

The Parameter editor appears.

Configure the Ethernet daughterboard’s parameters as needed.

To move a module (not applicable for PACSystems* RXi)

1. Inthe Project tab of the 1] Navigator, ® expand the fiis Hardware

Configuration and then the fii rack that contains the module.
Do one of the following:
* To move the module from one target to another: press SHIFT while

dragging and dropping the module onto an appropriate empty slot.
- Or‘ -

* To move the module within a target: drag and drop the module onto an
appropriate empty slot without pressing any keys.

You cannot move modules between different types of Controller targets, for
example from a Series 90*-30 to a PACSystems* RX7i.

The module is removed from the original slot and inserted into the empty slot.
Notes: (PACSystems RX7i and PACSystems RX3i)

> You can drag a double-width module to a main rack slot only if both the slot
and the slot after it are empty. Exceptions: The last slot on a PACSystems*
RX7i can contain a double-width module or one single-width module. The last
slot on a PACSystems RX3i main rack can contain only an IC695LRE001.

» Only PACSystems RX3i supports moving a power supply or CPU module.
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1. In the & Project tab of the 1] Navigator, = expand the fis Hardware

Configuration and then the fii rack that contains the module.

. Do one of the following:

To copy the module from one target to another: drag and drop the module
onto an appropriate empty slot without pressing any keys.

- or -

To copy the module within a target (not applicable for PACSystems* RXi):
press CTRL while dragging and dropping onto an appropriate empty slot.

You cannot copy modules between different types of Controller targets, for
example from a Series 90*-30 to a PACSystems* RX7i. Exception: You can copy
a PROFINET Controller from a PACSystems* RX3i to a PACSystems RXi or vice-
versa.

A copy of the module is inserted into the empty slot.
Notes
Only the PROFINET Controller can be copied to or from a PACSystems RXi.

(PACSystems* RX7i and PACSystems* RX3i.) You can drag and drop a
double-width module to a main rack slot only if both the slot and the slot after
it are empty. Exceptions: The last slot on a PACSystems RX7i can contain a
double-width module or one single-width module. The last slot on a
PACSystems RX3i can contain only an IC695LREQ01.

Only PACSystems RX3i supports copying a power supply.

I/0 VARIABLES

An I/O variable is a variable mapped to a terminal in the Hardware Configuration
of a PACSystems*. A terminal, for example, can be one of the following:

A physical I/O discrete or analog point on a PACSystems module or on a
Genius device

A discrete or analog status returned from a PACSystems module
Genius global data

Memory required to support I/O variables counts against your user memory.
When you configure the PACSystems CPU (see page 64), select the Memory
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tab and set the I/O Discrete (# of Bits) and I/O Non-Discrete (# of Words)
parameters to configure the space available for I/O variables.

To enable 1/0 variables for a module

1.

In the Project tab of the T3] Navigator, expand the # target that contains the
module.

. Expand the fiii Hardware Configuration and expand the fiil rack that contains

the module.

Right-click the 8 module and choose Properties.
The Inspector displays the module’s properties.

o
Slat Eﬂ
Catalog Mumber ICES7MDL24
Description 16 Faint Input
Reference Address 1 #lo0oa
Wariable Mode False LI
Inspector I

In the Inspector, set the Variable Mode property to True.

If the Variable Mode property is read-only and set to False, the module does not
support I/O variables.

In the dialog box that appears, click Yes.

If you enable I/O variables for a Genius bus Controller, I/O variables are enabled
for all the Genius devices on the Genius bus.

Note: When you enable I/O variables for a module, the Hardware Configuration
and logic become coupled. This means that they must be downloaded,
uploaded, or cleared together. You cannot change or add I/O variables in Run
Mode Store.

To map a variable to a terminal in the Terminals tab of a module or Genius device

1.

In the Project tab of the 1] Navigator, expand the 4 target that contains the
module or Genius device.

. Expand the @i Hardware Configuration and expand the il rack that contains

the module or device.

Double-click the # module or expand the Genius Bus Controller (GBC) and
double-click the Genius device.
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The Parameter editor displays the Terminals tab of the module or device.

Infoviewer .~ (0.10) IC693MDL230 [Target1] | 5 x

Settingsl W'iringl Power Consumption  Terminals |

Module: Node | Vatiable | Address Description
EE' Slot 10 (ICEI3MDLZ30) *
=l @ Reference Address

4. In the Terminals tab, right-click a terminal node that has no I/O variable mapped
to it and choose Map Variable.

The Variables smart list appears.

5. In the smart list, do one of the following:

»  Enter a name that is not used elsewhere in the PACSystems™* target. A new
1/0O variable by that name is created and mapped to the terminal. Its Ref
Address property is set to an I/O variable address. If the terminal is discrete,
the new /O variable’s data type is set to BOOL. If the terminal is analog, the
data type is set to INT, but you can change it to another 16-bit data type: UINT
or WORD.

_or_

» Enter the name of an existing CPU-mapped variable, symbolic variable, or
alias variable. (There are some mapping limitations.) The variable becomes
an /O variable mapped to the terminal and its Ref Address property is
changed accordingly.

7 Want to know more? In the online help index, look up “I/O Variables (PACSystems)”,
“working with 1/0 variables (PACSystems)”, and “Coupled Hardware Configuration and
Logic”.
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HOT REDUNDANCY SYSTEMS

Hot redundancy systems are supported only on PACSystems* RX7i,
PACSystems* RX3i, and Series 90*-70 Controllers. In redundancy systems, two
units are set up and configured identically. If one unit fails or is taken offline, the
other unit assumes responsibility without interrupting operation of the entire
system.

There are three types of hot redundancy systems:

»  Basic CPU Redundancy
»  Genius Redundancy

» CPU Redundancy Over Genius

Basic Hot CPU Redundancy

el
¢ -
g8
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Navigation: Project Tab
HWC Node
CPU Redundancy

(PACSystems RX7i,
PACSystems RX3i, Series 90-70

To implement basic hot CPU redundancy, a single Logic Developer - PLC*

% target is associated with two physical Controllers, a Primary and a
Secondary. Both Controllers share the same logic, but each has its own fiii
Hardware Configuration (HWC): Primary or Secondary. The selected HWC is the
HWC that you can go online with, download to, upload from, and so on.

Three types of basic CPU redundancy are available. These redundancy systems
can be used in combination with Genius redundancy schemes.

Single Bus with Preferred Master (Series 90-70 CPUs CGR772 and
CGR935 only): uses a single Genius bus with one or more bus Controllers in
each Controller. The primary unit is always chosen as the active unit when
the units initially synchronize.

Single Bus with Floating Master (PACSystems RX7i, PACSystems
RX3i,and Series 90-70 ): uses a single Genius bus with one or more bus
Controllers in each Controller. No switchover occurs on initial synchronization
to make the primary unit the active unit.

Dual Bus with Floating Master (RX7i, RX3i, and Series 90-70): uses dual
busses with one or more bus Controllers in each Controller. No switchover
occurs on initial synchronization. Bus Switching Modules (BSMs) are required
in accordance with configuration of a dual bus network. This option provides
redundancy of both the CPU and the Genius bus.
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Genius Redundancy

A Genius redundancy system contains duplicate components that are
configured to keep the Genius system operating properly even if one of the
duplicate components fails or is taken out of service. Genius redundancy
systems can be used in combination with PACSystems* RX7i, PACSystems*
RX3i, and Series 90*-70 CPU redundancy systems.

You can configure five types of Genius redundancy systems:

Genius dual bus redundancy (paired GBC internal)
Genius dual bus redundancy (paired GBC external)
Genius dual GBC redundancy (paired GBC internal)
Genius dual GBC redundancy (paired GBC external)
Genius dual bus & dual GBC redundancy

Hot CPU Redundancy Over Genius

A CPU Redundancy Over Genius system contains duplicate components that
are configured to keep the system operating properly if one of the duplicate
components fails or is taken out of service.

Five types of CPU Redundancy Over Genius systems can be built upon the

various types of redundancy Genius systems combined with the basic CPU

Redundancy schemes.

» CPU redundancy (GHS) using Genius dual GBC redundancy (paired
GBC external): Single bus with preferred master (Series 90-70 only)

CPU redundancy (HSB/GDB) using Genius dual GBC redundancy
(paired GBC external): Single bus with floating master

CPU redundancy (HSB/GDB) using Genius dual bus redundancy (paired
GBC external): Single bus with floating master

CPU redundancy (HSB/GDB) using Genius dual bus and dual GBC
redundancy: Dual bus with floating master

CPU redundancy (HSB/GDB) using a mixed Genius redundancy scheme

% Want to know more? In the online help index, look up “Redundancy: an Overview”".
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Hot Redundancy Systems

Configuring Hot Redundancy Systems

The procedures below are the general steps to follow for configuring hot
redundancy systems. For the procedures on configuring specific hot redundancy

systems, see online help.

To set up the primary Hardware Configuration for hot CPU redundancy (PACSystems* RX7i,
PACSystems* RX3i, and Series 90*-70)

In the Project tab of the [E| Navigator, expand the & target for which you
want to set up CPU redundancy.

1.

Wizard.

Hardware Reference View
Hardware Configuration Data View. .
Feport Chil+T

Mame Resolution and Routing...
Ethemet Global Data...
Restore EGD and Mame Resolution..

Redundancy

Import
Expoit to File...

Mirmor to Secondary Hardware Configuration

T

. Right-click @i Hardware Configuration, point to Redundancy, and choose

The Redundancy Wizards dialog box appears, with the Set up a Primary
Hardware Configuration for CPU Redundancy option selected by default.

Redundancy Wizards

WARMING: Operafiors performed by the wizard cannol be undone. Wiou may wart bo perform
a0 poit b backup your Hardware Configuration before proceeding.

“whiat iedundaricy cosration vould vou b o pedoim?

[h-]

[(=oa |anmmneTETE

[T |mananinig
oD |enenng

© fdd GECs for Geniz Aedurdancy

" Copy & redundant Genis Bus

Generate Seconday Hadwane
™ Conlfiguration from the Cument
Conhguration

et 5 Cancel Help
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3. Click Next and follow the wizard to the end.

x|

Target

Mame RK7i

Tupe GE IF Controller

Description

Documentation Address

Farnily PaCSystems FxFi

Contraller Target Mame | Target]

Update Rate [ms) 250

Sweep Time [mz] Offline

Contraller Status Offline

Dual HWC Fakse |

Scheduling Maode Marmal

Force Compact FYT Tre

Genivs Dutput Erraor

Enable Shared Variable

Falze

Physical Port

COM1

Hadditional Configuration

Inspector |

Hardware Configuration
Hot Redundancy Systems

The wizard adds a redundancy CPU and other redundancy modules to the
configuration.

The target property, Dual HWC, is now available in the Inspector and is set to
False by default.

To add Genius Bus Controllers (GBC) to your system (PACSystems* RX7i, PACSystems*

RX3i, and Series 90*-70)

1. Inthe Project tab of the [E| Navigator, expand the f target for which you

want to set up Genius redundancy.

2. Right-click @i Hardware Configuration, point to Redundancy, and choose

GFK-1918S

Wizard.
The Redundancy Wizards dialog box appears.

3. Select Add GBCs for Genius Redundancy.
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4 Hardware Configuration

Redundancy Wizards [ %]

WARMIMG: Operations performed by the wizard cannot be undone. Y'ou may want to perform
an export bo backup vour Hardware Configuration before proceeding.

‘what redundancy operation would you like to perform?

Set up a Primary Hardware
Configuration for CPU Redundancy

[2z]
[=h=ly]

Generate Secondary Hardware
Configuration from the Current
Configuration

LTI

G
B
C

< Back I Mest » I Cancel Help

4. Click Next and follow the wizard to the end. The wizard enables you to select a
Genius redundancy system and the location of the GBC modules. You can run
this wizard multiple times to configure additional pairs of redundancy busses in
the same system.

Note: When you add a Genius Bus Controller (GBC) to a PACSystems* RX7i,
PACSystems* RX3i, or Series 90*-70 rack, a new Genius bus network is
automatically created and associated with that slot and GBC module. Up to 31
Genius I/O devices (blocks) can be connected to a GBC through its Genius bus.

To configure the secondary Hardware Configuration (RX7i, RX3i, and Series 90-70)
1. Inthe Project tab of the [E| Navigator, select the fi§ Hardware Configuration.
2. Right-click Hardware Configuration, point to Redundancy, and choose Mirror to
Secondary Hardware Configuration.

Hardware Reference Yiew
Hardware Configuration Data Yiew.
Repoit Chl+T

Mame Resolution and Routing...
Ethernet Global Data.
Restore EGD and Name Resolution. .

Expart ta File...
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Hardware Configuration
Hot Redundancy Systems

A secondary rack system that is a copy of the primary rack system is generated.
The target now displays two Hardware Configurations (HWCs), one labeled
[Primary] and the other, [Secondary]. The Primary HWC is bolded because it is
currently selected. The target property Dual HWC is now set to True. To select
which Controller to interact with, set the Selected HWC property, just below the
Dual HWC property.

x|
=

Target
I ame R7i
Type GE IP Controller
Drescription
Documentation Address
Family PACSystems Rx7i
Controller Target Mame | Targetl
Update Rate [mz] 250
Sweep Time [ms] Oftline
Contraller Status Offlire
Dual HWE True hd|
Selected HWC Primary
Scheduling Made Narmal
Farce Compact T True
Geniuz Output Errar
Enable Shared Y ariable | False
Phyzical Port COk1

Inzpector

Note: You can mirror as many times as necessary to synchronize the two HWCs

after modifying the primary HWC. Each time you mirror the primary HWC, the
secondary HWC is updated to reflect those changes.

7 Want to know more? In the online help index, look up “Redundancy: an Overview".
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DSM3241 AND MOTION MATE DSM314
MOTION MODULES

The Series 90*-30 Controller family supports various I/O modules (discrete
input, discrete output, discrete mixed, analog input, analog output, and analog
mixed), communication modules, intelligent modules, bus Controllers, and
motion modules. You configure Series 90-30 hardware as described in the
section “Configuring Controller Hardware”, on page 63.

PACSystems* RX3i and Series 90-30 support some Motion modules that no
other GE IP Controller family supports: the DSM324i and the Motion Mate
DSM314 (see page 155). Both are high performance, easy-to-use multi-axis
motion control modules. Compatible with Controller logic solving and
communications functions, the DSM314 supports the following servo types:

Digital - GE digital servo amplifiers and motors.
Analog - GE SL Series analog servos and third-party servos.
The DSM324i supports only the Digital servo types.

Both the DSM324i and the Motion Mate DSM314 modules have four axes that
can be individually configured in Standard or Follower mode.

In order to perform motion programming in Logic Developer - PLC*, you must
program a DSM324i or a Motion Mate DSM314 module (see page 155).

To add a DSM324i or Motion Mate DSM314 module

1.

With a rack of the gi§ Hardware Configuration node expanded, right-click the
empty slot you want to add a DSM324i or a Motion Mate DSM314 module to and
choose Add Module.

The Catalog dialog box appears.
In the Catalog dialog box, click the Motion tab.

A selection of motion modules appears in the Catalog dialog box.

3. From the list, select DSM324i or Motion Mate DSM314.
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Hardware Configuration
DSM324i and Motion Mate DSM314 Motion Modules

The following picture displays some of the selections available for a
PACSystems* RX3i.

Central Processing Unit I
Dizcrete Inputl Dizcrete Dutputl Dizcrete Mixedl Analog Inputl Analog Dutputl

B
Analog MIHEdI Eommunlcatlonsl Bus Contraller - Motion I 3rd F'artyl Pawer Suppllesl

Catalog Mumber |Descripti0n | e
ICEI3APL300 High Speed Counter Module

ICE934PU 305 90-30 140 Processor Module
4 ) .

ICE93D5M 324 DSM324i

|ICE4APLI300 High Speed Counter Module

ICE44PL 305 F3i 140 Processor Module

ICE34D5M 314 Motion Mate DSM314

ICE34D5M 324 DSM324i

4. Click OK.

As per the example illustration, an IC693DSM314 is added to the Hardware
Configuration of your project.

To configure a DSM324i or a Motion Mate DSM314
1. Inthe @ Project tab of the | Navigator, double-click the slot containing a
DSM324i or Motion Mate DSM314.

The Parameter editor appears.
Settings I SHP F'ortl CTL Bitsl Output Bitsl Auis #1 I Axiz #2 I iz ﬂ3| Tuning #1 I Tuning #2 | Advanced | Power Conzumption I

Parameters Yalues |
Aeambiey oz 4 [
%| Reference: 0000
%1 Length: a0
%0 Reference: Q00001
%0 Length: 20
%4l Reference: Zzalonm
Al Length: 84
%40 Reference: AL
%40 Length: 12
Al ¥ vz Analog Servo
Al Avs Analog Servo
Al FAviaaa Ailiary Axis
A £ Aty Disabled
£ onald oumiz Ml Disabled
T otal Encoder Power [\ attz]: 0 ;I

2. Configure the DSM324i or Motion Mate DSM314 by using the Parameter editor..

% Want to know more? In the online help index, look up “IC693DSM314: Motion Mate

DSM314” and “IC693DSM324: DSM324i".
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4 Hardware Configuration

REMOTE I/0

Series 90*-70 Genius Remote I/O Scanner

| A Remote I/0O Scanner (IC697BEM733) is a Genius device that is part of a

g %DE; S =l Genius Bus system. As such, it is added as a Genius device to the Genius Bus
"ﬂ" Ha;war; Colnf,zurat,on Controller (GBC) and it is represented in Logic Developer - PLC* by an SBA

Hla PR (ICEITPARTIO)
| g:ﬁ;g:ggg;gg;ﬁ; It is also represented by a separate target in the Machine Edition* project, as
5 illustrated below.

E‘ ﬁ Main Rack (ICB37 CHS740) node under the GBC in a Series 90*-70 target, as illustrated to the left.

ﬂ SEIA 3 (ICBQ?EIEM1

Slat 3 (ICE97MDL250)

Slat 4 (ICESTMDLT40)

Slat 5 (ICE9TMDL2S1)

Slot & (ICEITMOLESD) =
»

NEEER

Navigator: Series 90-70 Remote

1/0 Scanner as a Genius device
under

= | o ' .
= &3 soToTest 2| A Remote I/O Scanner resides in Slot 1 of the Series 90-70 main rack. I/O

- BEWTI3 o modules can be inserted into the other slots of the main rack and on all the slots
Dﬁﬁ'ﬁm;r;:f: fessronsrao | Of the expansion racks. As such, the Remote 1/0 Scanner is represented by a
""" g parcesriR7I0) | target in the Project tab of the Navigator, and is also represented by a module in

..... g sot20 slot 1 of the main rack of that target.

-l Feack 1 (ocEaTCHSTAm
-l Fack 2 qoaTCHSTAm
=il Rack 3 gce9TcHSTID)
-l Feack # qosaTCHSTAm
-l Rack 5 (oEaTCHSTAm
-l Rack & (oEaTCHSTAm
-l Rack 7 (cEaTCHSTAD
- Supplemental Files -

NENER

Navigator: Series 90-70
Remote 1/0 Scanner
as a target and
as a module in Slot 1 of the main
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Remote I/0

To add a Remote I/0 Scanner

1.

10.

1.

GFK-1918S

In the Project tab of the 1] Navigator, = expand the i Hardware
Configuration and expand the il main rack.

Right-click the @ slot containing the Genius Bus Controller (GBC) and choose
Add Genius Device.

The Choose SBA dialog box appears.

Select a Serial Bus Address (SBA) for the Genius device and click OK.
The Catalog appears.

Select the device you want to add and click OK.

The device is added to the bus configuration with the SBA you selected.

When prompted to add a new target for the Remote 1/0 Scanner, click Yes.

A new # GE Remote I/O target appears in your project. This target represents
the Remote I/O Scanner. In the g Hardware Configuration of the new target, the
Remote I/O Scanner also appears in @ Slot 1 of the gl main rack.

Configure the communication with the Remote I/O Scanner target.

Add and configure I/O modules for the rack system of the Remote I/O Scanner
target.

. Configure the Remote 1/0 Scanner module’s parameters in @ Slot 1 of the

fil main rack of the Remote I/O Scanner target.

Set up the Remote I/0 Scanner Genius device in the same SBA node.

The 1/0 Map of both Remote I/O Scanner configurations must match (at the
Remote I/O Scanner target level and at the Remote 1/0 Scanner Genius Bus
device level). Now whenever you update the I/O map on the Remote I/O
Scanner, the /0 map is automatically updated to the GBC.

Download the Hardware Configuration of the new Series 90*-70 Remote 1/O
target.

Download the Hardware Configuration of the original Controller target that
contains the GBC.

% Want to know more? In the online help index, look up “IC697BEM733: Remote 1/0
Scanner”.
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E|l'| Target2
=i Hardware Configural
=8 [2}ain Fack:

- Hly PR (IC200

Navigator: VersaMax Remote

Hardware Configuration
Remote I/O

VersaMax* Remote I/0

VersaMax remote I/O consists of a Network Interface Unit (NIU) (Ethernet,
Genius, or Profibus), and one or more I/O modules. You can use Logic
Developer - PLC* to configure this hardware. Once configured, the remote /O
can be controlled by a VersaMax Controller or a PC Controller. The
differentiating factor between a VersaMax remote I/O and a Controller is that a
remote I/O is simply an input/output device with a communication interface.
Unlike a Controller, a remote 1/0O has no CPU.

With Logic Developer - PLC, you can add racks, configure the power supply, and
configure modules in the VersaMax Remote 1/0 Hardware Configuration.

Remote I/O targets are generally added to a project when you create a project
from a template. You can also add a GE Remote I/O target to an existing project.

To create a project containing a GE Remote 1/0 target from a template

. From the File menu, choose New Project.

The New Project dialog box appears.

2. From the Project Template list, choose the GE Remote I/O you want to add to

your project.

3. Enter a descriptive Project Name.
4. Click OK.

A new Remote I/O project is started.

To add a GE ip Remote 1/0 target to an existing project

1. Inthe Project tab of the [E| Navigator, right-click the & Project node.
2. Point to Add Target, then to GE Intelligent Platforms Remote 1/O, and choose

a remote 1/0.

Add Target GE Intelligent Platforms Controller —— » |

GE Intelligent Platforms Remate 140 » ISR i G
Save T Series3070Genius
ST FACSpstems R<3i Ethernet
Yersahdax Ethemet

Save And Backup...
LCloze
LCloge [withaut savingl...

Yersahdax Genius
Yersahd ax Profibus

Walidate All
Diavrlaad sl
Clean All Build Folders

Show Dacumenrtation
Properties
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Remote I/0

Note: The Series 90-70 Genius option is a Series 90*-70 Remote I/O Scanner
(see page 80).
To replace the power supply in your remote 1/0 configuration

1. Inthe Project tab of the [/ Navigator, expand the @i Hardware
Configuration of the remote I/O.

The Navigator displays the following:

=-28 Wersabax Remate
-4 Targetl
% D ata'watch Lists
ﬁﬁ Hardware Configuration
{5 Main Rack
Hlw PR [IC200FR001]
“ol Slot 0(IC200FEID0T
-0 Supplemental Files

2 =2 2. B 2]
2. Right-click the #l PWR slot and choose Replace Module.

The Module Catalog dialog box appears:

Module Catalog E

Power Supply |

Lancel

Help »»>

d;

Power Supply 24¥DC Input
Power Supply ' /Expanded 3.3WDC 24400 Input

IC200Pw/RO02

IC200PwR101 Power Supply 120/2400WALC [nput

|IC200PwR102 Power Supply '/ /Expanded 3.3WDC 120/2400ALC Inp
IC200PwR201 Power Supply 12¢DC Input

IC200FwR 202 Power Supoly W /Expanded 3.3vDC 12DC Inout

From the list, select the power supply that you want to configure for your system.

4. Click OK.

To add a new Carrier/Base to your VersaMax* Remote 1/0
1. Inthe Project tab of the [/ Navigator, select a # remote 1/0 target.

2. Expand the fii Hardware Configuration node and the fiil main rack.
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4 Hardware Configuration

The Navigator displays the following:

=-28 Wersabax Remate

-4 Targetl
% Data 'watch Lists

E-fifii Hardware Configuration

- =-f Main Rack

w PR (IC200FR001]

Slot 0 [IC200PBI00T )

#-0y Supplemental Files

2 =2 2. B 2]

3. Right-click the [ Slot 0 node and choose Add Carrier/Base.

The Module Catalog dialog box appears.

140 Carriers | Power Supply Booster Basesl Communication Earriersl

Fik

Lancel
Catalog Mumber Drescription
IC200CHS007 140 Carrier Barrier Style Help »»>
|IC200CHS002 140 Carrier Box Style
IC200CHS003 140 Carrier Connector Style
|IC200CHS 005 140 Carrier Spring Style
|IC200CHS022 140 Carrier Box Style - Vertical
|IC200CHS025 140 Carrier Spring Style - Yertical

4. Select the carrier/base that you want to add to the remote I/O target.

Note: You can add a maximum of eight carrier modules to each VersaMax* rack.
5. Click OK.

To add a module to a carrier/base

1. Inthe Project tab of the (1= Navigator, expand the Remote /O target you
want to add a base to.

2. Double-click an empty carrier/base.
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The Module Catalog appears.

Dizcrete Mixedl Analog Mixedl Other I
Analog Input | Dizcrete Inputl Dizcrete Dutputl Analog Dutputl

Lancel |
Catalog Mumber Drescription
IC LG Analog Input 12 Bit Valt/Curr 4Ch Help s |
IC2008LG240 Analog Input 16 Bit Wolt/Curr 1500VAL 20 8Ch
|IC2008L G260 Analog Input 12 Bit Walt/Curr 8Ch
|IC2008L G261 Analog Input 15 Bit Woltage Differential 8Ch
IC2008LG262 Analog Input 15 Bit Current Differential 8Ch
IC2008LG263 Analog Input 15 Bit Woltage 15Ch
IC2008L G264 Analog Input 15 Bit Current 15Ch
IC2004LGE20 Analog Input 16 Bit RTD 4Ch
|IC2008LGE30 Analog Input 16 Bit Thermocouple 7Ch
GEMERIC_AIM Mon-Inteligent Generic Analog Input Module

3. From the Module Catalog, select the module that you want to install.
4. Click OK.

7 Want to know more? In the online help index, look up “Hardware Configuration”.
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Logic Programs and Blocks

Logic Programs and Blocks

Program Types

For most GE IP Controllers, all the logic that is downloaded to a Controller
constitutes one program. However, there are cases when distinctions need to be
made. Therefore, we can speak of a main program, a C program, and a Motion

program.
Controller CPU Application DSM Application
Main Program C Programs Motion
C Program n Program
Interrupt Interrupt
-MAD Block1 | | Block2 C Program 2
C Program 1 Local
Logic
- Program Funiction £
Block 1 Block 1
P L Instance 1 Motion
rogram
| Block?2 Instance 2
I CAM
nstance n L
Parameterized T
Block 1

Each C program is a named section of executable code. The main program
and the Motion program contain blocks; that is, named sections of executable
code that can be written in various languages.

GFK-1918S
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The Project tab of the Navigator contains all of the programs:

HER N(*;Wimiwn = ? Tz The main program and its blocks reside in the ts Program Blocks
R folder. You can create user-defined subfolders to further organize

o 6 i these blocks.
» ’ C programs reside in the T+ Logic folder.

%} The Motion program resides in the Motion Program folder.

T:g Program Blocks

rocessOutputs
(=14 Motion Program

+ ) Reference View Tables

= By Supplemental Files  © Main Program

-

Most GE IP Controllers support only a main program. The main program

A »
. B =N consists of a block of logic named _MAIN and optionally, one or more of the
following kinds of blocks of logic, found under the & Program Blocks folder in

the £+ Logic folder of a GE IP Controller target:
Programs »  Called blocks developed in various languages:

Navigator: Project tab

T Ladder Diagram (LD) Blocks
d Bl Structured Text (ST) Blocks
TF Function Block Diagram (FBD) Blocks
» [2] Instruction List (IL) Blocks
[Z] C Blocks
» Called parameterized blocks (LD, ST, FBD, and/or C).

» Interrupt blocks (LD, ST, FBD, C, and/or IL) scheduled to execute at certain
time intervals or when specific memory registers reach certain values.
User-defined function blocks (UDFBs) in LD, ST, and FBD, of which
independent instances with their own data structures and local memory can
be used in logic.

% Want to know more? In the online help index, look up “UDFB* then choose “User-Defined
Function Blocks (UDFBs) (PACSystems)”.

Specialty function blocks, like HART utilities. Like UDFBs, you can create
independent instances of specialty functions blocks with their own instance
data (a structure variable). Unlike UDFBs, you cannot edit the logic of
specialty function blocks because they are read-only and provided to you by
GE.

% Want to know more? In the online help index, look up “Specialty Function Blocks
(PACSystems)*.

> All GE IP Controllers support LD blocks, but only certain Controller families or
models support one or more of the other kinds of blocks.
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The _MAIN block can be in various languages, depending on the Controller
family or model.

You download the main program to the Controller as logic; that is, after you
initiate a download, a dialog box presents you with various Download to
Controller options and you select the Logic option. If the Logic option is not
present, select the Program option.

C Programs

Series 90*-70 CPUs firmware version 6.00 and later support either the main
program, or various C programs, or a combination of a main program and C
programs. You download these various programs to the Controller together as
logic; that is, after you initiate a download, a dialog box presents you with three
Download to RAM options and you select the Logic option.

If there is no _MAIN block, then there is no main program. In this case, you
would have only one or more C programs and possibly various standalone
interrupt blocks (LD or C). These standalone interrupt blocks do not constitute a
main program if there is no _MAIN block.

A C program can be named _MAIN only if the target contains no LD blocks.

A C program is not the same as a C block. For more information, see “C
Programs”, on page 139.

Motion Program

In addition to the main program, Series 90*-30 CPUs firmware version 10.00 and
later, as well as PACSystems* RX3i CPUs firmware version 2.80 and later,
support a Motion program for use on a DSM324i or Motion Mate DSM314
module. The Motion program consists of:
? @ CAM profiles

{ CAM blocks
' Local Logic block
> {% Motion blocks

You download the Motion program to the Controller as part of its Hardware
Configuration (HWC); that is, after you initiate a download, a dialog box presents
you with various Download to RAM options and you select the Hardware
Configuration option. If you want to download the main program at the same
time, you also select the Logic option. If neither option is present, select the
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Program option to download both the Hardware Configuration and the Logic. For
more information about the Motion Program, see page 155.

Number of Blocks in the Main Program

CPU Type Number of Blocks Maximum Number of
Blocks

PACSystems* 511 subroutine blocks plus one 512
_MAIN block

Series 90*-70 255 subroutine blocks plus one 256
_MAIN block

Series 90*-30 64 subroutine blocks plus one 65
_MAIN block

VersaMax* and VersaMax* 64 subroutine blocks plus one 65

Micro _MAIN block

VersaMax* Nano 8 subroutine blocks plus one 9
_MAIN block

Series 90* Micro 1 _MAIN block 1

Scheduling Programs

On GE IP Controllers that support only one program (the main program), the
program as a whole cannot be scheduled. Every scan, logic execution begins
with the _MAIN block. You can schedule individual interrupt blocks of logic but
not the _MAIN block.

When you execute both a main program and a Motion program on a Series 90*-
30 Controller with a CPU firmware version 10.00 and later, or on a PACSystems*
RX3i with a firmware version of 2.80 or later, you cannot schedule the programs
because they are executed concurrently in two different locations.

In the CPU, every scan, logic execution begins with the _MAIN block of the
main program.

In the DSM324i or Motion Mate DSM314 module, the Motion program
executes independently of CPU scan times.

You can schedule individual interrupt blocks of logic in the main program
(except the _MAIN block).

Series 90*-70 CPUs firmware version 6.00 and later support scheduling
programs. On targets that contain such CPUs, you can schedule any program,
even the main program. That is, logic execution of any scan does not have to
begin with the _MAIN block of the main program: you can schedule any C
program to begin the logic execution part of the scan. Within the main program,
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Logic Programs and Blocks

you can further schedule individual interrupt blocks of logic (except the _MAIN
block). If you have no main program, that is, if your logic has no _MAIN block,
you can still have stand-alone interrupt blocks that you can schedule individually.

To schedule the execution of programs on a Series 90*-70
1. In the E& Project tab of the 1= Navigator, right-click a |€] C program or the
_MAIN LD block, and choose Properties.

The Inspector displays the program properties. The main program properties
(Program Name, Scheduling, and Stack Size) are shown together with the
_MAIN block’s individual block properties.

In the Inspector, expand the Scheduling property.

Select a Schedule Mode.

Select the other properties used in the schedule mode you selected.
Click OK.

Note: If you made any entries, they are validated when you click OK. You must
correct any errors before you can click OK to close the dialog box.

o DN

7 Want to know more? In the online help index, look up “Programs on GE IP Controllers: an
Overview”.

To create a user-defined folder

1. Inthe Project tab of the 1] Navigator, expand the # target with the main
program you want to organize and then expand the £ Logic folder.

2. Right-click the ®&8 Program Blocks folder, point to New, and choose Folder.

B £ Logic Anew 2 user-defined folder appears with a default name.
B8 Program Blocks
'tgﬂ g_MAIN 3. Optionally enter a new folder name, which must be unique among the folders
o | Processlnputs H
B L Py directly under the parent folder.
E-@l LD BK2

% Want to know more? In the online help index, look up “organizing logic (main program of a
GE IP Controller)”.

To schedule the execution of a block of logic

1. Inthe Project tab of the @ Navigator, right-click an existing LD, FBD, ST, C,
or IL block, and choose Properties.

The block’s properties appear in the Inspector.
2. Inthe Inspector, click the | button in the Scheduling property.
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The Scheduling dialog box appears.

Scheduling | %]
Interupts
Block Properties ; berupt]
Name LDBK1
P 1/0 Interrupt
Description Madule Intermupt
Language Ladder
Block Type BLE.
Scheduling :I
Parameters
HLock Settings
Extra Local Words | 128 oK I Cancel | >> Help |
Inzpectar |
3. Configure scheduling by entering values in each of the fields.
Inspector: some LD block % Want to know more? In the online help index, look up “Scheduling execution of blocks of
properties. logic”.

To control access to a block
1. Right-click an LD, FBD, ST, or IL block and choose Properties.
2. Inthe Inspector, expand the Lock Settings property.
3. Inthe Lock Type property, choose a setting from the list.

4. In the Password property, enter a password.

To search/replace in one block
1. Double-click an LD, FBD, ST, or IL block to open it.
2. From the Search menu, choose Find or Replace.
A dialog box appears.
3. In the Find what or in the Text to find field, enter the text to find.

4. (Only if you want to replace text.) In the Replace with field or in the New text
field, enter the text to replace the found text with.

5. Select or clear each search/replace option, as required.
6. Click Find, Find next, Replace, Replace All, Close, or Cancel, as required.
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Note: With Logic Developer - PLC*, you can search for some text in an entire
target or portions thereof, which you can specify. Various options are available to
narrow a search.

% Want to know more? In the online help index, look up “Global” and select the “Conducting a
Global Search” help topic.

Indirect References

The LD, FBD, and ST editors support indirect references. An indirect reference
treats the value of a variable assigned to an instruction operand as a pointer to
other data, rather than as actual data. Indirect references are sometimes
referred to as relative pointers.

Indirect references can be used only as follows:
With PACSystems* CPUs and Series 90*-70 CPUs.
» Inthe LD, FBD, and ST editors.
With %R, %Al, %AQ, %P, %L, and %W memory areas.
On instructions that support indirect references.
Notes for PACSystems*
The index for an indirect reference to %W is a 32-bit DWORD value.
Indirect references cannot be used to address bits in 16-bit memory.
» Indirect references are not supported on symbolic variables or 1/O variables.
Possible Uses
To perform the same operation to many registers.
» To avoid repetitious logic within the application program.

In loop situations where each register is incremented by a constant or by a
value specified until a maximum is reached.

To assign an indirect reference
» Where a variable operand is expected, type the @ symbol, followed by a valid
reference address or variable name.
The LD, FBD, or ST editor converts a reference address to a variable name or
the editor substitutes the name of a variable already mapped to the address.
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» The actual variable name does not contain the @ symbol. The @ symbol,
when used at the start of a reference address or variable name, merely
indicates that the address or variable must be treated as an indirect
reference.

The @ symbol can be thought of as an operator with the lowest precedence.
In other words, MyArray[2,5] becomes a reference address that is used for
the indirect reference. Another way to think of this is @(MyArray[2,5]) as
opposed to (@MyArray)[2,5].

The following are valid indirect references:
@RO0001 (a variable name automatically created from a reference address)
@MyArray[2, 5] (an array reference)

» @$MainSwitch (a universal variable)

@MyTimer.PV (a structure element)
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LD EDITOR

The Ladder Diagram (LD) editor is used to create programs with the Ladder
Diagram programming language. LD logic graphically represents the
programmed actions performed by a Controller as it executes.

The LD editor is cell-based with rungs constructed of horizontal sequences of
instructions that are wired together. A given instruction and its operands can
occupy one or more cells.

You can work with the LD editor while offline to edit a disk copy of a project, or
while online to monitor the execution of the logic while you fine tune the project,
for example by making word-for-word changes (see page 104).

You can customize the appearance and behavior of the LD editor by setting
options (see page 28).

An LD block is a named section of LD Logic that is compiled and downloaded to
the Controller represented by the associated target.

ditor

In the @ Options tab of the 1=} Navigator, expand the Editors folder and then
the Ladder folder.

. Right-click a B page (Confirmations, Editing, Font and Colors, or View), and
choose Properties.

The configurable options appear as properties in the Inspector.

In the Inspector, adjust settings as required.

In the E@ Project tab of the 1= Navigator, right-click t Program Blocks, point to
New, and then choose LD Block.

A new LD block with a default name is created.

2. Rename the block as desired.

To open an LD block for editing

GFK-1918S

* Inthe Project tab of the 1= Navigator, double-click an {r LD block.
The block opens in the LD editor.

Note: You can have multiple blocks open for editing. To navigate to another
open LD block, click the tab that displays its name at the top of the editor
window.
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Working with the LD Editor Offline

When you are offline, there is no live communication between the LD editor and
the target. Most logic development is done while offline. The following diagram
illustrates some of the more common operations you can perform when you use
the LD editor offline.

Insert
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BEEdEv 5 .

pBBOCX S DEEE@%E e ERA N editor.
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H Com) ion e nx
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automatlcally Sequences a string of bit values, starting at 'sT'.
i ?7227: Address, The first of three control WORDs for the BIT_SEQ
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information sequence in bits, WORD 3: control WORD) | [T o 3, Reterences {1 0|
on what you Far Help, press Fi Rung 2 | & |CFfline | Administrator |LOCAL
click.
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To insert an instruction
1. In the LD editor, right-click an empty cell and choose Place Instruction.
A smart list appears listing all available instruction mnemonics.
2. Choose an instruction mnemonic from the list and press ENTER.
Note: If you attempt to place an instruction that has inputs into the first column, it

is pushed to the second column and a horizontal wire is inserted in the first
column.

To assign instance data to a built-in function block instance and assign a length to an
instruction

There are two methods.

First method

1. In the LD editor, insert a built-in function block or insert an instruction that
requires a Length.

In the following example, a built-in function block instance has a length. Most
built-in function blocks do not require their instances to have a length.

i BITSEQ L Four question marks indicate that the Address property of the function block
2992 /instance has not been initialized. As a result, no instance data has been
assigned to the instance.

& T d
iz “1“ is the default value of
the Length property of an

™ instruction

—sT

2. Right-click the function block instance or instruction and choose Properties.

The Inspector displays the instance’s or instruction’s properties.

Alxl
-BIT_SEQ Add
Address looooy ———aeress
Length 34
™ Length

Inzpectar |

3. In the Address property, enter a variable name or a reference address to specify
the start of a memory block used for the instance data of the function block
instance.

Note: If you type a reference address, it is converted to a variable name
automatically.
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4. In the Length property, enter the number of bits or 16-bit registers on which the
function block instance or instruction is to operate.

Second method

1. In the LD editor, insert a built-in function block or insert an instruction that
requires a Length.

2. Double-click the function block instance or instruction or select it and press
ENTER.

When you double-click a function block instance, the Function Block Properties
dialog box appears, as pictured below. When you double-click an instruction, the
Function Properties dialog box appears, in which the Address property is
unavailable.

Function Block Propertie: #

Address ’TI
I j Cancel |

Length :

|1 _|:;' Fange: 1to128

3. In the Address property, enter a variable name or a reference address to specify
the start of a memory block used for the instance data of the function block
instance.

Note: If you type a reference address, it is converted to a variable name
automatically.

4. In the Length property, enter the number of bit or 16-bit registers on which the
function block instance or instruction is to operate.

To assign variables to instruction operands
1. In the LD editor, double-click beside any operand of an instruction, or click there
and press ENTER.

A smart list appears.
2. Type, or choose from the list, a variable name or reference address.

If you enter a reference address, a variable name is automatically substituted.

To check (validate) a single LD block

1. Inthe Project tab of the (1=} Navigator, ® expand the # target that contains
the block to check, and then expand the £ Logic folder.

2. Expand the 8 Program Blocks folder and then, if the block resides in a 1 user-
defined folder, expand the user-defined folder.

98 Proficy* Logic Developer - PLC* 8.50 GFK-1918S



Logic Programs and Blocks
LD Editor

3. Right-click the block and choose Check Block.

Machine Edition* checks the block for errors. Any messages or errors are
displayed in the Build tab of the B Feedback Zone.

Editing Logic as Text

You can enter LD logic into the LD editor by starting to type right into a cell. A
smart list appears and you can continue to type your instructions and operands.
When you press ENTER, the logic you typed appears in customary graphic form
in the LD editor. For example, in the first cell of a new rung, if you type “AD
MyDint1 MyDint2 Result12;AD MyDint3 MyDint4 Result34*, the following logic
appears in the LD editor:

0D | ) ADD |}
LINT DINT |

mydintl —{I¥1 O resulti2 mydint3 HINT 08 result34

mydintz —|IN2 mydintd —IN2

A horizontal wire was inserted in the first cell to make room for the ADD_DINT
instruction’s operands and the operands were inserted in their proper places. In
the keyboard entry, “AD" stood for “ADD_DINT", because ADD_DINT is the first
available instruction that begins with “AD* in the smart list. A semicolon
separates the ADD_DINT instructions. The required horizontal wires are
supplied automatically.

% Want to know more? In the online help index, look up “Keyboard Method to insert LD
instructions”.

A powerful extension of typing logic into the LD editor is the ability to write LD
logic in any text editor and copy and paste it into the LD editor, or to copy and
paste logic from the LD editor to a text editor. You can copy an entire block of LD
logic from the Navigator to any text editor, or copy sections of LD logic as text
from the LD editor to any text editor. You can then edit the logic in the text editor
and copy the edited logic back into the LD editor.

When LD logic is copied as text, a verbose format is used to make it easier to
read, but when you edit the logic as text you can use the same shorthand used
in the keyboard method of entering LD logic in the LD editor.

To copy an entire LD block as text

1. In the B Project tab of the B2 Navigator, expand the target and expand the T
Logic folder.
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Expand the ts Program Blocks folder and, if the LD block resides in a & user-
defined folder, expand the user-defined folder.

Optionally right-click the LD block and choose Check Block. This validates the
LD block. If the logic contains errors, error messages appear in the Feedback
Zone. If the logic contains errors, fix them.

Right-click the LD block and choose Copy.
The contents of the LD block are copied to the Windows Clipboard.
Paste the content of the Windows Clipboard into a text editor.

The LD logic is pasted as text.

To copy a section of LD logic as text

1.

Optionally right-click the LD block and choose Check Block. This validates the
LD block. If the logic contains errors, error messages appear in the Feedback
Zone. If the logic contains errors, fix them.

In the LD editor, select the cells that contain the logic you want to copy as text.
Right-click the selected logic and choose Copy.

The LD logic is copied to the Windows Clipboard.

Paste the content of the Windows Clipboard into a text editor.

The LD logic is pasted as text.

To copy text into the LD editor

1.

In the text editor, select and copy the text representing LD logic to the Windows
clipboard.

In the LD editor, do one of the following:
Select the cells that you want to overwrite.
-or-
Click the cell that will be at the upper left corner of the LD logic you want to
paste.
Right-click and choose Paste.

Existing cells in the LD editor are overwritten with the content of the Windows
clipboard.

To move or duplicate LD logic

1.

In the LD editor, select a range of logic.

2. To move it:

Click the selection and drag it to a new location.
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- or -
To duplicate it:

Press CTRL while clicking the selection, and drag the selection to where you
want to place the duplicate.

When you release the mouse button, the selection is respectively moved to the
new location or a duplicate copy of the selected logic is placed in the new area.

7 Want to know more? In the online help index, look up “Copying LD Logic as Text:
Overview”.

Working with the LD Editor Online

When online in monitor mode, you can monitor the Controller but cannot change
anything in the Controller or edit your logic. The LD editor animates LD logic to
reflect program execution in the Controller. Data values change typically every
250 milliseconds while coils and contacts indicate power flow. The number of
milliseconds is set in the Update Rate target property. (See “To configure a
Controller target”, on page 37.)

When you are online in programmer mode, you can edit your logic, make
changes in the Controller, and monitor the Controller. Many GE targets also
support Run Mode Store; that is, you can download logic to them when they are
running.

See “Offline, Online: monitor mode, programmer mode”, on page 46.
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Three methods are at your disposal to make changes in your LD logic and
download the changes to an online running Controller:
»  Test Edit (PACSystems* only): see page 102.

» Word-for-word changes: see page 104.
»  Go not equal, keep working, and download changes: see page 105.

You can also affect BOOL variables during execution. See page 105.

Test Edit (PACSystems™* only)

With Test Edit, you can perform transacted online programming. That is, you can
modify an LD block in the LD editor while seeing both the original and modified
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logic, test the new logic's execution on the PACSystems, and then either keep
the modified logic or roll back to the original logic.

To begin editing in Test Edit

1. In the LD editor, start modifying the logic.
The Logic Change Options dialog box appears.

2. Select Enter Test Edit Mode and click OK.
The LD editor is placed in Online Edit mode, with some visual cues to remind
you that a Test Edit session is in progress. Because Test Edit is an extension of
the Run Mode Store (RMS), only changes supported for an RMS are supported
in Test Edit mode. At any time, you can test the modified logic.

To begin testing the modified logic
1. Click anywhere inside the LD editor.
2. From the Debug menu, choose Begin Test.
The modified logic is downloaded to the PACSystems, which then executes the
modified logic. The original block of logic is retained in PACSystems memory as
an inactive block.
You now have three possible courses of action:
Cancel the test and continue editing the logic while in Test Edit mode.
Cancel Test Edit mode and restore the original logic in the PACSystems.

Accept the changes you tested and commit them to the PACSystems.

To cancel the test and continue editing the logic while in Test Edit mode
1. Click anywhere inside the LD editor.

2. From the Debug menu, choose Cancel Test.
The modified logic block is deactivated in the PACSystems*. The original block
is activated and executed. The modified logic block retains its changes in the LD
editor and you can continue editing it and test it again later.

To cancel Test Edit mode and restore the original logic in the PACSystems
1. Click anywhere inside the LD editor.

2. From the Debug menu, choose Cancel Edit.
If you made no changes to logic, the Test Edit session ends immediately. If you
made any changes to logic, the Cancel Test Edit dialog box appears.

3. In the Cancel Test Edit dialog box, select one of the following options and click
OK.
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Restore original logic in editor and maintain equality: The PACSystems
deactivates and deletes the modified block of logic, and it activates and
executes the original block. The LD editor discards the modified logic from
the block, retaining only the block's original logic. Your Test Edit session ends.
You are online in programmer mode and logic equal.

Keep modified logic in editor and lose equality: The PACSystems
deactivates and deletes the modified block of logic, and it activates and
executes the original block. The LD editor retains the modified block of logic
and no longer displays the original logic where it was different. Your Test Edit
session ends. You are online in programmer mode and logic not equal.

To accept the changes you tested and commit them to the PACSystems*

1.

Click anywhere inside the LD editor.

2. From the Debug menu, choose Accept Edit.

The modified logic is committed to the PACSystems. The original logic is
completely deleted from the PACSystems; it no longer exists as an inactive
block. The Test Edit session is ended. You are online in programmer mode and
logic equal.

Word-for-Word Changes

A word-for-word is a small change in logic made while online that generally fits in
the same amount of memory as the original logic. For example, changing the
type of contact or coil or changing an operand is usually a word-for-word
change.

Word-for-word changes can be completed online to PACSystems*, Series 90*-
70, Series 90*-30, VersaMax, and Series 90 Micro Controllers. (VersaMax
Nano / Micro Controllers do not support word-for-word changes.)

To make word-for-word changes

1.

While online to a target Controller, make a change to LD logic that does not
change the logic size.

Do one of the following:

If the Logic Change Options dialog box appears, select Word-for-word
change and click OK.

- Or -

If the Word for Word Change dialog box appears, click Yes.

The change is downloaded to the Controller.
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Go not equal, keep working, and download
changes

If you make changes in logic that do not qualify for Test Edit or a word-for-word
change, or if you choose not to enter Test Edit mode or make a word-for-word
change, logic becomes not equal.

To regain equality, you can download your changes to the Controller (see page
49) or upload the logic from the Controller (see page 50). You can generally
download to the Controller whether the target is running or not. All Controller
families support this Run Mode Store capability, but not every Controller in every
family.

Affecting BOOL variables

To turn on/off or force a variable
* In the LD editor, right-click a BOOL variable anywhere in LD logic and choose
Force ON, Force OFF, Toggle Force, Turn ON, Turn OFF, or Toggle 10.
Note: Forcing a variable ON or OFF overrides any actions the application may
take during runtime. That is, if a variable is forced OFF (0), but LD logic is trying
to set it to ON (1), it remains set to OFF.

7 Want to know more? In the online help index, look up “Test Edit: an Overview”, “working
online with variables and LD logic: overview", and "Run Mode Store (RMS)".

LD Instructions

The following is a list of all LD instructions available in Logic Developer - PLC*.
Companion help indicates which Controllers support the instructions.

7 Want to know more? In the online help index, look up “LD Instructions”.
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Advanced Math

ACOS ATAN_LREALP EXP LN_LREALP SIN TAN
ACOS_LREALP ATAN_REALP EXP_LREALP  LN_REALP SIN_LREALP  TAN_LREALP
ACOS_REALP  COS EXP_REALP  LOG SIN_REALP  TAN_REALP
ASIN COS_LREALP EXPT LOG_LREALP SQRT_DINT

ASIN_LREALP cOS_REALP EXPT_LREALP LOG REALP SQRT_INT

ASIN_REALP  DEG_TO RAD LREALP EXPT REALP RAD _TO DEG_LREALP SQRT LREALP

ATAN DEG_TO_RAD_REAL® LN RAD_TO DEG_REALP  SQRT_REAL

Bit Operations

AND_DWORDA BIT_SET_DWORD* NOT_WORD SHIFTL_DWORDA
AND_WORD BIT_SET_WORD OR_DWORD* SHIFTL_WORD
BIT_CLR_DWORD* BIT_TEST_DWORDA OR_WORD SHIFTR_DWORD*
BIT_CLR_WORD BIT_TEST_WORD ROL_DWORD* SHIFTR_WORD
BIT_POS_DWORD* MASK_COMP_DWORD ROL_WORD XOR_DWORD*
BIT_POS_WORD MASK_COMP_WORD ROR_DWORD* XOR_WORD
BIT_SEQ NOT_DWORDA ROR_WORD

Coils
COIL NCCOIL NTCOILP PTCOILP SETCOIL
CONTCOIL NEGCOIL POSCOIL RESETCOIL

Communication

MODBUS_TCP_RW (VersaMax Micro CPUs with firmware version 4.00 or later) PNIO_DEV_COMM
Contacts
CONTCON HIALRA NCCON NOCON NTCONP PTCONP
FAULTA LOALRA NEGCONA NOFLTA POSCONA?
Control
DO_I0 EXIT_FORA MASK_IO_INTR  R_TRIGP SUS_107 SWITCH_POSP
DRUM F_TRIGP PID_IND SCAN_SET_IOP  SUSP_IO_INTR
END_FORA? FOR_LOOPA PID_ISA SER SVC_REQ

P indicates instructions exclusive to PACSystems* Controllers.
70 jndicates instructions exclusive to Series 90*-70 Controllers.

A indicates instructions shared by PACSystems and Series 90-70 Controllers and
exclusive to them.
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BCD4_TO_INT
BCD4_TO_REAL
BCD4_TO_UINTA
BCD8_TO_DINTA
BCDS_TO_REAL
DEG_TO_RAD
DINT_TO_BCD8*

Counters

DNCTR UPCT

Data Move

ARRAY_SIZEP
ARRAY_SIZE_DIM1P
ARRAY_SIZE_DIM2P
BLK_CLR_WORD
BLKMOV_DINTA
BLKMOV_DWORD
BLKMOV_INT
BLKMOV_REAL
BLKMOV_UINTA
BLKMOV_WORD
BUS_RD_BYTE
BUS_RD_DWORDP
BUS_RD_WORDP
BUS_RMW_BYTEP
BUS_RMW_DWORDP

GFK-1918S
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DINT_TO_INTA
DINT_TO_LREALP
DINT_TO_REALP

INT_TO_UINTA
LREAL_TO_DINTP
LREAL_TO_REALP

REAL_TO_UINT*
REAL_TO_WORD
TRUNC_DINT
TRUNC_INT
UINT_TO_BCD4*
UINT_TO_DINTA
UINT_TO_INTA
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UINT_TO_REAL?
WORD_TO_REAL

DINT_TO_UINTA RAD_TO DEG
INT_TO_BCD4 REAL_TO_DINT
INT_TO_DINT* REAL_TO_INT
INT_TO_REAL REAL_TO_LREALP
R

BUS_RMW_WORDP
BUS_TS_BYTE
BUS_TS_WORD
BUS_WRT_BYTE
BUS_WRT_DWORDP
BUS_WRT_WORDP
COMM_REQ
DATA_INIT_AsCII"
DATA_INIT_COMM"
DATA_INIT_DINT"
DATA_INIT_DLAN"
DATA_INIT_DWORD"
DATA_INIT_INT"
DATA_INIT_LREALP
DATA_INIT_UINT"

DATA_INIT_REAL"
DATA_INIT_WORD"
MOVE_BOOL
MOVE_DATAP
MOVE_DATA_EXP
MOVE_DINT
MOVE_DWORD
MOVE_FROM_FLATP
MOVE_INT
MOVE_LREALP
MOVE_REAL
MOVE_TO_FLATP
MOVE_UINT
MOVE_WORD
SHFR_BIT

SHFR_DWORD"
SHFR_WORD
SIZE_OFP
SWAP_DWORD"
SWAP_WORD"
VME_CFG_READ7?
VME_CFG_WRITE"®
VME_RD_BYTE"?
VME_RD_WORD7©
VME_RMW_BYTE”O
VME_RMW_WORD7©
VME_TS_BYTE®
VME_TS_WORD7®
VME_WRT_BYTE’©
VME_WRT_WORD”0
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ARRAY_MOVE_BOOL
ARRAY_MOVE_BYTE
ARRAY_MOVE_DINT
ARRAY_MOVE_DWORD*
ARRAY_MOVE_INT
ARRAY_MOVE_UINT
ARRAY_MOVE_WORD
ARRAY_RANGE_DINTA
ARRAY_RANGE_DWORD?
ARRAY_RANGE_INT*
ARRAY_RANGE_UINT*
ARRAY_RANGE_WORD"
FIFO_RD_DINTA
FIFO_RD_DWORD*
FIFO_RD_INT?
FIFO_RD_UINTA
FIFO_RD_WORD"
FIFO_WRT_DINTA
FIFO_WRT_DWORDA
FIFO_WRT_INTA
FIFO_WRT_UINTA

Logic Programs and Blocks

LD Editor

FIFO_WRT_WORD*
LIFO_RD_DINT?
LIFO_RD_DWORD"
LIFO_RD_INT*
LIFO_RD_UINT?
LIFO_RD_WORD*
LIFO_WRT_DINT?
LIFO_WRT_DWORDA
LIFO_WRT_INTA
LIFO_WRT_UINTA
LIFO_WRT_WORD*
SEARCH_EQ_BYTE
SEARCH_EQ_DINT
SEARCH_EQ_DWORD*
SEARCH_EQ_INT
SEARCH_EQ_UINT*
SEARCH_EQ_WORD
SEARCH_GE_BYTE
SEARCH_GE_DINT
SEARCH_GE_DWORD*
SEARCH_GE_INT

SEARCH_GE_UINT*
SEARCH_GE_WORD
SEARCH_GT BYTE
SEARCH_GT DINT
SEARCH_GT_DWORD*
SEARCH_GT_INT
SEARCH_GT_UINTA
SEARCH_GT_WORD
SEARCH_LE_BYTE
SEARCH_LE_DINT
SEARCH_LE_DWORD?
SEARCH_LE_INT
SEARCH_LE_UINTA
SEARCH_LE_WORD
SEARCH_LT BYTE
SEARCH_LT DINT
SEARCH_LT_DWORD"
SEARCH_LT_INT
SEARCH_LT_UINTA
SEARCH_LT_WORD
SEARCH_NE_BYTE

Math
ABS_DINTA ADD_REAL DIV_UINT MUL_MIXEDA
ABS_INT ADD_UINTA MOD_DINT MUL_REAL
ABS_LREALP DIV_DINT MOD_INT MUL_UINTA
ABS_REAL DIV_INT MOD_UINTA SCALE_DINTP
ADD_DINT DIV_LREALP MUL_DINT SCALE_INT
ADD_INT DIV_MIXEDA MUL_INT SCALE_UINTP
ADD_LREALP DIV_REAL MUL_LREALP SCALE_WORDP
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SEARCH_NE_DINT
SEARCH_NE_DWORD*
SEARCH_NE_INT
SEARCH_NE_UINTA
SEARCH_NE_WORD
SORT_INTA
SORT_UINT
SORT_WORDA
TBL_RD_DINT?
TBL_RD_DWORD*
TBL_RD_INT*
TBL_RD_UINT?
TBL_RD_WORD*
TBL_WRT_DINTA
TBL_WRT_DWORDA
TBL_WRT_INT
TBL_WRT_UINTA
TBL_WRT_WORD

SUB_DINT
SUB_INT
SUB_LREALP
SUB_REAL
SUB_UINTA
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Program Flow

ARG_PRESP END H WIRE
CALL ENDMCR JUMP
COMMENT ENDMCRN JUMPN
Relational
CMP_DINTA EQ_INT GE_REAL
CMP_INTA EQ_LREALP GE_UINTA
CMP_LREAL®  EQ_REAL GT_DINT
CMP_REAL? EQ_UINTA GT_INT
CMP_UINTA GE_DINT GT_LREALP
EQ_DATAP GE_INT GT_REAL
EQ_DINT GE_LREALP GT_UINTA

Timer Function Blocks

OFDT_HUNDS
OFDT_SECH
OFDT_TENTHS
OFDT_THOUS

ONDTR_HUNDS ~ TMR_HUNDS
ONDTR_SEC*  TMR_SECH

ONDTR_TENTHS TMR_TENTHS
ONDTR_THOUS ~ TMR_THOUS

VersaMax Micro Motion

BLENDING

GFK-1918S

FIND_HOME ~ GO_HOME

LABEL
LABELN
MCR

LE_DINT
LE_INT
LE_LREALP
LE_REAL
LE_UINTA
LT_DINT
LT_INT

TOFP
TONP
PP

JOGGING

Logic Programs and Blocks
LD Editor

MCRN
V_WIRE

LT LREALP NE_UINTA

LT REAL RANGE_DINT
LT _UINTA RANGE_DWORDA
NE_DINT RANGE_INT
NE_INT RANGE_UINTA
NE_LREALP RANGE_WORD
NE_REAL

STOP_MOTION
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Logic Programs and Blocks
FBD Editor

FBD EDITOR

The Function Block Diagram (FBD) editor is used to create logic with the
Function Block Diagram programming language. FBD is a process language.
FBD logic graphically represents the programmed actions performed by a
Controller as it executes.

The FBD editor is free form; that is, instructions and text boxes can be placed

anywhere on the FBD editor where there is empty space. Sequences of
instructions can be wired together horizontally and vertically.

You can work with the FBD editor while offline to edit a disk copy of a project, or
you can edit an FBD block of logic online, but this causes the logic to become

An FBD Block not equal until you download the FBD block.

You can customize the appearance and behavior of the FBD editor by setting
options (see page 28).

An FBD block is a named section of FBD Logic that is compiled and downloaded
to the Controller represented by the associated target.

To customize the FBD editor
1. Inthe @ Options tab of the 1= Navigator, expand the Editors folder, then
expand the Function Block Diagram folder.

2. Right-click the B Colors and Preferences page and choose Properties.
The configurable settings appear as properties in the Inspector.
3. Inthe Inspector, adjust settings as required.

To create an FBD block
1. Inthe Project tab of the 1= Navigator, right-click the 8 Program Blocks
folder, point to New, and then choose FBD Block.

A new FBD block with a default name is created.

2. Rename the block as desired.
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To open an FBD block for editing
* Inthe Project tab of the 1] Navigator, double-click an FBD block.
The block opens in the FBD editor.

Note: You can have multiple blocks open for editing. To navigate to another
open FBD block, click the tab that displays its name at the top of the editor
window.

Working with the FBD Editor Offline

While in offline mode, there is no live communication between the FBD editor
and the target. Most logic development is done while offline. The following
diagram illustrates some of the more common operations you can perform using
the FBD editor offline.
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To insert an instruction

1. In the FBD editor, right-click an empty cell and choose Insert Instruction.
A smart list appears listing all available instruction mnemonics.

2. Choose an instruction mnemonic from the list and press ENTER.

To assign a parameter beside an instruction

There are two methods to assign a parameter to an instruction.
First method (from the FBD editor)

1. In the FBD editor, hover the mouse pointer immediately before an input

connection point or immediately beyond an output[}éonnection point of an FBD
instruction, so that the mouse pointer appears as

AbD The numeral 1 indicates that for this FBD

This ADD instruction block, this instruction is solved first

=1 M1 o
requires two inputs (at _\_
IN1 and IN2) [:E_ e This ADD instruction requires one output
(atQ)

The mouse pointer indicates
that a parameter can be
assigned to this connection
point beside the ADD instruction

2. Double-click the connection point.

3. Inthe smart list that appears, enter or choose an existing variable, constant, or
expression to assign to the instruction parameter.

In the FBD editor, the instruction may display as follows:

ADD
= N1 Q-

myCountar =—f IN2
1

Note: Inside the rectangle of the ADD instruction, the “1* indicates the solve

order of the instruction. Under the variable myCounter, the “1* is the initial value
of myCounter.

Second method (outside the FBD editor)
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1. In the B Variables tab of the @ Navigator, or the @ Data Watch tool, select a
variable.
2. Drag the selected variable to the connection point of an FBD instruction.

3
3. When the mouse pointer appears as , release the left mouse button to assign
the variable to a parameter of the FBD instruction.

For example, the following diagram shows that you can assign a parameter to
the FBD SUBTRACT instruction at the output connection point named Q.

HI
-t al N
— Nz

After you have assigned the parameter, the instruction may appear as follows:

sue
4

- M1 Q f= myRezult

&1

= IHZ

Note: In the above diagram, “61“ is the initial value of myResult. ‘4" inside the
rectangle of the FBD instruction indicates its solve order.

% Want to know more? From the Help menu, select Search. Look up “solve order”. Select
“FBD Editor: an Overview".
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To assign a parameter above an FBD instruction or function block instance

The FBD Call instruction and every function block instance (an instance of a
counter, PID, timer, HART utility, or user-defined function block) require a
parameter to be assigned immediately above the instruction or instance.

. In the FBD editor, hover with the mouse pointer immediately aboye an FBD Call

or function block instance so that the mouse pointer appears as 5.

CALL
2
= EN END

. When the mouse pointer appears as [}E click the left mouse button.

The instruction or function block instance appears in the FBD editor with the
parameter selected, as shown below.

CALL g
2

o [

EN EN

. Without moving the mouse pointer, click again.

A smart list appears. If this is an FBD Call instruction, the smart list contains a
list of all callable blocks of logic in your target. If this is an FBD function block
instance, the smart list contains a list of variables that you can choose from to
assign instance data to the function block instance. Normally you would choose
or create instance data that is not used by any other function block instance, but
you can assign the same instance data to multiple function block instances if you
want.

. In the smart list, enter or choose an existing block of logic, or enter a new

variable, or enter or choose an existing variable.
The block appears as the destination of the FBD Call or the variable is assigned
as instance data to the function block instance.

To check (validate) a single FBD block

GFK-1918S

1. Inthe Project tab of the (1=} Navigator, ® expand the # target that contains

the block to check, and then expand the T Logic folder.

. Expand the t Program Blocks folder and then, if the block resides in a o user-

defined folder, expand the user-defined folder.

. Right-click the block and choose Check Block.

Machine Edition* checks the block for errors. Any messages or errors are
displayed in the Build tab of the B Feedback Zone.
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To change the number of inputs for FBD instructions (ADD, AND, MUL, OR, SUB, XOR)

1.
2

To draw a wire

In the FBD editor, select an ADD, AND, MUL, OR, SUB, or XOR instruction.

In the Inspector, select the Number of Inputs property, and then enter or choose
from the list the number of inputs you need.

. If required, draw a wire or assign a variable or constant to the input and output

parameters.

7 Want to know more? In the online help index, look up “FBD Block”. Click the Related
Topics button and choose “FBD Controller logic: an Overview".

Notes
At least two instructions must exist in the FBD editor.
You cannot draw a wire to or from a Text box.

In the FBD editor, hover the mouse pointer above a connection point of an FBD
instruction or function block instance.

When the mouse pointer appears as 5- you can start a wire. See the diagram
below.

2 =Nl 2
mylnput = IN1 o

0 2

myCountar =—f IN2

1

myCountar? = M2
1

Hold down the left mouse button, and then drag the mouse pointer to a
connection point of another FBD instruction

ADD

2 =N Q=

mylnput = IN1 o
o myCountar? = M2
1

myCountar =—f IN2
1

. Continue to hold down the left mouse button and drag the mouse pointer to a

connection point of another FBD instruction, until the mouse pointer appears as
This indicates that the current location is a valid end point for the wire. See the
diagram below.

Release the left mouse button.

The newly drawn wire appears as a solid (analog) or a dashed (discrete) line in
the FBD editor. See the diagram below.
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mylnput = 1M1 o - %r-
o myCountar? = M2

myCountar =—f IN2 1
1

1 _—,—— 1M1 Q p= myOutput
mylnput =f IN1 [v] a o
o

o myCountar? = M2

myCountar =—f IN2 1
1

Note: In the above diagram:
» The numbers “1“ and “2* inside the rectangles have been reversed, indicating
a change in the solve order.

» The zeroes under the wire are the value that is travelling over the wire. It's the
same value at both ends.

To negate an FBD parameter

To negate an FBD wire

GFK-1918S

(For discrete parameters only.)

. In the FBD editor, assign a BOOL parameter to a connection point of an FBD

instruction that requires a BOOL variable.
The diagram may appear as shown below.

NOT
1
EOOLT =N O = myResult
off off

. Right-click a BOOL variable assigned to a connection point, for example, in the

diagram above, BOOL1.

. In the list box that appears, choose Negate. The diagram now appears as

shown below.

NOT
1

EOOLT £ IN O = myResult

off off

Note: Negating a BOOL parameter while online causes logic to be not equal;
turning a BOOL parameter ON/OFF while online does not affect logic equality.

(For discrete FBD wires only.)

. If required, draw the FBD wire from a connection point that requires a BOOL

variable, to a connection point that also requires a BOOL variable.
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If the wire is discrete, it appears as a dotted line .....: "~ .

2. Right-click the wire, and then choose Negate.

The wire now appears as &------

To move or duplicate FBD logic
1. In the FBD editor, select an FBD instruction or Text box.
2. To move it:
Click the selection and drag it to a new valid location. When you move an
instruction, the parameters and wires assigned to it move along with it.
-or-
To duplicate it:
Press CTRL while clicking the selection and drag the selection to where you want
to place the duplicate. When you release the mouse button, a duplicate copy of

the selected instruction is placed in the new area. When you duplicate an
instruction, its parameters are also duplicated; wires are not duplicated.

7 Want to know more? From the Help menu, select Search. Paste “editing FBD blocks®
(including the quotation marks) and then choose “Editing FBD blocks®.

To zoom in or zoom out an FBD block

Note: To zoom in an FBD block display in the FBD editor makes the FBD appear
larger; to zoom out an FBD block display makes the FBD appear smaller.

1. Click anywhere in the FBD editor.
2. Do one of the following:

In the Inspector, expand the Diagram Settings group of properties, and
then set the zoom property.
- Or -

» To zoom out, press the “-* key. To zoom in, press the “+* key.
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by the lightning bolt.
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Working with the FBD Editor Online

FBD Editor

When you are online in monitor mode, you can monitor the Controller but cannot
change anything in the Controller or edit your logic.

When online in programmer mode, you can edit your logic, make changes in the
Controller, and monitor the Controller. PACSystems* targets also support Run
Mode Store; that is, you can download logic to a running PACSystems.

See “Offline, Online: monitor mode, programmer mode”, on page 46.
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To turn on/off or force a variable
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indicates the status of
the Controller.

A wire with a
solid line
indicates
analog

| A wire with a

dotted line
indicates
discrete

Monitor and
change values
in real-time
with the Data

Controller Status is

indicated in the status bar.

+ In the FBD editor, right-click a BOOL variable anywhere in FBD logic and choose
Force ON, Force OFF, Toggle Force, Turn ON, Turn OFF, or Toggle 10.
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AND
NOT

CMP
EQ
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Note: Forcing a variable ON or OFF overrides any actions the logic may take
during runtime. That is, if a variable is forced OFF (0), but FBD logic is trying to
turn it ON (1), it stays OFF.

7 Want to know more? From the Help menu, select Search. Enter “Working with Variables

and FBD Logic Online* (including the quotation marks).

FBD Instructions, Functions, and Function

Blocks

(PACSystems™ only.) The following is a list of all FBD instructions, functions, and
function blocks available in Logic Developer - PLC*.

7 Want to know more? In the online help index, look up “FBD Instructions®.

Advanced Math
ASIN
ATAN
Bit Operations
OR
ROL
Comparison
GE
GT

Communication

PNIO_DEV_COMM

DO_I0
F_TRIG

DNCTR

Control
MASK_IO_INTR
PID_IND

Counters
UPCTR

Cos
EXP

ROR
SHIFTL

LE
LT

PID_ISA
R_TRIG
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EXPT
LN

SHIFTR
XOR

NE
RANGE

SCAN_SET [0
sus_lo

LOG SQRT
SIN TAN
SUSP_I0_INTR
SVC_REQ
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MoV
MOVE_DATA_EX
MOVE_TO_FLAT
SIZE_OF

Data Move
ARRAY_SIZE BUS_RMW_BYTE BUS_TS_WORD
ARRAY_SIZE_DIM1 BUS_RMW_DWORD BUS_WRT
ARRAY_SIZE_DIM2 BUS_RMW_WORD COMM_REQ
BUS_RD BUS_TS_BYTE FANOUT

Math
ADD MOD NEG SUB
DIV MUL SCALE

Program Flow
ARG_PRES CALL

Timer Function Blocks
OFDT_HUNDS ONDTR_HUNDS TMR_HUNDS TOF
OFDT_SEC ONDTR_SEC TMR_SEC TON
OFDT_TENTHS  ONDTR_TENTHS TMR_TENTHS TP
OFDT_THOUS ONDTR_THOUS = TMR_THOUS

Type Conversion
BCD4 TO_INT DINT_TO_DWORD  INT_TO DINT REAL_TO DINT
BCD4 TO _REAL DINT_TO_INT INT_TO_REAL REAL_TO_INT
BCD4_TO_UINT DINT_TO_LREAL  INT_TO_UINT REAL_TO_LREAL
BCDS_TO_DINT DINT_TO_REAL  INT_TO_WORD REAL_TO_UINT
BCD8_TO_REAL DINT_TO_UINT LREAL_TO_DINT TRUNC_DINT
DEG_TO_RAD DWORD TO DINT LREAL_TO REAL  TRUNC_INT
DINT_TO_BCD8 INT_TO_BCD4 RAD_TO DEG UINT_TO_BCD4
GFK-1918S

UINT_TO_DINT
UINT_TO_INT
UINT_TO_REAL
UINT_TO_WORD
WORD_TO_INT
WORD_TO_UINT
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Navigator: Project tab

An IL Block

IL EDITOR

Instruction List (IL) is a programming language specified by the IEC 61131-3
standard. This text language is accumulator-based and much like the assembly
languages used for programming microprocessors. The instructions executed by
an IL block modify or use an accumulator that is located in Controller memory.
Two types of accumulators are defined: one analog accumulator for numeric and
bitwise operations and eight boolean accumulators for discrete logic to support
eight levels of nested boolean expressions. The IL editor is free-form with an
option to apply a standard formatting rule. The appearance and behavior of the
IL editor is user-configurable.

Note: Only Series 90*-30, VersaMax* Controllers, and VersaMax* Nano/Micro
support IL logic.

To configure accumulators

To create an IL block
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1. Inthe Project tab of the 1= Navigator, right-click the s Program Blocks

folder and choose Properties.

The Inspector displays the Accumulator Address properties.

. In the Boolean Start property, enter the reference address of the first of eight

Controller memory locations to use for boolean accumulators.

The ending address is calculated automatically. The memory area must be %T,
%M, or %Q.

. In the Analog Start property, enter the Controller memory locations to use for the

analog accumulator.

The ending address is calculated automatically. The memory area must be %R,
%Al or %AQ.

. Inthe Project tab of the 1= Navigator, right-click the t Program Blocks

folder, point to New, and choose IL Block.

An empty IL block with the default name "ILBkn” is added to the folder, where n
represents a unique number.

. Rename the block as desired.

GFK-1918S



Logic Programs and Blocks

To open an IL block for editing
* Inthe Project tab of the 1= Navigator, right-click an [Z1 IL Block and choose

The Variables
tab of the
Navigator lists

Open.

The block opens in the IL editor.

IL Editor

Note: You can have multiple blocks open for editing. To navigate to another
open IL block, click the tab displaying its name at the top of the editor window.

Working with the IL Editor Offline

Most project development is carried out while offline from the target Controller.
Editing while offline provides maximum flexibility and enables you to interact with
the Machine Edition* tools as shown in the following diagram.
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Done

To insert an instruction
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1. In the IL editor, right-click and choose Insert Keyword.

A smart list appears listing all available instruction mnemonics.

2. From the list, select an instruction and press ENTER.

The instruction is inserted in your logic.
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To assign operands to an instruction
1. In the IL editor, right-click and choose Insert Variable.
A smart list appears showing all your defined variables.

2. Type, or choose from the list, a variable name or reference address and then
press ENTER.

The name appears in your logic.
Note: If you entered a reference address or a new variable name, you must
create a variable from it.

To create a variable from a reference address

+ In the IL editor, right-click a reference address, point to Create “name” as, and
then choose a data type.

A variable is created and a default name is applied. For example, if the reference
address is %R0032, the auto-created variable is named R00032.

To create a variable from a name
1. In the IL editor, right-click a name, point to Create “name” as, and then choose
a data type.

A variable is created with the name you right-clicked.

2. Map the variable to Controller memory. (See page 26.)

To move or duplicate IL logic
1. Inthe IL editor, select a range of logic.

2. To move it, click the selection and drag it to a new location. To duplicate it, press
CTRL while clicking the selection, and drag the selection to where you want to
place the duplicate.

When you release the mouse button, the selection is respectively moved to the
new location or a duplicate copy of the selected logic is placed in the new area.

To insert an inline comment
1. In the IL editor, click where you want to insert an inline comment.

2. Type an apostrophe (‘) followed by comment text.

3. Press ENTER to complete the comment.

To insert a block comment
1. In the IL editor, click where you want to insert a block comment.

2. Type (* followed by comment text.
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A block comment can contain any number of characters and can span multiple
lines.

Type *) to complete the block comment.

In the IL editor, right-click and choose Beautify Source.
The entire content of the IL editor is reformatted according to the default
formatting (indentation) rules.

Working with the IL Editor Online

When online in monitor mode, you can monitor the Controller but cannot change
anything in the Controller or edit your logic.

When you are online in programmer mode, you can edit your logic, make
changes in the Controller, and monitor the Controller. Many GE targets support
Run Mode Store; that is, you can download logic to them when they are running.

See “Offline, Online: monitor mode, programmer mode”, on page 46.
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To monitor a data value
 Click anywhere in the IL editor and hover the mouse pointer over a variable.

A tooltip appears, showing the variable’s current value. This value, however,
does not update automatically: you must move the mouse pointer away and
back over the variable to update the value.

To change a BOOL variable’s state

* In the IL editor, right-click the BOOL variable whose value you want to change
and choose Turn On, Turn Off, or Toggle I10.

The state of the variable in the target Controller changes when the command is
received. It remains in that state until acted on by the Controller’s logic.

To force a BOOL variable’s state

* In the IL editor, right-click a BOOL variable and choose Force On, Force Off, or
Toggle Force.

The state of a forced variable remains unchanged, regardless of any actions by
Controller logic.

To remove the force from a BOOL variable
+ In the IL editor, right-click a BOOL variable and choose Remove Forces.

The state of the forced variable is controlled by Controller logic from now on.

Downloading Online Changes to a GE IP
Controller

You can change your IL logic while online, but you must download the changes
to the Controller to maintain equality. Some GE Controllers support the
downloading of changed IL logic even when they are executing.

To make changes to IL logic and download them to a running target Controller (if the target
Controller supports it)
1. While online to a target Controller, make a change to IL logic.
2. Inthe Project tab of the 1] Navigator, right-click the ¥ target and choose
Download to Controller.

You are prompted to confirm a Run Mode Store. That is, the altered IL block will
be downloaded to the running Controller without stopping it.

7 Want to know more? In the online help index, look up “Downloading to running GE
Controllers”.

126 Proficy* Logic Developer - PLC* 8.50 GFK-1918S



Logic Programs and Blocks
IL Editor

IL Instructions

The following is a list of all IL instructions available in Logic Developer - PLC*.
Companion help indicates which Controllers support the instructions.

Basic Instructions

ADD GT LT OR ST_DINT XOR
AND LD_BOOL MOD ORN ST_INT XORN
ANDN LD_ENO MUuL PT ST_REAL

DIV LD_INT NE R ST_WORD

EQ LDN_BOOL NOT S STN_BOOL

GE LE NT ST_BOOL SUB

Advanced Math

ACOS COS LN SQRT_DINT TAN
ASIN EXP LOG SQRT_INT
ATAN EXPT SIN SQRT_REAL

Bit Operations

AND_WORD BIT_SEQ MASK_COMP_DWORD OR_WORD SHIFTL_WORD
BIT_CLR_WORD BIT SET WORD MASK_COMP_WORD ROL_WORD SHIFTR_WORD
BIT_POS_WORD BIT TEST WORD NOT_WORD ROR_WORD ~ XOR_WORD

Communication
MODBUS_TCP_RW (VersaMax Micro CPUs with firmware version 4.00 or later)

Control
DO_IO DRUM PID_IND PID_ISA SER SVC_REQ

Conversions

BCD4 TO_INT  DINT_TO REAL RAD_TO DEG  REAL_TO_WORD WORD_TO_REAL
BCD4_TO REAL INT_TO_BCD4  REAL_TO DINT  TRUNC_DINT
DEG_TO RAD  INT_TO_REAL  REAL_TOINT  TRUNC_INT

Counters
DNCTR UPCTR

A superscript V (V) indicates instructions supported only for VersaMax Controllers.
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Data Move
BLK_CLR_WORD BLKMOV_REAL COMM_REQ MOVE_BOOL MOVE_REAL SHFR_BIT
BLKMOV_INT BLKMOV_WORD MOVE_INT MOVE_WORD SHFR_WORD
Data Table

ARRAY MOVE_BOOL SEARCH EQ_INT ~ SEARCH GT DINT ~ SEARCH_LT BYTE  SEARCH_NE_WORD
ARRAY_MOVE_BYTE SEARCH_EQ_WORD SEARCH_GT_INT ~ SEARCH_LT_DINT

ARRAY_MOVE_DINT SEARCH_GE_BYTE SEARCH_GT_WORD SEARCH_LT_INT

ARRAY MOVE_INT ~ SEARCH_GE_DINT ~ SEARCH_LE_BYTE  SEARCH_LT_WORD

ARRAY_MOVE_WOR SEARCH_GE_INT ~ SEARCH_LE_DINT  SEARCH_NE_BYTE
D

SEARCH EQ_BYTE SEARCH_GE_WORD SEARCH_LE_INT  SEARCH_NE_DINT
SEARCH_EQ_DINT ~ SEARCH_GT BYTE  SEARCH_LE_WORD SEARCH_NE_INT

Math
ADD_DINT DIV_DINT MOD_DINT MUL_DINT SCALE_WORDY  SUB_REAL
ADD_INT DIV_INT MOD_INT MUL_REAL SUB_DINT
ADD_REAL DIV_REAL MUL_INT SCALE_INTV  SUB_INT

Program Flow

CAL CALCN END_MCRN JMPC MCRN RETC
CALC END JMP JMPCN RET RETCN
Relational
EQ_DINT GE_DINT GT_DINT LE_DINT LT_DINT NE_DINT RANGE_DINT
EQ_INT GE_INT GT_INT LE_INT LT_INT NE_INT RANGE_INT
EQ_REAL GE_REAL GT_REAL LE_REAL LT_REAL NE_REAL RANGE_WOR
D

Timer Function Blocks

OFDT_HUNDS ~ ONDTR_HUNDS TMR_HUNDS
OFDT_TENTHS ~ ONDTR_TENTHS TMR_TENTHS
OFDT_THOUS ~ ONDTR_THOUS = TMR_THOUS
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1]
Bl £ Logic

E|T:g Pragram Blocks
)

4 3

EBEEIEER

Navigator: Project tab

An ST Block

ST EDITOR

Structured Text logic is a programming language specified by the IEC 61131-3
standard. The Structured Text (ST) Editor is a free-form text editor for editing
Structured Text logic in the Machine Edition* environment. With the ST editor,
you can work on a disk copy of a structured text block (offline) or monitor the
execution of an ST block running in the Controller (online). You can edit an ST
block online, but this causes the logic to become not equal until you download
the ST block.

ST is a high-level language that uses various operators and functions. ST logic
is supported by PACSystems™ Controllers.

To customize the ST Editor

To create an ST block

. Inthe & Options tab of the 1] Navigator, expand the (1 Editors folder and then

the @ Text folder.

. Right-click a & page (Colors or Preferences), and choose Properties.

The configurable settings appear as properties in the Inspector.

. Inthe Inspector, adjust the settings as required.

. In the & Project tab of the 1] Navigator, ® expand the £+ Logic folder, right-

click the T8 Program Blocks folder or a 1 user-defined folder, point to New, and
then choose ST block.

A new ST block with a default name is created under the Program Blocks folder
or under a user-defined folder.

2. (Optional.) Rename the block.

To create a parameterized ST block

GFK-1918S

. Create an ST block.

2. Do one of the following:

In the Inspector, set parameters for the block.
- or -

Set the block’s Block Type property to Parameterized Block, and then
optionally schedule the parameterized block.
Notes:
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» By assigning parameters to the block, its Block Type property is automatically
changed to Parameterized Block.

» A parameterized block cannot have both interrupt scheduling and
parameters.

% Want to know more? In the online help index, look up “Parameterized Block".

To open an ST block for editing

* Inthe & Project tab of the 1] Navigator, under the & Logic folder, under the
= Program Blocks folder, or under a (1 user-defined folder, double-click an
= ST block.

The ST block opens in the ST editor.

Working with the ST Editor Offline

The ST editor interacts with the Machine Edition* tools to provide maximum
flexibility when editing a program. The following diagram illustrates some of the
operations you can perform.
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To insert an ST variable or keyword
1. In the ST editor, right-click and choose Insert Variable or Insert Keyword.
A smart list appears, prompting you to enter the name of an existing variable or
keyword.
2. Type, or choose from the list, the item you want, and then press ENTER.
The variable or keyword appears in the ST editor.
Notes:

» Parameters and constants must be manually entered.

> When entering an indirect reference as an operand, prefix the variable name
with @ after selecting it from the smart list, for example, @IntVar. Indirect
referencing is available for all register references (%R, %P, %L, %W, %Al,
and %AQ).

% Want to know more? In the online help index, look up “Indirect References".

To create a variable from a name

* In the ST editor, right-click a name that was entered as an operand, point to
Create "[name]" as, and then choose a data type from the list that appears.
A new variable of the specified data type is created and substituted for the name
at every occurrence in the ST block. The name of the new variable is identical
with the original name.

To insert a line comment
1. In the ST editor, click where you want a line comment to begin.
2. Type an apostrophe (’) or // followed by comment text.

3. Press ENTER to complete the line comment. The line comment ends when a new
line starts.

To insert a block comment
1. In the ST editor, click where you want a block comment to begin.

2. Type (* followed by comment text. A block comment can contain any number of
characters and can span multiple lines.

3. Type *) to complete the block comment.
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To select a range of ST logic
1. In the ST editor, click at the beginning of the range.
2. Press and hold shift and then click at the end of the range. All logic within the
range is selected.
Tips:
» You can also click and drag from the beginning of the range to the end.

» After selecting a range of logic, you can click anywhere in it and drag it to
another area in the ST editor.

To move or duplicate ST logic

1. In the ST editor, select a range of logic.

2. To move it, click the selection and drag it to the new location. To duplicate it,
press CTRL while clicking the selection, and then drag the selection to where you
want to place the duplicate.

When you release the mouse button, the selection is respectively moved to the
new location or a duplicate copy of the selected logic is placed in the new area.

To locate all occurrences of a variable
1. In the | Feedback Zone, click the References tab.
2. Click a 2 variable anywhere it appears in ST logic, in the Variables tab of the
Navigator, or in the % Data Watch tool.

Each occurrence of the variable in your project (for a given # target) is listed in
the References tab of the Feedback Zone.
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Working with the ST Editor Online

When online in monitor mode, you can monitor the Controller but cannot change
anything in the Controller or edit your logic.

ST Editor

When you are online in programmer mode, you can edit your logic, make
changes in the Controller, and monitor the Controller. PACSystems* targets also
support Run Mode Store; that is, you can download logic to a running
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PACSystems.
“A\EEL: . . »
See “Offline, Online: monitor mode, programmer mode”, on page 46.
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> In the ST editor, hover the mouse pointer over a variable to see its value. A
tool tip displays the variable name, address, description, data type, and
current value. If this is a BOOL variable, the tool tip also displays if it has

been forced On (1) or Off (0).
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ST parameterized block parameter

In the Project tab of the 1] Navigator, ® expand the ts Program Blocks
folder.

. If the block that contains the call to the ST parameterized block whose

parameter you want to monitor resides in a a user-defined folder, expand the
user-defined folder.

Right-click the block that contains the call and choose Open.
The block appears in the appropriate editor.

In the editor, right-click the block call to the ST parameterized block and choose
Open Block.
The called ST parameterized block appears in the ST editor.

In the ST editor, hover the mouse pointer over the parameterized block
parameter (variable) to see its value.

Depending on the context of the parameter, the tool tip displays the following
items:

If the text refers to a parameter instead of a variable, and the block was
opened from a CALL instruction (in an LD, ST, or FBD block), then if possible,
the parameter is associated with the variable used in the call the block was
opened from. In this case, the tool tip displays the parameter name, address
of the variable, description of the parameter, data type, and value of the
variable.

If the text refers to a parameter instead of a variable, and the block was not
opened from a CALL instruction (in an LD, ST, or FBD block), then the tool tip
displays the parameter name, description of the parameter, and data type
only.
In either case, if this is a forced BOOL variable, the tool tip also displays if the
variable has been forced On (1) or Off (0).

Note: The tool tip displays a variable’s current value only if logic is equal; the
tool tip doesn’t display the current value if logic is not equal.

To change a BOOL variable’s state

* In the ST editor, right-click the BOOL variable whose value you want to change

and choose Turn On, Turn Off, or Toggle I0.

The state of the variable in the target Controller changes when the Controller
receives the command.
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* In the ST editor, right-click a BOOL variable and choose Force On, Force Off,

or Toggle Force.
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The state of a forced variable remains unchanged, regardless of any actions by

Controller logic.

To remove the force from a BOOL variable
+ In the ST editor, right-click a BOOL variable and choose Remove Forces.

Statements

:= (Assignment) ~ Comment
Block call Exit
Case For...do

Advanced Math

ACOS ATAN
ACOS_LREAL  ATAN_LREAL
ACOS_REAL  ATAN_REAL
ASIN cos

ASIN LREAL  COS_LREAL
ASIN_REAL COS_REAL

The state of the unforced variable is controlled by Controller logic from now on.

ST Statements, Functions, and Function

Blocks

The following is a list of all ST statements, functions, and function blocks
available in Logic Developer - PLC*. InfoViewer Help indicates which firmware
version of PACSystems supports the statements, functions, or function blocks.

7 Want to know more? In the online help index, look up “ST Instructions" and "ST Logic: an

Overview",

Function block invocation

Function call
If

EXP
EXP_LREAL
EXP_REAL
EXPT, **, or A
EXPT_REAL
EXPT_LREAL

Bitwise Operators

AND NOT

Communication
PNIO_DEV_COMM

GFK-1918S

OR

LN
LN_LREAL
LN_REAL
LOG
LOG_LREAL
LOG_REAL

XOR

Repeat ... until
Return
While ... do

SIN SQRT_REAL
SIN_LREAL TAN
SIN_REAL TAN_LREAL
SQRT_DINT TAN_REAL
SQRT_INT

SQRT_LREAL
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DO_I0 MASK_IO_INTR  SCAN_SET IO
F_TRIG R_TRIG SUS_I0
Conversions
ANGLES

BCD4 to INT, REAL, or UINT

BCD8 to DINT or REAL

DINT to BCD8, DWORD, INT, LREAL, REAL, or UINT
DWORD to DINT

INT to BCD4, DINT, REAL, UINT, or WORD

Logic Programs and Blocks

SUSP_I0_INTR
SVC_REQ

SWITCH_POS

LREAL to DINT or REAL

REAL to DINT, INT, LREAL, or UINT
TRUNC_DINT, TRUNC_INT

UINT to BCD4, DINT, INT, REAL, or WORD
WORD to INT or UINT

Data Move
ARRAY_SIZE ARRAY_SIZE _DIM2  MOVE_DATA EX SIZE_OF
ARRAY_SIZE_DIM1  COMM_REQ MOVE_TO_FLAT
Program Flow
ARG_PRES
Math Functions
ABS_DINT ABS_LREAL SCALE_DINT SCALE_UINT
ABS_INT ABS_REAL SCALE_INT
Math Operators
+ (addition) - (subtraction) - (negation) * (multiplication) / (division) mod (modulo)
Relational Operators
= (Equal) >= (Greater than > (Greater than) <= (Less thanor < (Less than) <>, 1= (Not equal)
or equal) equal)
Timer Function Blocks
TOF TON TP
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Navigator: Project tab
A C Block

To import a C block

GFK-1918S

[T1Sample C Block exe

File name:

Files of type: IEI Block Files [*.exe]

C BLOCKS

A C block is an independent section of executable code written in the C
programming language that is downloaded to and executed on the target
Controller. C blocks are created externally using GE’s C Programming Toolkit
and then imported into a project. A C block compiled for PACSystems* has a
.gefelf extension. A C block compiled for Series 90*-70 or Series 90*-30 has a
.exe extension. C Blocks can be called as a subroutine from another block (LD,
ST, FBD, or IL) but cannot call another block.

For more information on developing C Blocks, refer to C Programmer’s Toolkit
for Series 90 Controllers (GFK-0646) and PACSystems C Toolkit User’s Guide
(GFK-2259).

Working with C blocks

. Inthe & Project tab of the 1] Navigator, right-click the t8 Program Blocks

folder and choose Add C block.
The Open dialog box appears.

Look jr: I 3 Project2

i Jlca] = ) sl

[Sample C Block.exe

Open I
j Cancel |

. Browse to the .exe or .gefelf file you want to import and click Open.

The selected file is added to the T Program Blocks folder with the same name
as the .exe or .gefelf file.

Note: You can then move the C Block to a =2 user-defined folder.

7 Want to know more? In the online help index, look up “C block” and “User-Defined Folder".
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To set a C block’s parameters

Note: This procedure applies only to C blocks that were written to require
parameters for use on PACSystems* or Series 90*-70 targets.

1. Inthe & Project tab of the | Navigator, right-click the [Z] C block and choose
Properties.

The Inspector displays the block’s properties.
2. In the Inspector, select the Parameters property and click .
The Parameters dialog box appears.
3. Type a name and description for each required input and output parameter.

For information on the required parameters, refer to the written documentation
for the C block. The names you enter will display in the CALL instruction that
calls the C block. The names and descriptions will display in a tooltip when you
hover the mouse pointer over the CALL instruction.

7 Want to know more? In the online help index, enter “Parameterized” and select the “C Block”
help topic.
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C PROGRAMS

Note: C programs are supported only on Series 90*-70 CPUs, firmware release
6.00 and later.

A C program is an independent section of executable code, written in C
language, that is downloaded to and executed on the associated target
Controller. To develop a C program, use GE's C Programmer's Toolkit for Series
90 Controllers User's Manual (GFK-0646). You then import it into a project.

A C program has access to all the % reference tables of the Controller except for
the _MAIN LD block’s %P memory and the %L memory of any other LD block. A
C program can also call any of the numerous Controller-embedded functions
that are included in the C Programmer’s Toolkit.

A C program cannot be called as a subroutine. Execution is controlled only
through scheduling. A C program cannot call a block as a subroutine.

By setting the parameters of a C program, you enable it to access memory
directly. When a C program begins to execute, it reads the data for all the
parameters and makes a copy of the data. If the C program’s execution is
interrupted or time-sliced over multiple scans, the C program, when it resumes
execution, uses the copy of the data that it made when it began to execute.

C programs can coexist with a main program on a Series 90-70 Controller.
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Working with C Programs

Setting a C program’s parameters

Note: You must provide a list of all the input and output parameters that the C
program requires. The main program does not use parameters.

1. Inthe E Project tab of the 1] Navigator, right-click a [ C program and choose
Properties.

The Inspector displays the C program’s properties.
2. In the Inspector, select the Parameters property and click =].
The Parameters dialog box appears.

3. On the Input and Output tabs, enter up to 8 input and up to 8 output parameters.
Each parameter has its own row on the tab. For each parameter, double-click the
following cells and enter the required data:

*  Name: The parameter’s name.

Type: The parameter’s data type.
Length: The length of the input or output reference.
Variable: The first data item associated with the parameter.

Description: (Optional.) The parameter’s description.

% Want to know more? In the online help index, choose “C Program’.
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LD Diagnostic Logic Blocks

o x (PACSystems* RX3i firmware version 5.60 and later.)

= A PACSystems RX3i target contains the _[# Diagnostic Logic Blocks folder,
-4 Targetl ™ which contains two empty subfolders: the Active Blocks folder and the Inactive
o B st | Blocks folder.
EE%LDEL“ Active Blocks folder
E|_E1 1;;§EC§:CEOFHES The ﬁ Active Blocks Folder can contain the following:
- i H;}:IwarL: BCEInFiguratinn » One or more active LD DLBs.
E%:Err:ngcr:rcleﬁlﬁkasbles | »  Zero through three Cam profiles associated with an LD DLB.
. [ Suoplemental Files - » One or more user-defined folders.
@ B® [@72] Inactive Blocks folder
Project Tab: Navigator The L[ Inactive Blocks Folder can contain the following:
LD Diagnostic Logic Blocks > One or more inactive LD DLBs.

One or more user-defined folders.

Active LD Diagnostic Logic Blocks

An —@ active LD Diagnostic Logic Block (DLB) is a named section of ladder
logic that is compiled and downloaded to the Controller.

Cam profiles associated with an active LD DLB are stored in the §Cam
profiles folder and are also downloaded to the Controller.

The contents of an active LD DLB are edited with the LD editor.

Immediately before an upload from the Controller is performed, all active LD
DLBs and their associated Cam profiles are moved to the _[F]Inactive Blocks
folder. This causes all active LD DLBs to become —@ inactive LD DLBs prior to
the upload, because the variables being used by the active LD DLBs may not
exist in your project after the upload completes.

After an upload from the Controller, you can activate an LD DLB. Do this in the
I:E| Navigator by right-clicking an inactive LD DLB and choosing Activate.
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Every LD DLB, whether active or inactive, has an associated Published Variable
Table (PVT) that contains the local published variables of the LD DLB. If an LD
DLB has no local variables, then its PVT is empty.

7 Want to know more? In the online help index, look up “Active LD Diagnostic Logic Block
(DLB)".

Inactive LD Diagnostic Logic Blocks

An —@ inactive LD Diagnostic Logic Block (DLB) is a named section of ladder
logic that is inactive and for storage only. An inactive LD DLB cannot be viewed,
edited, compiled, or downloaded to the Controller. Cam profiles associated with
an inactive LD DLB also cannot be viewed.

To edit, view, or download the contents of an inactive LD DLB, or to edit or view
a @ Cam Profile associated with an inactive LD DLB, you must first activate
the LD DLB. To do this, in the EE.| Navigator, right-click an inactive LD DLB and
choose Activate.

% Want to know more? In the online help index, look up “Inactive LD Diagnostic Logic Block
(DLB)" and “Working with LD Diagnostic Logic Blocks (DLBs)".

To create an active LD Diagnostic Logic Block

1. Inthe Project tab of the g Navigator, expand the PACSystems* RX3i
lﬁl target where you want to create the -@ active LD Diagnostic Logic Block
(DLB), expand the -E'IDiagnostic Logic Blocks folder, and then expand the EI
Active Blocks folder.

2. Ifthe active LD DLB is to reside in a [_] user-defined folder, then, if required,
add the user-defined folder.

3. Right-click the folder where you want to create the active LD DLB, point to New,
and then choose Block.
The active LD DLB is created and its unique default name is highlighted.
Each active LD DLB contains a §Cam Profiles folder, where you can add, edit,
or import from one through three &l cam profiles.

4. (Optional.) Rename the new active LD DLB.

All LD DLBs in the parent folder appear in alphabetical order..

% Want to know more? In the online help index, look up “Working with LD Diagnostic Logic
Blocks”.
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PROFINET Support

(PACSystems* RXi; PACSystems* RX3i with firmware version 7.00 and later.)
Hardware

GE IP PROFINET Controllers (PNCs) support the following PROFINET devices:

VersaMax VersaMax IP VersaPoint
RSTi PAC8000 General Electric AF6
Third-party

A PNC is connected by Ethernet to PROFINET devices, each of which has its own
modules and possibly submodules.

Software

In Machine Edition, the PROFINET devices connected to a PNC are shown as
nodes under the PNC in the Hardware Configuration of a PACSystems RXi or
PACSystems RX3i target in a Machine Edition project. The illustration on the
next page highlights the target names and the PNCs.

Configuration data

The data required to configure the PROFINET devices connected to the PROFINET
Controller is contained in GSDML files provided by the vendors in accordance
with PROFINET standards.

Redundancy

PACSystems RX3i Controllers support Hot Standby CPU redundancy with
PROFINET I/O. In that setup, two RX3i Controllers are capable of controlling the
same set of PROFINET devices. (For the minimum PACSystems RX3i firmware
version requirement, refer to online help.).

7 Want to know more? In the online help index, look up “PROFINET Devices Catalog”, "RXi
PROFINET Controller", “lC695PNC001: RX3i PROFINET Controller (2 SFP)", “Supported
PROFINET devices”, “GSDML files: Overview”. “configuring PROFINET networks”, and “LAN
View: Overview (PROFINET)".
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Ethernet Global Data (EGD)

Ethernet Global Data (EGD)

Ethernet Global Data is a mechanism that enables one CPU, referred to as a
producer, to share a portion of its internal memory with one or more other CPUs,
referred to as consumers, at a scheduled periodic rate. Such a snapshot of
internal memory, mediated by an Ethernet interface, is referred to as an
exchange. An exchange is identified by a unique combination of three identifiers:

The Producer ID (the producer's IP address)
The Exchange ID (the exchange's identifier)
The Adapter Name (the Ethernet interface identifier)

Exchanges vs. Pages

Some EGD tools group multiple produced exchanges into a page, and some
EGD tools can consume such pages. Logic Developer - PLC*, however, does
not consume or produce pages. It consumes and produces exchanges.

When you add a consumed exchange in Logic Developer - PLC, if an
EGD tool has published produced pages that contain multiple exchanges
to the EGD Configuration Server, the produced exchanges are extracted
from the pages and presented for your selection as exchanges.

Logic Developer - PLC does not group multiple produced exchanges into
a produced page. EGD tools that consume pages see Logic Developer -
PLC produced exchanges as pages with only one exchange each.

Integration with the EGD Configuration Server

Logic Developer - PLC* is integrated with the EGD Configuration Server. The
EGD Configuration Server is a central repository of EGD configuration
information used to facilitate the sharing of information between EGD tools in
order to assist with the configuration of EGD.

After configuring a produced exchange on any EGD tool (such as the EGD
component in Logic Developer - PLC), you can publish the configuration of the
produced exchanges to the EGD Configuration Server. After this, Logic
Developer - PLC, when connected to the server, can obtain the produced
exchange configuration from the server and automatically create a consumed
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exchange that matches the produced exchange exactly. At this point, the only
thing left to do is to map the variables of the exchange to memory on the EGD
consumer, or to replace some or all of the unmapped variables with mapped
variables that already exist on the EGD consumer.

The EGD Configuration Server provides extra EGD validation that is unavailable
without the server.

The EGD Configuration Server supports EGD Signatures. When a
PACSystems* RX7i or PACSystems* RX3i is configured to use signatures, then
every scan, it compares the signature of every consumed exchange with the
signature of its corresponding produced exchange to determine whether the
configuration of the consumed exchange matches the configuration of the
produced exchange; if not, the exchange is not consumed.

The EGD Configuration Server tracks which produced exchanges published on
the server are consumed by EGD devices connected to the server. You can
obtain an Unconsumed Data report. Other reports compare the produced or
consumed exchange information on your computer with that on the server.

The EGD Configuration Server is not the authoritative source of the EGD
configuration. It does not store past versions of EGD configurations. It contains
only the latest snapshots of the EGD configurations published to it. The EGD
tools are the authoritative source, while the server enables the tools to share
information. It is possible to delete the server contents completely and restore
them again by using the tools in a two-step process: publish the authoritative
information from all tools to the server, and have each tool read the information it
needs from the server and confirm to the server that it has received it.

% Want to know more? In the online help index, look up “Ethernet Global Data in Logic
Developer - PLC*: an Overview” and “EGD Configuration Server: Integration with Logic
Developer - PLC*".

Integration with the EGD Management Tool

Logic Developer - PLC* is integrated with the EGD Management Tool (EMT).
You can open the EMT from within Logic Developer - PLC and vice-versa.

The EMT provides a high-level view of the EGD system published on the EGD
Configuration Server, including a graphical display of individual EGD systems.
The EMT provides validation of the EGD configuration.

The EMT enables the EGD configuration of devices by launching the appropriate
EGD Configuration Tool from the graphical display.

7 Want to know more? Refer to the online help in the EGD Management Tool.

146 Proficy* Logic Developer - PLC* 8.50 GFK-1918S



Ethernet Global Data (EGD)

Logic Developer - PLC* implementation of
EGD: the EGD component

The first step in using Ethernet Global Data (EGD) in a GE IP Controller or ENIU
target consists in adding the EGD component. In a Controller target, you can do
so even if the CPU presently configured in the target does not support EGD, as
long as the target belongs to one of the Controller families that support EGD.

This flexibility enables you to start configuring EGD even if the hardware
specifications of your system have not been determined.

To add the EGD component

=8 Pe
E|l'| TRex
422 Data Wakch Lists
‘s thernst Global Data
e Consumed Exchanges

In the Project tab of the IE| Navigator, right-click a % GE IP Controller target
that belongs to one of the Controller or ENIU family types that support Ethernet
Global Data (EGD), point to Add Component, and choose Ethernet Global
Data.

The # Ethernet Global Data folder is added to the target. The folder contains
two empty folders: # Consumed Exchanges and 8 Produced Exchanges.

EE Produced Exchanges
il Hardware Configuration
-1 Logic

E|_|j Reference Yiew Tables

| B Default Tables
@3 Supplemental Files

<II )I
> 2 B [E]7]

Navigator: After the Ethernet
Global Data component has
been added to the target

Note: For Ethernet modules that support EGD uploads, the EGD component is
automatically added when you upload the Hardware Configuration and EGD
configuration. The EGD component is also automatically added to a target when
you import a folder that contains an Ethernet Global Data (EGD) configuration or
import a Hardware Configuration that contains an EGD configuration. In such
cases, the Consumed Exchanges and Produced Exchanges folders are
automatically populated.

To install the EGD Configuration Server
1. Insert the Machine Edition* 8.50 install disk into the computer on which you want
to install the EGD Configuration Server.
The computer must be connected to an Ethernet network. It may be local or
remote.
2. On the Machine Edition 8.50 install disk, navigate to the Install folder.

3. Double-click the EgdCfgServer Setup.msi file.
The EGD Configuration Server is installed on the computer.
Note: The client library required for your copy of Logic Developer - PLC* to
communicate with the EGD Configuration Server is automatically installed as
part of the installation of Logic Developer - PLC.
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To install the EGD Management Tool (EMT) on your computer

1.
2
3.

Insert the Machine Edition* 8.50 install disk into your computer.
On the Machine Edition 8.50 install disk, navigate to the Install folder.

Double-click the EgdManagementTool Setup.msi file.
The EGD Management Tool is installed on your computer.

To configure communications with the EGD Configuration Server

1.

4.

In the & Options tab of the [i=] Navigator, expand the & Machine Edition
folder.

Right-click the [5] EGD page and choose Properties.

The Inspector displays the EGD options.

In the Inspector, configure the Host Name option. For help on this or any option,

select the option and look up the help that automatically appears in the 3|
Companion. To open the Companion, press SHIFT+F11.

(Optional.) Configure the Local Server Cache Path and Timeout options.

To configure a Logic Developer - PLC* target to use the EGD Configuration Server

1.
2,

In the Project tab of the [E| Navigator, expand the ¢ target.
Right-click the B Ethernet Global Data folder and choose Properties.
The Inspector displays the folder's properties.

Ensure that the Use Configuration Server property is set to True and configure
the properties below it.

To add a new produced exchange and configure it

1.

In the Project tab of the [i=] Navigator, expand the ¢ target's # Ethernet
Global Data folder.
Right-click the B Produced Exchanges folder and choose New.

A new produced exchange appears with a default name. The new produced
exchange is & invalid.

3. (Optional.) Enter a name that is more meaningful than the default name.

Right-click the produced exchange and choose Properties.

The Inspector displays the exchange's properties.

In the Inspector, configure the Destination property and other properties. If the
new produced exchange is now valid, its icon looks like this: & .

In the Project tab of the Navigator, right-click the produced exchange and
choose Configure.
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The EGD Variable editor appears.

InFoViewer/VProdExchl ] F X

Add | Insertl Deletel Length (Bytes]: 0

Offzet [Byte|Yariable Ref Addres:|lgnore | Lengt| Type | Description

Statug *lo0ao False 16[BIT

7. In the editor, use the buttons to add, insert, or delete rows.

8. For each row, define the Variable, Ref Address, Length, and/or Description
parameters. When you have configured the target to use the EGD Configuration
Server, you must specify a Variable for each row; you cannot use memory
ranges that have no variables mapped to them. The Ignore parameter is
available only for the Status. The Type parameter is read-only.

For help on the editor, click inside the grey space at the top and press F1.

To publish a target's produced exchanges to the EGD Configuration Server, by using the
Validate method
1. Inthe Project tab of the [i=] Navigator, right-click the 4 target and choose
Set as active target.
If the option is unavailable, the target has already been set as the active target.
2. Right-click the target and choose Validate.
Any errors found in the target's EGD configuration, Hardware Configuration, or
logic are listed in the Build tab of the Feedback Zone.
3. Correct any errors found and repeat step 2 of this procedure.
4. When the Build tab of the Feedback Zone displays no errors, click the Messages
tab of the Feedback Zone.
If the message "EGD Produced Data published" appears, the target's produced
exchanges have been updated (published) from your computer to the EGD
Configuration Server.

To publish a target's produced exchanges to the EGD Configuration Server, by using the
Bind and Build method

1. Inthe Project tab of the [i=] Navigator, right-click the 4 target and choose
Set as active target.
If the option is unavailable, the target has already been set as the active target.

2. Expand the target.
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3. Right-click the Ethernet Global Data folder and choose Bind and Build.
Any errors found in the target's EGD configuration are listed in the Messages tab
of the Feedback Zone. Some of these errors may pertain to consumed
exchanges. If you want context-sensitive help on the errors, we recommend that
you use the Validation method instead of the Bind and Build method.

4. If errors are found pertaining to produced exchanges, correct them and repeat
step 3 of this procedure.
The message "EGD Produced Data published" appears when the target's
produced exchanges have been updated (published) from your computer to the
EGD Configuration Server.
If an error is found pertaining to a consumed exchange, you typically need to
synchronize the consumed exchange.

To synchronize a consumed exchange on your computer with the corresponding produced
exchange published on the EGD Configuration Server:

1. If any of the following conditions is true, validate the target that contains the
producer. (See “Validating a Target”, on page 46.)

You have uploaded the Hardware Configuration and EGD configuration from
the producer Controller to your computer

You have converted the target that contains the producer

You have deleted the Ethernet Global Folder from the target that contains the
producer and added it again.
Validating the target that contains the producer updates the EGD Configuration
Server with the produced exchange that this consumed exchange consumes.

2. Inthe Project tab of the | Navigator, expand the ¢ target.
3. Expand the B Ethernet Global Data folder and then expand the # Consumed
Exchanges folder.

4. If you have changed the Local Producer ID property of the producer that the
consumed exchange consumes from, right-click the consumed exchange and
choose Properties. Then, in the Inspector, set the Producer ID property on the
consumed exchange to the same value as the new Local Producer ID.

5. In the Project tab of the Navigator, right-click the consumed exchange and
choose Synchronize to Server.

% Want to know more? In the online help index, look up “Developing EGD systems with the
EGD Configuration Server: Possible work flow” and “Troubleshooting EGD”.
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PACMotion

PACMotion

(PACSystems* RX3i with firmware version 5.60 or later.)

@ The PACMotion Multi-axis Motion controller (PMM) is a high performance,
easy-to-use servo motion control module that is closely integrated with the
PACSystems RX3i CPU logic solving and communications functions. This
versatile motion controller combines the benefits of highly integrated motion and
machine logic with the performance, flexibility, and scalability required for
advanced machine automation. The open programming environment simplifies
motion and machine logic synchronization, and enables real-time performance
required for high-speed motion applications.

Expanding the PACMotion node reveals the following PACMotion components
used with a PACMotion Digital Motion Control Module (IC695PMM335):

Cam Profile Library: Contains all of the PACMotion Cam profiles for this
# target, which cannot be downloaded to a PACMotion module.

»  Active Profiles: Contains all of the PACMotion D Cam profile aliases for this
target, which can be downloaded to a PACMotion module.

> Data Logging Windows: Contains all of the 8 Data Logging Windows for
this target. Each window is used to view and print graphs of the values of
various IC695PMM335 parameters over time.

PACMotion function blocks and instructions controlling or interacting with a PMM
module are supported in LD, FBD, and ST logic. You can drag them into logic
from the Toolchest [* LD Instructions drawer (or FBD Instructions drawer)[»
PACMotion folder.

The following can be used with PACMotion function blocks only:

»  Enumerated data types. An enumerated variable stores a value belonging to
an enumeration, list, or set of possible values. The value of an enumerated
variable can be selected from a drop-down list in the Inspector.

Reference ID variables (RIVs). A variable of a reference ID data type is used
to identify something on which a PACMotion function block instance is used
to perform an operation.
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This chapter outlines basic procedures that will get you started in Logic
Developer - PLC to work with PACMotion.

Location in the Navigator
A target’s PACMotion node appears in the Project tab of the M| Navigator.

To locate a target’s PACMotion node

« [ Expand the & target.

By default, the PACMotion node does not appear in the Navigator. You must add
the PACMotion component.

To add the PACMotion component to a PACSystems* RX3i target

EHl
EI-- Pacho

[ f R¥3i_target_with_PACMo
3 DataWatch Lists
-E‘l Diagnostic Logic Blocks
-y Hardware Canfiguration
EI:D Logic
%g Program Elocks
& PACMation
E§ Cam Profile Library
5] Profile
g Active Profiles
™3 Data Logging Windaws
- Reference Yiew Tables

1@ Supplemental Files

1 3

ﬂ/i@

Project tab: Navigator

Cam profiles and active Cam
profiles
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* Inthe Project tab of the @Navigator, right-click the lﬁtarget, point to Add

Component, and choose PACMotion.
The % PACMotion node is added to the target.

Cam Editor

The Cam editor is an accessory for PACSystems RX3i PACMotion programming
that enables you to create, edit, and manage Cam profiles. Each Cam profile is a
user-defined curve that specifies the response of a slave servo to a master
position index. Cam profiles are referenced by name and grouped into the Cam
Profile Library and the Active Profiles folder. Each active profile is intended for
use on a specific PACMotion module. The hardware components are specified
in the Hardware Configuration (HWC) of the parent target.

You can reuse a Cam profile by right-clicking it and choosing Copy Profile.

Working with the Cam Editor

You can adjust the curves of your Cam profile to suit the specific needs of your
project. With the Cam editor, you create profiles by defining points on a
master/slave position curve. Groups of adjoining points are allocated to sectors.
Each sector is assigned a polynomial curve fit order (1,2,3,5) that specifies how
the curve will be interpolated between points.
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To create a Cam profile

1. Inthe Project tab of the T Navigator, expand the % PACMotion node.
2. Right-click & Cam Profile Library and choose New Profile.

A new Cam profile with a default name is added to your project.

Data Logging

To generate .dlog files

GFK-1918S

1. Inlogic, create an instance of the MC_DL_CONFIGURE PACMotion function
block. To specify which parameters you want to log in the .dlog file, edit the
properties of the variable (of the DATA_LOG_PARAM_CONFIG data type) that
is assigned to the ParameterConfig input.

When the instance executes, data logging is configured.

2. Inlogic, create an instance of the MC_DL_ACTIVATE PACMotion function block.
When the Enable input to the instance is set to On, data logging occurs.
3. Inlogic, create an instance of the MC_DL_GET PACMotion function block.
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When the instance executes, it writes the data logged to the *.dlog file specified
by the DatalLogFile input.
To add a Data Logging Window (DLW)

1. In the Project tab of the Navigator, locate the [®& Data Logging Windows node,
right-click it, and choose Create New.

2. If you are online to the PACSystems* RX3i, the Create dialog box appears.
Select one of the following:

Controller: The DLW is a .dlog file stored on the PACSystems RX3i.
- Or -

PC: The DLW is a .dlw or .csv file stored on your computer.

If you selected Controller If you selected PC or are offline

The Controller File Explorer window appears | The Select DLW to Load dialog box appears.
and displays the .dlog files found on the
PACSystems RX3i.

3. Do as follows, depending on which window appeared:

In the Controller File Explorer window | In the Select DLW to Load dialog box

Select a .dlog file and click Open. Navigate to a folder on your computer, select a
.dlw or .csv file, and click Open.

A [E] Data Logging Window (DLW) appears, in alphabetical order, under the
[®F Data Logging Windows node with a default name that begins with “Session”.
It contains the following nodes:

=5 Views:
If you selected a .dlw file, this contains one or more =] views.
If you selected a .dlog or .csv file, there are no views. You need to add
one.

El Data Sources, whose El child node contains the data snapshot
contained in the .dlog, .dlw, or .csv file. If the .csv file was exported from a
data source, it is a complete snapshot. If it was exported from a view, it

contains only the data required for the traces configured to appear in that
view.

4. (Optional.) Enter a new name for the DLW.

% Want to know more? In the online help index, look up “PACMotion Instructions and
Function Blocks”, “IC695PMM335: PACMotion Digital Motion Control Module”, “Cam Profile
Library (PACMotion)”, “Enumerated Data Types: an Overview (PACSystems)’, “Reference ID
Variables (RIVs)", “Data Logging Window (PACMotion)” and “adding views to DLWs”.
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Navigator: Project tab

Motion Program

Motion Programming

Motion Programming

Logic Developer - PLC* supports motion programming for the DSM324i and
Motion Mate DSM314 motion control modules. High performance, easy-to-use,
these multi-axis motion control modules are highly integrated with the
PACSystems* RX3i and the Series 90*-30 Controller logic solving and
communication functions.

Both the DSM324i and the DSM314 support 10 motion blocks, 40 subroutines,
and a maximum total of 1000 motion program statements. Logic Developer -
PLC, making motion programming possible, supports the following motion
editors:

@ Motion editor
Local Logic editor
& Cam editor

This chapter outlines basic procedures that will get you started with Logic
Developer - PLC to create motion programs with these three motion editors.

To add a Motion component to a target

‘Add Companent. [ Ethernet Global Data
Add All Companents Mation
Remove Companent 3

Rename. F2
Delete. . Del

Set 25 Actve Target

Validate i
Danlaad ko Cantroler. . i

Upload from Contralers.,

Doynlnad and Start F3

G0 Oniing:

Offling Commanids )
St Rutime:

Repott... T
Dizgrcsics

o Docurertaticn

Findin "Ri3"

Clean Buld Folders
Import 3
Export Biraries, .

Fropeties AlsEnter

Target right-click menu
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* Inthe Project tab of the T Navigator, right-click the ] target, point to Add

Component, and then choose Motion.

A @ Motion Program node is added to your project. Included are empty ‘@
Motion Blocks, Local Logic, & CAM Profiles and & CAM Blocks folders.
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To add a Motion block

% Mation Program

Navigator: Project tab

Motion Blocks

Motion Programming
Motion Editor

1.
. Right-click 4 Motion Blocks and choose New.

MOTION EDITOR

Logic Developer - PLC* includes a Motion editor, which enables you to create
Motion blocks for the DSM324i and the DSM314. This text-based editor is
configurable as to its appearance and behavior. Comments and white space are
not considered to be Motion block statements. The Motion block programming
syntax is different from Local Logic syntax (see page 159).

In the Project tab of the 1= Navigator, expand the ‘@ Motion Program.

An empty Motion block with a default name is added to your project.

Rename the block as desired.

To open a motion block for editing

1.
2,

In the Project tab of the | Navigator, expand the ‘@ Motion Program.

Expand @ Motion Blocks and double-click the 4 Motion block you want to
open.

The block opens for editing in the Motion editor.
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To insert a command

File Edt Search Project Target Wariables Tools

1.

Motion Programming

Working with the Motion Editor

In the Motion editor, right-click and choose Insert Keyword.

A smart list appears showing all available motion commands.

Motion Editor

2. Select the appropriate command from the smart list and press ENTER.

The command is placed in the motion editor.

Window Help
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2 Want to know more? In the online help index, choose “Motion Editor”.
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10 Motion Programming
Motion Editor

Motion Commands

ACCEL

The ACCEL statement sets the axis acceleration for subsequent
moves and remains in effect in a given block unless changed. Note: If
a move instruction is executed before ACCEL, the tag Acceleration is
used.

BLOCK NUMBER

Block numbers can be used as the destination of JUMP commands.
Block numbers must be unique and can be between 1 and 65535.

CAM

The CAM statement starts CAM motion and specifies exit conditions.

CAM-LOAD

CAM-LOAD loads a parameter register with the starting location for a
CAM slave axis.

CAM-PHASE

CAM-PHASE sets the phase for CAM commands.

CALL

The CALL command executes another block as a subroutine.

CMOVE

The CMOVE command programs a continuous move using the
specified position and acceleration mode.

DWELL

DWELL causes motion to cease for a specified time period before
processing the next command.

ENDPROG

The ENDPROG statement terminates a Motion program definition.

ENDSUB

The ENDSUB statement terminates a Motion subroutine definition.

JUMP

Jump to a block number or a sync block within the current program or
subroutine. The jump may be unconditional or conditional based on the
status of a CTL bit.

LOAD

Initializes or changes a parameter data register with a 32-bit twos-
complement integer value.

PMOVE

The PMOVE command programs a positioning move using the
specified position and accelerator mode.

PROGRAM

The PROGRAM statement is the first statement in a motion program.
The program statement identifies the program number (valid range: 1
through 10) and the axis configuration. Program definitions cannot
nest.

SUBROUTINE

The SUBROUTINE statement is the first statement in a motion
subroutine. The subroutine statement identifies the subroutine number
(valid range: 1 through 40) and the axis configuration.

SYNC BLOCK

A sync block is a special case of a block number. A sync block can be
used only in multi-axis programs.

VELOC

Sets the process VELOCITY used by subsequent motion program
move commands and remains in effect until changed by another
VELOC statement.
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Navigator: Project tab

Local Logic

To create a Local Logic
1.
2.

3.

Motion Programming
Local Logic

LOCAL LOGIC

A Local Logic block runs synchronously with the Motion block, but is
independent of the Controller’s CPU scan. This enables the DSM324i or
DSM314 to interact much more quickly with motion 1/O signals on its faceplate
connectors than would be possible if the logic for the signals were handled in the
_MAIN program running on the Controller.

Local Logic language uses free-form, text-based circuits and contains basic
mathematical and logical constructs. The Local Logic syntax enables you to
assign a variety of logic tasks to your motion programs while working in
conjunction with Controller Logic programs and motion blocks to yield a flexible
programming environment. Because it uses straightforward, understandable
syntax, it is easy to gain proficiency with this editor.

The Local Logic programming language supports assignments, conditional
statements, arithmetic, logical, and relational statements. Local Logic provides
you with access to motion Controller data, parameters using a fixed set of
variables, control bits, and status bits:

Parameter data - accessible from Local Logic host Controller and motion
blocks. The parameter data are similar to variables in a program.

» CTL bits - enable the Local Logic block or host Controller to signal the motion
block to start an event.

Motion block numbers - the current block number can be used within the
Local Logic block or host Controller to make an action occur only during a
specific motion programming section.

block
In the Project tab of the T Navigator, expand the ‘@ Motion Program.
Right-click “@ Local Logic and choose New.

Rename the block as required.

To open a Local Logic block for editing

GFK-1918S

In the Project tab of the [i=] Navigator, expand the ‘@ Motion Program and

The Local Logic block opens for editing in the Local Logic editor.
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Local Logic

Working with the Local Logic Editor

The Local Logic editor has its own distinctive syntax for constructing Local Logic
blocks.

& new project -

=18l
Fle Edt Seach Pojeot Taget Vaiiables ook Window Help _8 x|

EEEvRRs |[PErocxi|EnpaEees o0 0@ D |
kAL O 0B L, B ‘Eﬁ»,‘“m G m £ ! |

I HAME | Tvee GROUP DESCRIPTION R|w o
#etual_Position_1 32 Bits. Status Variables | Actual_Position (user units) i
15 Status imabizs | Aorual_velocity (user uritsfsec) 0
cilog_nput_1 Bts | FacePlate /D | Aualog Input 1+ 33000 = - 100 0
Enaie_Folone 1 B\ N\ Gortrl vl [ e st = 10 i he Folomer x
r_Code_1 Uns\g\ Status Variables | Awis 1 Bror Code i
Feedbold_1 o ontrol ariables | Set this bt = 110 ntiste feedhid B
Foloner_rabied 1 B N s Vi |0 b tollvaris ersies 0
Follower_Ramp_sctive_1 (4 ‘ “ariables | ON when follower avcel / decel ramp is astive b
FotowerFai_A,1 e 0ol \nabis o Acmd o foloer A8 gtwemastaiat «
A 1 Fais 2, A B CTL Bits Paameter Registers ~|
R
Drag and =L - [ =
drop EI * T 1 ed: Jun 16, 2004
. argel
variables 2, Dt Watch Lists Select an item
2 iption:
from the -l Hardware Configuration
. B Logic 485 | Right-click t
Local Logic &-Fg Program Blocks i Ight-click to
: LAfF _MAN
Variable 5@y Motion Frogram __________-—_--—choose
€ ChM Profiles
@ TAM Blocks IF First_Local Logic Swesp THEW (% If 2 sweep then *; commands
513 Local Logic POO1:=0; (* Initiali from a list.
-8 Z042 : (% Initiali
#1445 Motion Blocks (% Initiali
' Reference Yiew Tables
Iy Supplemental Files
POO1:=PO0O1 + Z; (* Time in Mil1 MDD VI
! of | [ ;I—I

B =N EEE .LLBIkT[MyTargati

Far Help, press F1

[Ln8. Col1 [ & [Dffine | [Loc

To insert a Local Logic command
1. Inthe & Local Logic editor, right-click and choose Insert Keyword.
A smart list displays all available Local Logic commands.
2. Select the desired command in the smart list and press ENTER

The command is inserted.

Note: You can drag variables from the Local Logic Variable Table (LLVT) to the
Local Logic editor.
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Click a HAME TYPE GROUP DESCRIPTION R|w
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Right-click a - - -
Commanded_‘elocity_1 32 Bits Status Wariables | Commanded_“locity (user unitsisec) i
name to co| Dighal_Outpue1_1 Bt FacePlame 0 | Set this bit = 1 to tum on 2¢v oupur OUTI_A M
it to the Digital_Output3_1 Bit FacePlate 1D | Set this bit = 1 ta tum on 5w output OUTI_A %
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. FeedHold_t Bt Control “ariables |Set this bit = 1 to initiate fesdhold H
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i Follower_Enabled_1 Bt Status Veriables | M when follower is enabled i
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To view the LLVT
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Local Logic

Local Logic Variables

Local Logic is designed to complement a Controller’s logic and mathematical
capabilities. Solving small Local Logic and mathematical sets requires a tight
synchronization with the controlled motion.

Logic Developer - PLC* includes a table containing Local Logic variables, the
Local Logic Variable Table (LLVT), that you can drag into your Local Logic
blocks. As illustrated in the diagram below, the LLVT has several tabs that
organize the variables by category:

InfoVigwer LLBIk3

In the Project tab of the | Navigator, expand the Motion Program.

Right-click “@ Local Logic and choose Local Logic Variable Table.

The “Which LLVT do you want?” help topic appears.
Select Motion Mate DSM314 or DSM324i.

The LLVT appears in the Infoviewer, displaying variables or data on each tab:

Axis 1 Variables specific to axis 1

Axis 2 Variables specific to axis 2

Axis 3 Variables specific to axis 3

Axis 4 Variables specific to axis 4

Global Global data such as module status code
CTL bits DSM general Control/Status bits

Parameter Registers

DSM parameter data
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Local Logic

The table has six columns:

Name Contains the variable name that is to be used within a Local Logic block

Type The data type for this variable. For example, 32-bit means that this variable
is a 32-bit variable.

Group The group this variable is placed in. For example, Faceplate 1/0 means that
this variable refers to a point on the module faceplate.

Description This column contains a textual description of the variable. When you hover
the mouse pointer over the description, a tool tip displays the description.

R This column indicates if the variable can be read by a Local Logic block.

W This column indicates if the variable can be written to by a Local Logic block.

To insert a Local Logic variable
1. In the Local Logic editor, right-click and choose Insert Variable.
A smart list appears prompting you to choose a Local Logic variable name.
2. Select a variable in the list and press ENTER.

The variable is inserted in your Local Logic.

Local Logic Commands and Operators

With Local Logic, you can execute basic logic and mathematical functions on the
DSM324i or Motion Mate DSM314 module. Commands use upper case
characters only and are case sensitive.

ABS TRUE -(minus) <= (less than or equal to)
BWAND FALSE | (divide) <> (not equal)

BWOR IF * (multiply)

BWXOR THEN :=(assign)

BWNOT END_IF >(greater than)

ON MOD < (less than)

OFF + plus >= (greater than or equal to)

% Want to know more? In the online help index, choose “Local Logic: an Overview”.
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Cam profiles and Cam blocks

To create a Cam block

1.
2.

3.

To import Cam blocks

1.
2,

Motion Programming
CAM Editor

CAM EDITOR

The Cam editor is an accessory for Logic Developer - PLC*motion programming
that provides a means to create, edit, and manage electronic Cam profiles. Each
Cam profile is a user-defined curve that specifies the response of a slave servo
to a master position index. Cam profiles are referenced by name in the parent
motion program and grouped into Cam blocks. Each block is intended for
download to a specific motion module via its Controller. The hardware
components are specified in the Hardware Configuration (HWC) of the parent
target.

You can reuse a Cam profile by including it in multiple Cam blocks. To include a
Cam profile in a Cam block, see “To add an alias to a Cam block”, on page 165.

In the Project tab of the 1] Navigator, expand the @ Motion Program.
Right-click & Cam blocks and choose New.

A new Cam block with a default name is created.
Rename the block as desired.

In the Project tab of the [E| Navigator, expand the ‘@ Motion Program.
Right-click 8 Cam blocks and choose Import from File.
The Open dialog box appears.

3. Browse to the Cam block you want to import (.csv or .txt file).

Click Open.

The imported block appears in your project.

To open a Cam block for editing

1.
2,

GFK-1918S

In the Project tab of the | Navigator, expand the ‘@ Motion Program.
Expand # Cam Blocks and double-click the & Cam block you want to open.
The block opens for editing in the Motion editor.
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1 Motion Programming

Working with the Cam Editor

You can adjust the curves of your Cam profile to suit the specific needs of your
project. With the Cam editor you create profiles by defining points on a
master/slave position curve. Groups of adjoining points are allocated to sectors.
Each sector is assigned a polynomial curve fit order (1,2,3) that specifies how
the curve will be interpolated between points.

File Ecit Gearch Project Target Variables Tools Window Help 18]
Navigator T Curves of
displays BeEa ER [ oo il [mEEE e Y0 aaal) 0
- e
RS e e e e e | A s e | i
Cam = _~profile
rofiles = Master Slave w2fH —
p 4 Positian ‘ Pasiion 1 100% /E‘ Car' be
an " *F}Tr;:ﬂ A BA 76 50659 e fh\ A ; I adjusted
E 0128, A30YE
blocks. -3 Data WalchLists ' EEEH 461535 233 e FaliAl and
fiis Hardware Configuration 1 207 48767 o Ssoinb Nl S .
R E;g‘t HEEE 70231 200, | 1 (’ ]-; -/ Ry edited
. EHEg Progiam Blocks —H h
Cam profile b | | |278 384022
P S Mot g L e 20 el
table 2 389 593671 i
g el e 238 ) | fJ‘
H Profile1 -
enables __—— : % Prfie? 438 13 e {
numeric L Pofie 43 248 e Secondary
H 1 0 100 200 300 400 500 GO0 700 800 900 1,000 1,100 1,200
" £ &P CAM Blocks i B LD T curves show
editing and =1 HEEE 8175 —Velocly  focel_— ek
i ~ L] Profiel HEEE 745245 i
curve order 5 B P 00 e an, i the velom_ty,
grouping. : ] Profie3 = [EH e 785331 LY L acceleration
642 59797 : B
2 2e B e i . iy i = and jerk of
Configure —————— | 1= 20045 o [0 i the Cam
. 960 540905 -40, .
profiles T e ii 000 o i [ profile.
and blocks e = 2l az0rs |
in the CAM Typs NonCyclic CAM L1280 A |
Start Type Default 0 100 200 300 400 500 60O 700 8OO 900 1,000 1,100 1,200
Inspector. End Type Defautt i azomas |
The Inspectar Infetiewer _MaIN profile]
Companion T B cam Profile @ =
i 2scriptio A CAM fill d, -defined that ifies th it f & foll (slave) it functi f ter' iti
automatically Gpan to adit D O RE 17 ST 3 SV 197 1 G MITEE g (LA I S sl £ FTEh ) r ) RGBT PR
: Configure successive points to generate a continuous curve. A& GAM profile can be configured as to its type and behavior by adjusting its properties. A I
d g
provides S profile is referenced by name in a motion program that is downloaded to a motion module
information =
on what you Done [ [ [Offine [dmeneley lLocaL

click.

To create a Cam profile
1. Inthe Project tab of the 1] Navigator, expand the @ Motion Program.
2. Right-click & Cam Profiles and choose New.

A new Cam profile with a default name is added to your project.
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To configure a Cam profile

To edit a Cam profile

1. Inthe Project tab of the [E| Navigator, expand the ‘@ Motion Program.
2. Right-click & Cam Profiles, right-click a & Cam profile, and choose

Properties.

The Inspector displays the properties of the Cam profile.

. Adjust the properties of the Cam profile in the Inspector to specify its type and

boundary conditions.

. Inthe Project tab of the T Navigator, expand the ® Motion Program.
. Right-click & Cam Profiles and double-click a 8 Cam profile.

A graphical representation of your profile appears in the profile editor and a
numeric representation appears in the profile table.

. Insert and move points in the profile editor or table.
. Group points into sectors in the profile table and assign curve fit order to each

sector.

To add an alias to a Cam block

Fiename Block

Cut Block
LCopy Block
Paste

Delete Block...

Import from File
Ex=port to File

Froperties

GFK-1918S

Chil+
Chil+C
Chil+t
Del

Al+E nter

Right-click method

. Inthe Project tab of the | Navigator, expand the ® Motion Program and

expand 8 Cam blocks.

. Right-click a & Cam block, point to Add Alias to, and then choose a profile.

Note: Aliases correspond to Cam profiles within Cam blocks. In order to create
aliases for Cam blocks, you must have previously created Cam profiles.

Drag and drop method

. Inthe Project tab of the I Navigator, expand the ® Motion Program.
. Expand & Cam Profiles and expand 8 Cam blocks.
. Drag a Cam profile and drop it onto a Cam block.

The Cam profile is added to the Cam block.

% Want to know more? In the online help index, choose “Cam’.
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Index

A

Access Control
Setting 92
Accumulators
Configuring 122
Active Blocks folder 141
Active LD DLB 141
Adding
Carrier/Base to VersaMax
Remote I/O 83
DSM324i 78
EGD Component 147
Ethernet Modules
(PACSystems) 66
Fan Kits to PACSystems
RX7i 66
GBC 75
GE Remote I/O Targets 82
Modules to a Carrier/Base 84
Motion Mate DSM314 78
Produced Exchanges 148
Remote I/O Scanner 81
Targets 36
Address Use report 55
Advanced Math Instructions
FBD 120
IL 127
LD 106
ST 135
Aliases 165
Aliasing Variables 26
Analog Start Address 122
Application Structure reports 55
Arrays 25
Assigning
Indirect References 93
Instance Data to Built-In Function
Blocks (LD) 97
Length to LD Instructions 97
Operands to IL Instructions 124
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Parameters beside FBD
Instructions 113
Variables to Operands 98

B

Basic Hot CPU Redundancy 72
Basic Instructions
L 127
Bit Operations
FBD 120
L 127
LD 106
Bit References 27
Bitwise Operators
ST 135
Blocks
C 5,88, 89, 137
CAM 87, 89, 163, 165
FBD 88,110
Function Blocks 87, 88
IL 88
Interrupt 87, 88, 89
LD 88,95
Local Logic 87, 89, 159
_MAIN 89, 90,91
Motion 87, 89, 156
Parameterized 87, 88, 129
Reports 55
Scheduling 91
ST 88
Blue Arrows. See Docking Markers
Bookmarking Favorites 32
BOOL Variables
Changing the State 126, 134
Forcing the State 105, 119, 126,
135
Removing the Force 126, 135
Turning On or Off 105
Boolean Start Address 122
Build Tab 46, 49

Built-In Function Blocks
Assigning Instance Data to (in
LD) 97

C

C Blocks 5, 88, 89, 137
Importing 137
Setting Parameters 138
C Programs 5, 87, 88, 89, 139
Diagram 87
Scheduling 90
Setting Parameters 140
Cam 152
CAM Blocks 87, 89, 163, 165
Aliases 165
Creating 163
Importing 163
CAM Editor 5, 152, 155, 163
Working with the CAM
Editor 152
CAM Profile Library 151, 152
CAM Profile report 55
CAM Profiles 89, 141, 142, 152
Adjusting the Curves 152
Configuring 165
Creating 153, 164
Editing 152, 165
Carrier/Base 84
Adding Modules 84
Adding to VersaMax Remote
/0 83
Catalog 64, 65, 66
Changing the State of BOOL
Variables 126, 134
Checking
FBD Blocks 115
LD Blocks 98
Coils
Justification 28
LD 106
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COM 37
COM ports 40
Comments
IL 124
ST 131
Communication
Configuring with Controllers 40
Ethernet 40
Modem Connection 40
Serial Connection 40
Companion Help 23, 46
Using 29
Component
Adding the PACMotion
component 152
Compound Structure Variables 25
Configuring
Accumulators 122
CAM Profiles 153, 164, 165
Communication with
Controllers 40
Communications with EGD
Configuration
Server 148
Controllers 63
CPUs 44, 64
DSM314 78,79
DSM324i 79
Ethernet Communication 40
Ethernet Daughterboard 68
Execution Scheduling 91
Hardware 39, 57
Modem Communication 40
PACSystems RX7i 60
Redundancy Systems 74
Remote I/O 5
Scheduling 92
Secondary HWC 76
Serial Communication 40
Target to use EGD Configuration
Server 148
Targets 37
VersaMax Remote /0 82
Consumed Exchanges
Synchronizing 150
Consumers (EGD) 145
Contact Information 14, 15
Contacts
LD 106, 127
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Context-Sensitive Help 23, 29
Control 5,20
Control Instructions

FBD 120

IL 127

LD 106
Controllers 46

Configuring 63

Families 37, 57

Family Property 37

Starting 51

Status 37

Stopping 51
Conversion Instructions

FBD 121

IL 127

LD 107

ST 136
Conversion Reports 39
Converting Targets 38
Copying

Entire LD Blocks as text 99

Modules 68

Sections of LD Blocks as

text 100

Text into the LD Editor 100
Counters

FBD 120

IL 128

LD 107
CPU

Configuring 44, 64

Replacing 63

CPU Redundancy Over Genius 72
CPU364 43
CPU374 43
Creating
CAM Blocks 163
CAM Profiles 153, 164
FBD Blocks 110
IL Blocks 122
LD Blocks 95
Local Logic Blocks 159
Parameterized ST Blocks 129
Projects 20, 57, 82
Reports 55
ST Blocks 129
User-Defined Folders 91
User-Defined RVTs 54

Variables 26
Variables from Names
(IL) 124,131
Variables from Reference
Addresses (IL) 124

CTL Bits (Local Logic) 159
Customer Care 14, 15
Customizing

FBD Editor 110

LD Editor 95

ST Editor 129

D

Data Logging 153
Data Logging Window 151
Adding 154
Data Move Instructions
FBD 121
IL 128
LD 107
ST 136
Data Sources 154
Data Table Instructions
IL 128
LD 108
Data Values
Monitoring (FBD) 119
Monitoring (IL) 126
Monitoring (LD) 101
Monitoring (ST) 133
Data Watch Tool 22
Default RVTs 54
Diagnostics 52
DLB
Active LD Diagnostic Logic
Blocks 141
Creating an active LD Diagnostic
Logic Block 142
Inactive LD DLBs 142
DLBs 5, 141
DLW
Adding 154
Docking Markers 23
Documentation Address 37
Downloading IP Addresses
non-PACSystems 44
PACSystems 42
Downloading to a Target 49
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DSM314 78,155,156,159,161, 162
Adding 78
Configuring 78, 79
DSM324i 78, 89, 90, 155, 156, 159,
161, 162
Adding 78
Configuring 79
Dual Hardware Configuration 75, 77
Duplicate Addresses 28
Duplicating
FBD Logic 118
IL Logic 124
LD Logic 100
ST Logic 132

E
Editing
CAM Blocks 153, 164
CAM Profiles 165
FBD Blocks 111
IL Blocks 123
LD Blocks 95, 99
LD Logic 99
Local Logic Blocks 159
Motion Blocks 156
Projects 20
ST Blocks 130
Variables 25
Editors
CAM 5, 152, 155, 163
FBD 5,110
IL 5,122
LD 5,95
Local Logic 5, 155, 160
Motion 5, 155, 156
ST 5,129
EGD
Adding EGD Component 147
Adding Produced
Exchanges 148
Configuration Server 145
Configuring Communications
with EGD
Configuration
Server 148
Configuring Target to use EGD
Configuration
Server 148
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Consumers 145
Exchanges 145
Installing EGD Configuration
Server 147
Installing EGD Management
Tool 148
Management Tool 146
Pages 145
Producers 145
Publishing Produced Exchanges
to EGD Configuration
Server 149
Signatures 146
Synchronizing Consumed
Exchanges 150
Unconsumed Data Report 146
Variable Editor 149
EGD Configuration Server 145
Configuring
Communications 148
Installing 147
Publishing Produced Exchanges
to 149
EGD Management Tool 146
Installing 148
EGD reports 55
EGD Variable Editor 149
Enabling I/O Variables for a
Module 70
Enumerated Data Types 151
Ethernet 37, 39, 40, 66, 68
Adding Modules 66
Ethernet Adapter 59
Ethernet Daughterboard
Configuring 68
Ethernet Global Data. See EGD
Exchanges (EGD) 145
Executing Programs 51
Execution Scheduling
Configuring 91
Expansion Racks 59, 60, 65
Extentions
.csv 154
.dlog 153
diw 154

F
Families 37, 57

Index

Fan Kits
Adding to PACSystems RX7i 66
Non-Intelligent 59
Fault Locating References 39
Fault Table Reports 52
Fault Tables 52
Favorites 32
FBD
Drawing Wires 116
Negating Parameters 117
Negating Wires 117
FBD Blocks 88, 110
Checking 115
Creating 110
Editing 111
Validating 115
FBD Editor 5, 110
Customizing 110
Offline 111
Online 119
FBD Instructions 120
Advanced Math 120
Assigning Parameters
beside 113
Bit Operations 120
Changing the Number of
Inputs 116
Control 120
Conversion 121
Counters 120
Data Move 121
Inserting 113
Math 121
Program Flow 121
Relational 120
Timer Function Blocks 121
FBD Logic 110
Duplicating 118
Moving 118
Feedback Zone 22, 46, 49, 55, 56
Files
.csv File 154
.dlog File 153
.diw File 154
Finding text
Global Search 93
In One Block 92
Folders
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Importing 21
Forces in Controller report 55
Forcing BOOL Variables 105, 119,
126, 135
Full-text Search
Bookmarking Favorites 32
Using 31
Function Block Instances 87, 88
Function Blocks 87
Built-In 97
Specialty 88
User-Defined 88
fxClasses 22

G

GBC 76, 80

Adding 75
GE Remote 1/0

Adding 82
Generating Reports 55
Genius Bus Controller. See GBC
Genius Devices 60
Genius Redundancy 72, 73
Global Search 93
GlobalCare 14, 15
Going Offline from a Target 48
Going Online to a Target 47
GSDML files 143

H

Hardware
Configuring 39, 57
Hardware Configuration 5, 39, 57
Dual 77
New Reference Assignment 28
Primary 72,77
Secondary 72,76, 77
Synchronizing 77, 79
Hardware Configuration report 55
Hardware Key Authorization 9
Help
Companion 29
Context-Sensitive 23, 29
Favorites 32
Full-text Search 31
Index 30
InfoViewer 29
Table of Contents 33
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Hot CPU Redundancy

Setting Up Primary HWC 74
Hot CPU Redundancy Over
Genius 73
Hot Redundancy

Configuring Systems 74

CPU Over Genius 73
Hot Redundancy Systems 72
HWC. See Hardware Configuration
Hyperlinks 56

1/0 Variables 24, 69

IC695CPU320 63

IC695PSA040 63

IL Block Comments
Inserting 124

IL Block report 55

IL Blocks 88
Creating 122
Editing 123

IL Editor 5, 122
Offline 123
Online 125

IL Inline Comments
Inserting 124

IL Instructions 127
Advanced Math 127
Basic Instructions 127
Bit Operations 127
Control 127
Conversion 127
Counters 128
Data Move 128
Data Table 128
Inserting 123
Math 128
Program Flow 128
Relational 128
Timer Function Blocks 128

IL Logic 122
Duplicating 124
Moving 124
Reformatting 125

Importing
C Blocks 137
CAM Blocks 163
Folders 21

Inactive Blocks folder 141
Inactive LD Diagnostic Logic
Block 141
Inactive LD DLBs 142
Index 30
Indirect References 93
Assigning 93
InfoViewer 23, 55, 56
InfoViewer Help 29
Initial Force States in Project
report 55
Inserting
FBD Instructions 113
IL Block Comments 124
IL Inline Comments 124
IL Instructions 123
LD Instructions 97
ST Block Comments 131
ST Instructions 131
ST Keywords 131
ST Line Comments 131
Variables (ST) 131
Inspector 22
Installation 8
Installing
EGD Configuration Server 147
EGD Management Tool 148
Instance Data
Assigning to Built-in Function
Blocks (LD) 97
Instances of Function Blocks 87, 88
Instruction List (IL) 122
Instructions
FBD 120
IL 127
LD 105
ST 135
Interacting with Controllers 46
Internet Explorer 23
Interrupt Blocks 87, 88, 89
IP Address 37, 44
Downloading to non-
PACSystems 44
Downloading to PACSystems 42
Setting for Lower-End Series 90-
30 44
Setting for PACSystems
(Permanent) 42
Setting for Series 90-30
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CPU364 43
Setting for Series 90-30

CPU374 43
Setting for Series 90-70 42
Setting Temporary 41

K

Keywords
Inserting (ST) 131

L

LD Block report 55
LD Blocks 88, 95
Checking 98
Copying Entire as Text 99
Copying Sections as Text 100
Creating 95
Editing 95, 99
Printing 56
Validating 98
LD Editor 5, 95, 99
Copying Text into 100
Customizing 95
Offline 96
Online 101
LD Instructions 105
Advanced Math 106
Bit Operations 106
Coils 106
Contacts 106, 127
Control 106
Conversion 107
Counters 107
Data Move 107
Data Table 108
Inserting 97
Math 108
Program Flow 109
Relational 109
Timer Function Blocks 109
LD Logic 95, 99
Duplicating 100
Moving 100
Length
Assigning to LD Instructions 97
LLVT 161
Local Logic 155, 159
Local Logic Block report 55
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Local Logic Blocks 87, 89

Creating 159

Editing 159
Local Logic Editor 5, 155, 160
Locating

All Occurrences of a

Variable 132

Logic

FBD 110

IL 122

LD 95,99

Local 155

ST 129
Logic Developer - PC 5, 20
Logic Folder 88
Logic Printouts 55
Logic Programs and Blocks 87
Logicmaster 5, 20

M

_MAIN Block 89, 90, 91
Main Program 90

Blocks 88

Diagram 87

Downloading 89

Number of Blocks 90

Properties 91
Making Word-for-Word Changes 104
Mapping a Variable to a Terminal 70
Math Instructions

FBD 121

IL 128

LD 108

ST 136
Maximum Number of Blocks 90
Modbus Address report 55
Modem 37
Modem Communication 40
Module Catalog 43, 67, 83, 84, 85
Modules

Copying 68

Moving 69
Monitor Mode 46
Monitoring

Values of Parameterized Block

Parameters (ST) 134

Monitoring Data Values

FBD 119
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Index

IL 126

LD 101

ST 133
Motion

Blocks 156

Editor 5, 155, 156

Program 89
Motion Block report 55
Motion Blocks 87, 89
Motion Mate DSM314 78, 89, 90
Motion Program 90

Diagram 87
Motion Programming 155
Moving

FBD Logic 118

IL Logic 124

LD Logic 100

Modules 69

ST Logic 132

N

Navigator 22, 54, 88, 152
Negating

FBD Parameters 117

FBD Wires 117
Network Administrator 43
Network Interface Unit (NIU) 82
New Reference Assignment 28
NIU 82
Number of Blocks in the Main
Program 90

0]
Offline 46
FBD Editor 111
Going Offline from a Target 48
IL Editor 123
LD Editor 96
ST Editor 130
Online
FBD Editor 119
Going Online to a Target 47
IL Editor 125
LD Editor 101
ST Editor 133
Online in Monitor Mode 46
Online in Programmer Mode 46
Opening a Project 21
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Operands
Assigning to IL Instructions 124
Assigning Variables 98
Options Tab 54

P

PACMotion 5, 151
Cam profiles 151
components 151
Enumerated Data Types 151
Module 152
Node 151, 152
Reference ID variables 151
PACMotion node
Location in the Navigator 152
PACSystems 90, 146
Downloading IP Addresses 42
LD Instructions Support 106
Setting Permanent IP
Addresses 42
PACSystems RX3i 35, 152
lllustration 59
Motion modules 78
Motion Program 90
PACSystems RX7i 35, 104
Adding Fan Kits 66
Configuring 60
lllustration 61
PACSystems RXi 35
Pages (EGD) 145
Parameter Data (Local Logic) 159
Parameter Editor 44, 64, 79
Parameterized Block Parameters
Viewing Values (ST) 134
Parameterized Blocks 87, 88
Creating (ST) 129
Parameters
C Blocks 138
C Programs 140
Permanent IP Address
Setting for PACSystems 42
Power Supply 82
Replacing 63
Primary HWC 72, 77
Setting Up for Hot CPU
Redundancy 74
Printing
LD Blocks 56
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Reports 56
Produced Exchanges
Adding 148
Producers (EGD) 145
Product Authorization 9
Proficy Logic Developer - PC 5, 20
Proficy View 5, 20
PROFINET 143
Program Blocks Folder 88
Program Flow Instructions
FBD 121
IL 128
LD 109
Programmer Mode 46
Programs 140
C. See C Programs
Comparative Diagram 87
Main. See Main Program
Motion. See Motion Program 87
Scheduling 90, 91
Types 87
Programs and Blocks 87
Project Tab 88
Projects 17
Creating 20, 57, 82
Downloading 49
Editing 20
Executing 51, 162
Importing Folders 21
Opening 21
Uploading 49
Published Variable Table 142
Publishing
Target’s Produced Exchanges to
EGD Configuration
Server 149
PVT
Published Variable Table 142

Q

Quick Start 18

R
Racks 57, 82
Expansion 59, 60, 65
Replacing 65
Redisplaying Reports 56
Redundancy

Basic Hot CPU 72
CPU Over Genius 72
Genius 72,73
PROFINET 143
Wizards 74, 75
Reference Address 24, 54, 97
Reference ID variables 151
Reference View Tables 54
Default 54
User-Defined 54
Working with 55
Reformatting IL Logic 125
Relational Instructions
FBD 120
IL 128
LD 109
Relational Operators
ST 136
Remote I/O 36, 57, 83
Configuring 5
Remote I/O Scanner 80
Adding 81
Removing the Force from BOOL
Variables 126, 135
Replacing
CPUs 63
Power Supplies 63
Racks 65
Text 92
Reports 55
Address Use 55
Application Structure 55
CAM Profile 55
Conversion 39
EGD 55
Fault Table 52
Forces in Controller 55
Generating 55
Hardware Configuration 55
IL Block 55
Initial Force States in Project 55
LD block 55
Local Logic Block 55
Modbus Address 55
Motion block 55
Printing 56
Redisplaying 56
Structured Text Blocks 55
Variable Difference 55
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Variables 55
Reports Tab 55, 56
Right-Click Menu

HWC 63

Target 46, 155
RIVs 151
Run Mode 51
Run Mode Store 101, 103, 105
Rungs (LD Logic) 95
Run-time Destinations 35
Run-time Files 49

S
SBA 80
Scheduling
Blocks 91
Configuring 92
Programs 90, 91
Searching
Global Search 93
In One Block 92
Secondary HWC 72, 77
Configuring 76
Selecting
Range of ST Logic 132
Serial Communication 40
Series 90 Micro 35, 90, 104
Series 90-30 35,60, 78,90, 104, 122
Motion Program 89
Series 90-30 Ethernet Network
Interface Unit 35
Series 90-70 35, 60, 90, 91, 104,
106, 139
C Programs 89
Remote I/O Scanner 35
Series 90-70 Genius Remote 1/0
Scanner 35, 80
Setting Access Control 92
Setting IP Addresses
Lower-End Series 90-30 44
PACSystems (Permanent) 42
Series 90-30 CPU364 43
Series 90-30 CPU374 43
Series 90-70 42
Temporary 41
Setting Parameters
C Blocks 138
C Programs 140
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Setting Up
Primary HWC for Hot CPU
Redundancy 74
Signatures (EGD) 146
Slots 59, 63
Software Key Authorization 10
Specialty Function Blocks 88
ST Blocks 88
Creating 129
Editing 130
ST Editor 5, 129
Customizing 129
Offline 130
Online 133
ST Function Blocks
Timer Function Blocks 136
ST Functions
Advanced Math 135
Bitwise Operators 135
Conversions 136
Data Move 136
Math 136
Relational Operators 136
ST Instructions
Inserting 131
ST Logic 129
Duplicating 132
Moving 132
Selecting Range of 132
ST Statements 135
Starting
Controller 51
Machine Edition 18
Statements (ST) 135
Status 37
Status Bar 47
Stop Mode 51
Stopping 51
Stopping a Controller 51
Structured Text Blocks report 55
Sweep Time 37
Symbolic Variables 24
Synchronizing
Consumed Exchanges
(EGD) 150
HWCs 77,79
System Requirements 6

Index

T

Table of Contents 33
Target Properties 37
Targets 88
Adding 36
Adding GE Remote I/O 82
Configuring 37
Converting 38
Definition 35
Downloading 49
Going Offline 48
Going Online 47
Offline 46
Online in Monitor Mode 46

Online in Programmer Mode 46

Remote I/O Scanner 80
Right-Click Menu 46, 155
Run Mode 51
Stop Mode 51
Uploading 50
Validating 46
Technical Support 14, 15
Templates 20, 36, 82
Terminal 69
Test Edit (LD) 102
Text
Replacing 92
Timer Function Blocks
FBD 121
IL 128
LD 109
ST 136
Toolchest 22
Tools 22
Docking Markers 23
Transacted Online Programming
(LD) 102

U

UDT 25

Unconsumed Data Report
(EGD) 146

Uploading from a Target 50

Uploading from the Controller 141

URL 37
User-Defined Folders
Creating 91
User-Defined Function Blocks 88
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User-Defined RVTs 54
Creating 54
User-defined User Type 25
Using Help
Companion Help 29
Favorites 32
Full-text Search 31
Help Index 30
InfoViewer Help 29
Table of Contents 33
Using Templates to Create
Projects 20

)

Validating
FBD Blocks 115
LD Blocks 98
Targets 46
Variable Difference report 55
Variables 24, 39
Aliasing 26
Arrays 25
Bit References 27
Compound Structures 25
Creating 26
Creating from Names
(IL) 124, 131
Creating from Reference
Addresses (IL) 124
Editing 25
1/0 24, 69
Inserting (ST) 131
Locating All Occurrences of 132
Mapping 26
Symbolic 24
Turning On or Off 119
Variables Reports 55
VersaMax 35, 104
Adding Carrier/Base to Remote
/0 83
Configuring Remote I/O 82
VersaMax Controllers 90, 122
VersaMax Ethernet RIOs 35
VersaMax Genius RIOs 35
VersaMax Micro 90
VersaMax Nano 90
VersaMax Nano / Micro 35, 104, 122
VersaMax Profibus RIOs 35
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VersaMax Remote 1/0 82
VersaPro 5,20

View 5, 20

Viewing Fault Table Reports 52
Viewing. See also Monitoring
Visual Style 28

w

Windows Explorer 22
Wires
Drawing in FBD 116
Negating 117
Word-for-Word Changes 102
Making 104
Working with Reference View
Tables 55
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